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TeleMagic Program Features 
TeleMagic is a fully configurable, relational Contact and Business Automation Manager 
integrated with Productivity Tracking, Report Generation, Auto-Dial, Word Processing, 
Faxing, Wireless Messaging, and Electronic Mail capability. TeleMagic is available in both 
single-user and network versions. 

Manual Conventions 
Full documentation of all features of TeleMagic can be found in on-line help. To access on-
line help, select Help from the TeleMagic Main menu. To access context -sensitive help from 
anywhere except the report generator, press F1. Pressing F1 in the Report Generator will open 
on-line help, but not context -sensitive help. 

This System Administrator Guide is designed to be used by the system administrator and 
includes information on installation, setup, configuration, maintenance, and troubleshooting 
of TeleMagic. 

Text Conventions 
Verbatim Entries: Text you must type verbatim is shown in bold. For example, if you are 
instructed to enter: xxx, you would type the letters: xxx (in lowercase). If uppercase letters are 
required, text will be shown in uppercase. 

Optional Entries: If you have an option of what you can enter, a placeholder is shown in 
bold italics. For example, if you were to enter the name of your database, the instructions 
would tell you to type the database_filename. For a database called Contacts, you would 
type contacts. 

On-screen Text: Field names, pop-up warnings and any other text that appears on the 
TeleMagic screen will be shown in this typeface: Example of on-screen text. 

Menu Options and buttons will be shown in bold face text with the appropriate hot key (if 
applicable) underlined. 

PATH AND FILE NAMES: File, program, and directory names are shown in all capital letters. 
For example, a file stored on your hard drive in the directory containing the TeleMagic 
program files might have the path and filename C:\TM\PROGRAMS\TM.EXE. 
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Instruction Conventions 
?? Sets of instructions are indented slightly and numbered. 

?? The word close means that the dialog box or window will close and, if applicable, 
any changes will be saved automatically. 

?? The word save  means that current work will be saved, leaving you free to execute 
other commands without losing any changes you may have made. 

?? The word cancel means that the current window will close, without saving any 
changes or affecting previous settings in any way. 

Symbols 
Note:  Additional information concerning the current section of text will appear in this format. 
Notes may be reminders, suggestions, or information that may or may not pertain to your 
installation. For example, instructions on deleting databases may contain a note regarding 
databases being used with Data Synchronization Server. 

WARNING!  Indicates precautionary information. Please read carefully before proceeding. 

 This symbol indicates a one-step procedure, or a set of alternative procedures. 

 Hint: This is information from our file of technical tips and tricks.
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Single User Installation 
Single User System Requirements 

?? IBM-compatible computer, Pentium II 233, with a minimum of 64 MB of RAM (128 MB 
recommended). 

?? Microsoft Windows 95, 98, ME, 2000, or newer, or Windows NT version 4.0 
(recommended). Service Pack 3 must be installed on Windows NT Server and 
Workstation. 

?? 200 MB or more free space on a hard disk for initially installing and/or upgrading 
TeleMagic. 

Note:  It will also vary depending on how many databases you install with TeleMagic. 
Databases require between 1 and 5 MB, depending on the size of the database. 

?? Additional disk space to store your records. Space requirements are dependent on the 
size of each record and the number of records stored. You will need additional space to 
perform rebuilds. (Rebuilds are a necessary TeleMagic maintenance procedure. The 
space required for performing rebuilds will vary according to the number of records and 
fields that exist in that database.) 

?? You must make 150 (minimum, 250 recommended) file handles available by using a 
FILES=150 statement in the CONFIG.SYS file. . If you are using Windows NT 
Workstation or Windows 2000 Professional, this change must be made in the 
CONFIG.NT file in the \SYSTEM32 directory. This is not necessary with Windows NT 
Server. 

 Hint: Note in your CONFIG.SYS or CONFIG.NT file why so many are necessary. 

Optionally, TeleMagic supports: 

?????Modem or other serial-attached dialer for your telephone. 

?? Class 1 or class 2 faxmodem. (A faxmodem can also be used to dial the phone. If you 
have a faxmodem, you do not necessarily need a separate modem to dial your phone.) 

?????Printer access (through Windows’ printer setup). 

?????Wireless Messaging access to a carrier terminal that supports modem transmissions. 
TeleMagic uses Telocator Alphanumeric Input Protocol (TAP) with its Wireless Messaging 
feature.  Your carrier must use TAP, and its implementation must be compatible with 
TeleMagic.  Not all carriers that use TAP use the same implementation.  Once you have set 
up the Wireless Messaging feature, it is recommended that you perform a test page to verify 
that your paging system is compatible and can accommodate pages from TeleMagic. 
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Single User Installation 
This set of instructions covers both the actual installation and the basic steps you need to 
follow to prepare TeleMagic’s program features for use. Full installation is an 8-step process. 
This section covers each step in detail, and suggests where you can learn more about each 
one. A summary of these steps can be found on page 16. 

 Hint:  Once you have completed the basic installation, take some time to become 
familiar with the program. You may want to create a “trial” setup first. You can 
always reinstall later. Even if you do not have time to become completely familiar 
with the program, it is best to spend a few hours exploring it before setting up 
your final installation. If you do create a trial version, do not register it. Register 
when you have the installation you want to keep. 

Step 1: Read All Installation-related Materials 
We urge you to read this entire chapter before installing your software. Having a basic 
understanding of the installation requirements before starting can save you a great deal of 
time and frustration later. Also, read the installation insert that accompanied your software. 
This contains important last-minute installation notes that can affect your installation. If you 
are upgrading or updating an earlier version of TeleMagic, carefully review the contents of 
the \DOCS folder on the installation CD. The files in this folder contain special instructions 
for upgrading from any earlier version of TeleMagic, including DOS and Professional 
versions, to V5. These files also contain important information for first-time installations. 

Step 2: Check TeleMagic’s System Requirements 
Make sure that your system meets minimum requirements and capacity for running 
TeleMagic. 

Step 3: Install TeleMagic on Your Hard Drive 

To Install TeleMagic on Windows ME, NT, or 2000: 

1. Insert the installation CD-ROM in your CD-ROM drive. The setup program will auto-
launch. 

or From the taskbar, select Start, Run. In the Open: field, type D:\V5SETUP.EXE (where 
D: is the drive letter of your CD-ROM) and click OK. 

 The setup program will launch. The setup program consists of a series of dialog boxes 
that will walk you through installation, step-by-step. 

2. Follow the on-screen installation instructions. 
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To Install TeleMagic on Windows 98: 

1. Insert the installation CD-ROM in your CD-ROM drive. Hold down the Shift key to 
prevent the setup program from automatically launching. 

or If the setup program automatically launches, click the Cancel button, and then click 
Exit Setup. 

2. From the Start menu on the taskbar, select Run. In the Open: field, type 
D:\UTILS\WIN98\DCOM98.EXE (where D: is the drive letter of your CD-ROM) and 
click OK. 

One or more Windows system files may be updated, depending upon the updates 
which have already been installed on this computer. 

3. Restart the computer when instructed to do so. 

4. From the Start menu on the taskbar, select Run. In the Open: field, type 
D:\V5SETUP.EXE (where D: is the drive letter of your CD-ROM) and click OK. 

 The setup program will launch. The setup program consists of a series of dialog boxes 
that will walk you through installation, step-by-step. 

5. Follow the on-screen installation instructions. 

To Install TeleMagic on Windows 95: 

1. Insert the installation CD-ROM in your CD-ROM drive. Hold down the Shift key to 
prevent the setup program from automatically launching. 

or If the setup program automatically launches, click the Cancel button, and then click 
Exit Setup. 

2. From the Start menu on the taskbar, select Run. In the Open: field, type 
D:\UTILS\WIN95\DCOM95.EXE (where D: is the drive letter of your CD-ROM) and 
click OK. 

One or more Windows system files may be updated, depending upon the updates 
which have already been installed on this computer. 

3. Restart the computer when instructed to do so. 

4. From the Start menu on the taskbar, select Run. In the Open: field, type 
D:\V5SETUP.EXE (where D: is the drive letter of your CD-ROM) and click OK. 

 The setup program will launch. The setup program consists of a series of dialog boxes 
that will walk you through installation, step-by-step. 

5. Follow the on-screen installation instructions. 
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Step 4: Open TeleMagic for the First Time and Complete Registration 
It is necessary to open TeleMagic to perform several of the following installation and setup 
steps. The first time you open TeleMagic, your User ID is added as a supervisor user during 
the logon process. A supervisor user has full access to all features, including adding users 
and databases. 

When you log in for the first time, you will be given the opportunity of entering a 
registration code that can be obtained by calling a toll-free number, by fax, or by e-mail. It is 
important for us to be able to inform you of program revisions, new links, and new database 
templates that will update your software. If you choose not to register at the time of your 
first logon, TeleMagic  will remind you that you have an unregistered copy and give you the 
opportunity to enter your registration number each time you launch it until registration is 
complete. You will be able to operate TeleMagic  without restriction for 45 days before 
registration is required. After that time, you must register to access the program. Contact 
TeleMagic Registration to receive your registration number. 

To Open TeleMagic for the First Time and Complete Registration by 
Telephone:  

1. Find the TeleMagic program icon or shortcut: 

 
The icon will appear in the program folder specified during installation. 

or Find the TeleMagic Enterprise entry on the Windows Start menu. 

2. Double-click the TeleMagic program icon, shortcut, or Start menu item.  

 TeleMagic will start and flash through the license screen. The TeleMagic  menu bar 
will display and a message will appear asking if you want to register. 

3. If you are ready to register, click Yes . 

Note: You may want to wait until you are satisfied that you will be keeping this 
installation before registering the program. 

or If you do not want to register at this time, click No and skip to step 12. You will be able 
to continue to use TeleMagic without restriction for 45 days before registration is 
required. After that time, you must register to access the program. 

If you select Yes , the following Registration dialog box will appear: 
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Sample Registration Dialog Box 

4. The Company Name and User Name fields will contain the information entered during 
installation. Edit these fields if necessary. (This information cannot be changed after 
TeleMagic is registered.) 

5. Select the Call In Registration radio button. 

6. Click Next. 

 A Product Registration dialog box will open. 

7. Enter the serial numbers for all of the products you are registering in the fields 
provided. (If this is first time registration, you must enter the TeleMagic serial number 
in the first field.) 

 The product you are registering will appear next to the serial number. 

8. Click Next when you have entered the serial number(s). 

 The Product Authorization dialog box will open. 

9. Call the phone number displayed on the screen to register the serial number you have 
entered. Be prepared to provide the serial number(s) and the Registration Code 
(displayed in the center of the screen). 

 You will receive an Authorization Code. 
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10. Enter the Authorization Code in the field provided. 

Click on Next when the Authorization Code has been entered. 

 The Save Registration Information dialog box will open, detailing what you are 
registering. 

11. If the information displayed is correct, click Finish to complete the registration 
process. 

or If the information displayed is not correct, click Back to return to previous screens 
where you can correct any errors. 

A series of messages will indicate that TeleMagic is installing templates. 

12. The first time logon dialog box will appear: 

TeleMagic Logon Dialog Box 

The user logging into TeleMagic the first time it is opened will be added to TeleMagic 
as a new user, and assigned a supervisor’s security rights. The next time you (or 
anyone else) log in, the Logon dialog box will look slightly different, and their User ID 
and Password entered must already be set up in the system to open TeleMagic. 

Note: Make sure that the user logging in is, in fact, a user to whom you want to give 
supervisor rights. (The user’s rights can be changed later if necessary.) 

13. Type a three-character User ID. For the sake of simplicity, most users enter their 
initials. 

14. Type your name. 
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15. Type a password (optional). 

 This information, User ID, password, and name, will be added to the list of users in 
TeleMagic. (The only other user in the system at this point is the default supervisor 
user, TST.) The information may be changed at a later time, if necessary. 

16. Click OK. 

 You will receive a message confirming creation of the new user. 

17. Acknowledge the confirmation message. 

 The Contact Manager will open. 

To Open TeleMagic for the First Time and Complete Registration by 
Email or Fax:  

Registering by fax is a two-part process: first, you must enter your serial numbers and 
generate a printout of your regis tration information to fax to TeleMagic, and then you 
must enter the authorization code that is faxed back to you from TeleMagic. 

To Receive an Authorization Code 

1. To register your copy of TeleMagic, launch TM.EXE and select Yes  when asked if 
you would like to register. 

 A Product Registration dialog box will open. 

If this is an evaluation or unregistered copy of TeleMagic, the Company Name and 
User Name fields will become available. You may use these fields to change the 
registration information that was entered during installation. (Once TeleMagic is 
registered, you will not be able to modify this information.) 

2. If you want to change the company name entered during installation, enter the correct 
name in the Company Name field. 

3. If you want to change the user name to whom the product is registered, enter the 
correct user in the User Name field. 

4. Select the Fax Registration radio button to fax in your registration information. 

or Select the Email Registration radio button to send your registration information 
through e-mail. 

5. Click Next to proceed. 

 A Second Product Registration dialog box will open. 
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6. Enter the serial numbers for all of the products you are registering in the fields 
provided. (If this is first time registration, you must enter the TeleMagic serial number 
in the first field.) 

 The product you are registering will appear next to the serial number.  

7. Click Next when you have entered the serial number(s). 

 The Save Registration Information dialog box will open detailing what you are 
registering. 

8. Verify that the information is correct and click Next to proceed. 

or Click Back to return to the previous screen to add additional product serial numbers 
or adjust any of the existing information. 

 The User Information dialog box will open. (This dialog box will contain a Print button 
if you are faxing registration, or a Done button if you are e-mailing registration.) 

9. Enter your name, address, telephone, e-mail address, and dealer information in the 
fields provided. (Your Dealer ID can be found on your Key Card.) 

10. If you are sending your registration by e-mail, click Done and skip to step 14.  

or If you are registering by fax, click Print to print the information on your default 
printer.  

 If you are faxing your registration information, a message will appear confirming that 
you are ready to print. 

11. Select Yes  to print the registration information. 

or Select No to return to the User Information screen where you can adjust your 
information or click Back to change your serial number information. 

 When you click Yes, the Windows Print dialog box will appear. 

12. Click OK to send the registration information to your printer. 

 A message will appear asking if the information printed. 

13. Select Yes  if the registration information was successfully printed. 

or Select No to return to the Windows Print dialog box where you can click Setup to 
adjust your printer settings. 

Note:  If you have not yet faxed in your registration printout and you discover that 
you need to adjust your registration information after it has printed, you can access 
the Register option from the File menu to edit your selections. Select the Enter 
authorization code or change registration information radio button, then select No 
when you are asked if you would like to enter your authorization code. You will be 



 Installation  

System Administrator Guide 

14 

returned to the Product Registration screen where you can adjust your selections as 
necessary. 

 14. Fax the document to TeleMagic at the number indicated on the registration form. 

or If you are registering by e-mail, a message will appear giving the path and file name of 
the file that you should e-mail to TeleMagic. Click OK to acknowledge the message 
and include the specified file as an attachment to an e-mail message to TeleMagic at 
register@telemagic.com. 

 Your authorization code will be sent to you via return fax or e-mail. Your product is 
not yet registered. If you have added additional users, they will not be available until 
you enter your authorization code. If you are registering your TeleMagic installation 
you will continue to be asked if you would like to register each time you launch 
TeleMagic until you enter your authorization code. 

To Enter Your Authorization Code 

1. Launch TM.EXE and select Yes  when asked if you would like to register. 

or If your installation of TeleMagic is already registered and you are adding additional 
users to TeleMagic, select File, Register…. 

 A Product Registration dialog box will open. 

2. Select the Enter authorization code or change registration information radio button. 

3. Click Next to proceed. 

 You will be asked if you would like to enter your authorization code. 

4. Select Yes. 

 The Product Authorization dialog box will open. 

5. Enter your Authorization Code in the field provided. 

The Save Registration Information dialog box will open. 

6. If the information displayed is correct, click Finish to complete the registration 
process. 

or If the information displayed is not correct, click Back to return to previous screens 
where you can correct any errors. 

 Once the authorization code has been successfully entered, your TeleMagic 
installation will be registered and any users you have added will be available for use. 
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 Step 5: Create and/or Configure Your Databases 
When you installed TeleMagic you had several installation options, each of which provides 
a different set of databases. TeleMagic’s customizability allows you to make any necessary 
changes to those databases, or create completely new databases to your exact 
specifications. Before beginning to use TeleMagic, it is a good idea to explore the 
database(s) you have installed to determine if they fit your needs as is, or if you need to 
make changes or create a new database. For information on creating and customizing 
databases, see the Database Management and Screen Designer chapters. 

 Hint: The pre-designed databases include a selection of sample records that allow 
you to familiarize yourself with your database before adding your own records. 
Consider making a copy of the sample databases without the records. Users can 
explore the sample records, then switch to the copy to begin actually working in 
TeleMagic. 

Step 6: Add Users to TeleMagic  
If you are the only one who will be accessing TeleMagic, you can continue to use the User 
ID you set up when you logged on without worrying about adding additional users. If other 
individuals will also be accessing TeleMagic, you may want to set up additional User IDs. 
Although you are limited to only having one user logged into TeleMagic at a time, the total 
number of users that can be added to TeleMagic is limited only by the number of unique, 
three-character combinations that can be formed. For information on creating new users, see 
step 7 in the Multi-user (Network) Installation section of this guide. 

 Hint: TeleMagic was designed to be used by groups of users working on a network; 
however, if you have multiple users you can still use the workgroup tools (such 
as the Bulletin Board and group activities) on a single user installation. Rather 
than receiving shared information immediately, as on a network, users will 
receive it the next time they logon to TeleMagic with their User IDs. 

Step 7: Set Up the TeleMagic Program Features You Will Be Using 
TeleMagic allows you to configure most of its features to precisely fit your needs. For 
example, you can create scripts specific to your company to be used with the Branch 
Scripting feature, and set up a list of company resources that can be reserved for use with 
activities. Before you begin to work in TeleMagic, it is a good idea to perform the basic setup 
in those areas of TeleMagic. 

You should also configure database and system preferences at this time.  
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Step 8: Back Up the TeleMagic Directories 
You should now make a complete backup of your TeleMagic installation before you actually 
begin using it. 

Installation Checklist  
Use the following checklist to verify that the installation was complete: 

?? Read this chapter and the installation insert. 

?  Ensure that the machine on which you are installing TeleMagic meets the planned 
minimum requirements and capacity for installation. 

?  Install TeleMagic on your hard drive. 

?  Open TeleMagic for the first time, adding yourself as a user while doing so. 

?  Create any databases that you will want in your system, or customize the 
database(s) that are automatically installed. (This step may be performed any time 
after installation. You may want to skip it at this point if you have not yet decided 
exactly what your database setup will be.) 

?  If necessary, add any additional users who will be accessing TeleMagic. 

?  If necessary, perform any desired setup for the program features (including 
database and installation preferences) you will be accessing. 

?  Back up the TeleMagic directories for safekeeping. 

Multi-user (Network) Installation 
Multi-user System Requirements 

Multi-user Hardware 
Faster workstations will run TeleMagic faster, but there are important improvements you can 
make on existing equipment. See the Optimization section of the Utilities and Maintenance 
chapter for more information. 

Server 

The network on which you are planning to share TeleMagic  will need: 

?? 100% NET BIOS compatible server able to accommodate DOS drive mapping. 
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Note: TeleMagic must be installed to a directory, such as into F:\TM. 

?? Room to open at least 100 files for each user’s PC. You must also have sufficient 
environment space for record and file locking on each of those 100 files. Some 
networks (especially peer-to-peer networks such as LANtastic) have ways to set 
the total number of file handles for the entire network; most require changes to the 
setting for each workstation or user’s network configuration files. See your network 
documentation for instructions on this setting. If you are using a Microsoft NT 
network, you may need to consider the implications of Opportunistic Locking. See 
the Microsoft Knowledge Base for more information on oplock. 

?? The latest, most reliable version or patch set for your network. Check with your 
network provider or support specialist for its current state. 

?? 200 MB, or more, free disk space on the server to perform full installation of 
TeleMagic. 

Note: This  free space requirement can vary considerably for systems using disk 
compression. It will also vary according to how many databases you select to 
install. Databases require between 1 and 5 MB, depending on the size of the 
database. 

?? Additional disk space to store your records. Space requirements are dependent on 
the size of each record, and the number of records stored. You will need additional 
space to perform rebuilds. (Rebuilds are a necessary TeleMagic maintenance 
feature. The space required for performing rebuilds will vary according to the 
number of records and fields that exist in that database.) 

?? Optionally, 2 MB or more disk space, per TeleMagic user, on the network for 
temporary files. 

Note: There is an option to perform a workstation setup, which creates the 
temporary files on the user’s local workstation. If users are working on a node, you 
do not need to allocate space on the network for temporary files. 

?? Maximum available cache RAM. With most servers, the more RAM you have on 
the server, the faster the network response will be. This will also improve 
performance of other networked programs. 

Workstation Requirements 

These are the minimum requirements for each workstation that will run TeleMagic: 

?? IBM-compatible computer, Pentium 233, with a minimum of 64 MB of RAM (128 MB 
recommended). 
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?? Microsoft Windows 95, 98, ME, or newer, or Windows NT version 4.0 or 2000 
(recommended). Service Pack 3 must be installed on Windows NT Server and 
Workstation. Service Pack 4 is recommended. 

?? Optionally, 2 MB or more disk space for the temporary files for each user of 
TeleMagic. 

Note: Whether temporary files are stored on the network or on a user’s workstation 
depends on if a workstation setup has been performed. 

?? You must make 150 (minimum, 250 recommended) file handles available by using a 
FILES=150 statement in the CONFIG.SYS file, or by using a similar setting in your 
network's configuration file (consult your network documentation for instructions 
on setting file handles). If you are using Windows NT Workstation or Windows 
2000 Professional, this change must be made in the CONFIG.NT file in the 
\SYSTEM32 directory. This is not necessary with Windows NT Server. 

Optionally, workstations using TeleMagic can have: 

?? A modem or other serial-attached dialer for your telephone. 

?? Class 1 or class 2 faxmodem. A faxmodem can also be used to dial the phone—if 
you have a faxmodem, you will probably not need an additional modem for dialing 
the phone. 

 Hint: If your workstation does not have access to a faxmodem, you can set 
up the Automation Server on the network to send faxes. 

?? Printer access through Windows. 

?? Wireless Messaging access to a carrier terminal that supports modem 
transmissions. TeleMagic uses Telocator Alphanumeric Input Protocol (TAP) with 
its Wireless Messaging feature.  Your carrier must use TAP, and its implementation 
must be compatible with TeleMagic.  Not all carriers that use TAP use the same 
implementation. Once you have set up the Wireless Messaging feature, it is  
recommended that you perform a test page to verify that your paging system is 
compatible and can accommodate pages from TeleMagic. 

Multi-user Software 

Supported Networks 

TeleMagic will support nearly any network, either true client/server or peer-to-peer. It has 
been tested on Novell NetWare, Windows NT, LANtastic, Banyon Vines, and Invisible 
LAN. It should work on all 100% NETBIOS-compatible networks, as well. It does require that 
the network be set up before installation. 
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In all networks it is necessary for “drive mappings” to be set up before installation to make 
sure all users of TeleMagic point to the same drive letter. Drive mappings provide a way to 
read and write data from the non-local (network) drives. For instance, the F: drive often maps 
to the first network directory. If a user does not log into the network and perform the steps 
necessary for drive mapping, then he or she cannot access files on the network. TeleMagic 
must be installed to the same drive letter that all users will be using. For example, if you 
install to F:\TM, all users must be able to access F:\TM and its associated sub-directories on 
drive F:. 

Use of TeleMagic also requires appropriate network rights to access its own directories. In 
client/server networks, such as NetWare, this means setting up access (or trustee) rights so 
users can read, write, erase, create, and modify files in the TeleMagic directories. These 
settings must be done by a network administrator or someone with “supervisor equivalent” 
rights. Access to database directories can be denied, using network security, to prevent 
access to tables. 

Note: It is not recommended that you run TeleMagic on a diskless workstation. 

Specific network requirements apply to installations using TeleMagic NetClient and 
TeleMagic NetClient – Browser Edition. See the TeleMagic NetClient – Server Guide for 
details. 

Other Software Requirements 

Microsoft Windows requires that you install network support before the program will 
properly access network resources. You should also make sure that Windows has been 
properly set up to recognize your network. 

More about networks and Windows can be found in the Windows Help, the documents in 
the \DOCS folder of your installation CD, in the NETWORK.TXT file in the Windows 
directory, in your network installation guides, and from your authorized network reseller or 
integrator. 

Multi-user Installation 
This set of instructions covers the actual installation and basic steps you will need to follow 
to prepare TeleMagic for use by users who will need to access it. Full installation on a 
network is a 10-step process. This section covers each step in detail, and suggests where 
you can learn more about each one. A summary of these steps can be found on page 30. 
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 Hint: Once you have completed the basic installation, take some time to become 
familiar with the program. You may want to create a “trial” setup first. You can 
always reinstall later. If you have the time, run TeleMagic as a single-user 
application for a while. Your company’s setup may dictate some customizations 
that will only become obvious after using the program for a while. Even if you 
do not have time to become completely familiar with the program, it is best to 
spend at least a few hours exploring it before you set it up for your users. If you 
do create a trial version, do not register it. Register when you have the 
installation you want to keep. 

Step 1: Read All Installation-related Materials 
Read this entire chapter before installing your software. Having a basic overview in mind of 
the installation requirements before beginning can save you a great deal of time and 
frustration later. Also, read the installation insert that accompanied your software. This 
contains important last-minute installation notes that can affect your installation. 

Step 2: Check TeleMagic’s System Requirements 
Make sure that the network meets minimum requirements and capacity for each user and all 
network traffic. 

Step 3: Check TeleMagic’s Workstation Requirements 
Ensure that each user’s  workstation will be adequate for the tasks required in the program.  

Step 4: Install TeleMagic on the Network 

To Install TeleMagic on the Network: 

Note: If you are installing from a Windows 95 workstation, please see the special 
instructions for Windows 95 users in step 3 of the Single User Installation section of this 
guide. 

1. Log onto your network under an account that has the following rights: 

?????Rights to copy files to the network. 

?????Rights to use at least 200 MB hard disk storage space on the network. 

Note:  This requirement will vary according to the number of databases you 
select to install. Each database will require between 1 and 5 MB, depending on 
the size of the database, in addition to the minimum requirement. 
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?????Rights to create directories in a shared program area. 

Note: Often, these are accomplished by logging onto the network as the 
SUPERVISOR user or equivalent. 

2. Insert the installation CD in your CD-ROM drive. The setup program will auto-launch. 

or From the Start menu on the taskbar, select Run. In the Open: field, type 
D:\SETUP.EXE (where D: is the drive letter of your CD-ROM) and click OK. 

 The setup program will launch. The setup program consists of a series of dialog boxes 
that will walk you through installation, step-by-step. 

3. Follow the on-screen installation instructions. 

Step 5: Open TeleMagic for the First Time and Complete Registration  
It is necessary to open TeleMagic to perform several of the following installation and setup 
steps. The very first time you open TeleMagic, your User ID is added as a supervisor user 
during the logon process. A supervisor user has full access to all features, including adding 
users and databases. 

When you log in for the first time, you will be given the opportunity of entering a 
registration code that can be obtained by calling a toll-free number, by fax, or by e-mail. It is 
important for us to be able to inform you of program revisions, new links, and new database 
templates that will update your software. If you choose not to register at the time of your 
first logon, TeleMagic  will remind you that you have an unregistered copy and give you the 
opportunity to enter your registration number each time you launch it until registration is 
complete. You will be able to operate TeleMagic  without restriction for 45 days before 
registration is required. After 45 days, you must register to access the program. Contact 
TeleMagic Registration to receive your registration number. 

To Open TeleMagic for the First Time and Complete Registration by 
Telephone:  

1. Find the TeleMagic program icon or shortcut:  

 
The icon will appear in the program group or folder specified during installation. 

2. Double-click the TeleMagic program icon or shortcut.  

 TeleMagic will start and flash through the license screen. The TeleMagic  menu bar 
will display and a message will appear asking if you want to register. 

3. If you are ready to register, click Yes . 
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or If you do not want to register at this time, click No and skip to step 12. You will be able 
to continue to use TeleMagic without restriction for 45 days before registration is 
required. After that time, you must register to access the program. 

If you select Yes , the following Registration dialog box will appear: 

 
Sample Registration Dialog Box 

4. The Company Name and User Name fields will contain the information entered during 
installation. Edit these fields if necessary. (This information cannot be changed after 
TeleMagic is registered.) 

5. Select the Call In Registration radio button. 

6. Click Next. 

 A Product Registration dialog box will open. 

7. Enter the serial numbers for all of the products you are registering in the fields 
provided. (If this is first time registration, you must enter the TeleMagic serial number 
in the first field.) 

 The product you are registering will appear next to the serial number. 

8. Click Next when you have entered the serial number(s). 

 The Product Authorization dialog box will open. 

9. Call the phone number displayed on the screen to register the serial number you have 
entered. Be prepared to provide the serial number(s) and the Registration Code 
(displayed in the center of the screen). 
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 You will receive an Authorization Code. 

10. Enter the Authorization Code in the field provided. 

Click on Next when the Authorization Code has been entered. 

 The Save Registration Information dialog box will open detailing what you are 
registering. 

11. If the information displayed is correct, click Finish to complete the registration 
process. 

or If the information displayed is not correct, click Back to return to previous screens 
where you can correct any errors. 

A series of messages will indicate that TeleMagic is installing templates. 

12. The first time logon dialog box will appear: 

TeleMagic Logon Dialog Box 

The user logging into TeleMagic the first time it is opened will be added to TeleMagic 
as a new user, and assigned a supervisor’s security rights. The next time you (or 
anyone else) logs in, the Logon dialog box will look slightly different, and their User 
ID and Password entered must already be set up in the system to open TeleMagic. 

Note: Make sure that the user logging in is, in fact, a user to whom you want to give 
supervisor rights. (The user’s rights can be changed later if necessary.) 

13. Type a three-character User ID. For the sake of simplicity, most users enter their 
initials. 

14. Type your name. 
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15. Type a password (optional). 

 This information, User ID, password, and name, will be added to the list of users in 
TeleMagic. (The only other user in the system at this point is the default supervisor 
user, TST.) The information may be changed at a later time, if necessary. 

16. Click OK. 

 You will receive a message confirming creation of the new user. 

 The Contact Manager will open. 

To Open TeleMagic for the First Time and Complete Registration by 
Email or Fax:  

Registering by fax is a two-part process: first you must enter your serial numbers and 
generate a printout of your registration information to fax to TeleMagic, then you must 
enter the authorization code that is faxed back to you from TeleMagic.  

To Receive an Authorization Code 

1. To register your copy of TeleMagic, launch TM.EXE and select Yes  when asked if 
you would like to register. 

 A Product Registration dialog box will open. 

If this is  an evaluation or unregistered copy of TeleMagic, the Company Name and 
User Name fields will become available. You may use these fields to change the 
registration information that was entered during installation. (Once TeleMagic is 
registered, you will not be able to modify this information.) 

2. If you want to change the company name entered during installation, enter the correct 
name in the Company Name field. 

3. If you want to change the user name to whom the product is registered, enter the 
correct user in the User Name field. 

4. Select the Fax Registration radio button to fax in your registration information. 

or Select the Email Registration radio button to send your registration information 
through e-mail. 

5. Click Next to proceed. 

 A Second Product Registration dialog box will open. 

6. Enter the serial numbers for all of the products you are registering in the fields 
provided. (If this is first time registration, you must enter the TeleMagic serial number 
in the first field.) 

 The product you are registering will appear next to the serial number.  
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7. Click Next when you have entered the serial number(s). 

 The Save Registration Information dialog box will open detailing what you are 
registering. 

8. Verify that the information is correct and click Next to proceed. 

or Click Back to return to the previous screen to add additional product serial numbers 
or adjust any of the existing information. 

 The User Information dialog box will open. (This dialog box will contain either a Print 
button if you are faxing, or a Done button if you are e-mailing registration.) 

9. Enter your name, address, telephone, e-mail address, and dealer information in the 
fields provided. (Your Dealer ID can be found on your Key Card.) 

10. If you are sending your registration by e-mail, click Done and skip to step 14.  

or If you are registering by fax, click Print to print the information on your default 
printer.  

 If you are faxing your registration information, a message will appear confirming that 
you are ready to print. 

11. Select Yes  to print the registration information. 

or Select No to return to the User Information screen where you can adjust your 
information or click Back to change your serial number information. 

 When you click Yes, the Windows Print dialog box will appear. 

12. Click OK to send the registration information to your printer. 

 A message will appear asking if the information printed. 

13. Select Yes  if the registration information was successfully printed. 

or Select No to return to the Windows Print dialog box where you can click Setup to 
adjust your printer settings. 

Note:  If you have not yet faxed in your registration printout and you discover that 
you need to adjust your registration information after it has printed, you can access 
the Register option from the File menu to edit your selections. Select the Enter 
authorization code or change registration information radio button, then select No 
when you are asked if you would like to enter your authorization code. You will be 
returned to the Product Registration screen where you can adjust your selections as 
necessary. 

14. Fax the document to TeleMagic at the number indicated on the registration form. 

or If you are registering by e-mail, a message will appear giving the path and file name of 
the file that you should e-mail to TeleMagic. Click OK to acknowledge the message 
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and include the specified file as an attachment in an e-mail to TeleMagic at 
register@telemagic.com. 

 Your authorization code will be sent to you via return fax or e-mail. Your product is 
not yet registered. If you have added additional users, they will not be available until 
you enter your authorization code. If you are registering your TeleMagic installation 
you will continue to be asked if you would like to register each time you launch 
TeleMagic until you enter your authorization code. 

To Enter Your Authorization Code 

1. Launch TM.EXE and select Yes  when asked if you would like to register. 

or If your installation of TeleMagic is already registered and you are adding additional 
users to TeleMagic, select File, Register…. 

 A Product Registration dialog box will open. 

2. Select the Enter authorization code or change registration information radio button. 

3. Click Next to proceed. 

 You will be asked if you would like to enter your authorization code. 

4. Select Yes. 

 The Product Authorization dialog box will open. 

5. Enter your Authorization Code in the field provided. 

The Save Registration Information dialog box will open. 

6. If the information displayed is correct, click Finish to complete the registration 
process. 

or If the information displayed is not correct, click Back to return to previous screens 
where you can correct any errors. 

 Once the authorization code has been successfully entered, your TeleMagic 
installation will be registered and any users you have added will be available for use. 

Step 6: Create and/or Configure Your Databases 
When you installed TeleMagic, you were given a choice of what databases you want to 
install. TeleMagic’s customizability allows you to make any necessary changes to those 
databases, or create completely new databases to your exact specifications. Before 
beginning to use TeleMagic, it is a good idea to explore the database(s) you have installed 
to determine if they fit your needs as is, or if you need to make changes or create a new 
database. For information on creating and customizing databases, see the Database 
Management and Screen Designer chapters. 
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 Hint: The pre-designed databases include a selection of sample records that allow 
you to familiarize yourself with your database before adding your own records. 
Consider making a copy of the sample databases without the records. Users can 
explore the sample records, then switch to the copy to begin actually working in 
TeleMagic.  

Step 7: Add Users to TeleMagic   
TeleMagic was designed to work efficiently in a multi-user environment. Once a user is 
added to the system, he or she can log into TeleMagic and start using the program. 

As many users can be added to TeleMagic as there are unique, three-character combinations 
of letters and numbers; however, depending on the user limit of the version you have 
installed, only a certain number of users may log into TeleMagic at one time. (If you have 
installed a five-user network for example, only five users may log in at the same time, no 
matter how many users you have added.) 

To find out how many users are allowed to simultaneously use your copy of TeleMagic, 
open the About screen by selecting About from the Help menu. The number of users will be 
listed right after the version number. If you want to increase your maximum number of users, 
you will have to purchase a TeleMagic  Additional User License. Contact your TeleMagic 
Reseller for more information. 

When a user is added to TeleMagic, you should establish the user’s security and the user’s 
preferences. Security controls what areas of TeleMagic the user may access. Preferences are 
options that allow you to configure TeleMagic to a user. 

We recommend that, rather than adding new users one-by-one, you set up master template 
users. Master template users are users who have been created solely for the purpose of 
allowing you to quickly copy them when adding “real” users. Create your master template 
users with complete security settings and preferences, then add your individual users  by 
copying those template users to real names. Doing so will copy all the settings of the 
template user to the actual user, saving you from having to set the security and preferences 
for each user individually. 

You can have any number of different master template users, one for each class of user in 
your company. For example, if your organization includes salespeople, administrators and 
order-fulfillment personnel, you may have three different sets of master template users. If 
you have multiple classes of users, create one user in each class, with names like “Master 
Sales User”. You will copy these masters to individual names later. You may want to add 
passwords to the master template users; passwords will not be copied to the individual users 
when you copy the users later. Adding passwords to the master template users will keep 
these accounts from being used without authorization. 
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To Create a Master Template User:  

1. From the Options menu, select Preferences . 

 The Preferences dialog box will open. 

2. Click on the Users  tab. 

 The Users Preferences page will open: 

 
Users Preferences Page 

 The list of users will include the user who logged into TeleMagic for the first time and 
Terry S. Thompson, the TeleMagic sample user. 

3. Click Add. 

 The Properties dialog box will open. 

4. Enter a User ID for your template user. 

 Example: MSU. 

Note: You can only use a particular User ID for one TeleMagic user at a time in the 
current installation. If you know what User IDs the individuals you will be adding to 
TeleMagic, do not use those IDs for the master template user. (Most TeleMagic users 
use their initials for their User IDs.) 

5. In the Name: field, enter an identifying name for the template user. 

 Example: Master Sales User 
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Note:  Pager Number, Pager ID, and e-mail address are not necessary for user 
templates. 

6. Click Change Password.  

 A Change Password dialog box will appear: 

7. Enter a password for the template user in the Enter New Password: field. 

8. Enter the password again in the Confirm New Password: field. 

Note: If the entries do not match, you will be required to enter the password again. 
9. Click OK to save the password. 

 Hint: Keep the passwords written down in a safe place for future reference. 

10. Click OK. 

11. Repeat steps 3 through 10 for each template user you want to create. 

12. Click OK to exit the Users Preferences page. 

13. From the Options menu, select Security. 

 The System Level Security screen will open. 

14. Create the necessary security groups for each template user. Press the F1 key for help 
on the available System Level Security options. 

Note: Make sure you grant the user rights to edit preferences. (You can restrict these 
rights after you have configured the user’s preferences, if necessary.) 

15. Click OK to exit the System Level Security screen. 

16. From the File menu, select Change User. 

 A logon dialog box will open: 

 
Logon Dialog Box 

17. In the User ID: field, enter the ID for your template user. 

18. Enter the template user’s password in the Password: field. 

19. Click OK. 
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 You will be logged into TeleMagic as the template user. The Select Database dialog 
box will appear: 

 
Sample Select Database Dialog Box 

20. Select any of the databases the user will have to access and click Open. 

 The Contact Manager will open. 

21. From the Options menu, select Preferences . 

 The Preferences dialog box will open. 

22. Set the user preferences for the template user. Press the F1 key for help on the 
available Preferences options. 

Note: Contact preferences relate to the current database for the user. If the user will be 
accessing multiple databases, open each database in turn and set Contact 
preferences. The user’s startup database is also determined in Contact preferences. 

23. Repeat steps 16 through 22 for each template user. 

24. From the File menu, select Change User and log back into TeleMagic with your User 
ID. 

25. If necessary, access security (select Security from the Options menu) and restrict 
access to preferences for your existing security groups. 

 When all of the necessary template users have been established, you are ready to 
begin adding users. 

To Add Users to TeleMagic:  

1. From the Options menu, select Preferences . 
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 The Preferences dialog box will open. 

2. Click on the Users  tab. 

 The Users Preferences page will open with a list of the master template users you 
have added. 

3. Highlight the desired template user. (For example, to add a TeleMagic user who works 
in the sales department, in the above example you would highlight the Master Sales 
User (MSU) template user.) 

4. Click Copy. 

 The Properties dialog box will open. 

5. Enter a User ID for the user. 

 Hint: Most TeleMagic users use their initials for their User IDs. 

6. In the Name: field, enter the user’s name. 

7. If you want to set a password for the user, click Change Password. 

Note: Users may change their passwords at any time, so this step is optional. 
 A Change Password dialog box will appear. 

8. Enter a password for the user in the Enter New Password: field. 

9. Enter the password again in the Confirm New Password: field. 

Note: If the entries do not match, you will be required to enter the password again. 
10. Click OK to save the password. 

 Hint: Make sure you note the password and give it to the user. The user will be 
required to enter the password to access TeleMagic. 

11. Click OK. 

12. Repeat steps 3 through 11 for each user you want to create. 

13. Click OK to exit the Preferences dialog box. 

Step 8: Set Up the TeleMagic Program Features You Will Be Using 
TeleMagic allows you to configure most of its features to precisely fit your needs. For 
example, you can create scripts specific to your company to be used with the Branch 
Scripting feature, and set up a list of company resources that can be reserved for use with 
activities created by your users. Before users begin to work in TeleMagic, it is a good idea to 
perform the basic setup to those areas of TeleMagic they will need to access. The help 
system TUTORIAL.HLP will step you through most common setup procedures online. You 
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will be able to leave annotations at any step in the procedure in this help system for future 
reference. 

You should also configure database and system preferences at this time.  

Step 9: Set Up Users’ Working Copies 
TeleMagic offers a local workstation installation option that can copy the system files from 
the global directory on the network drive to a local hard disk drive. Users will still be 
accessing the common information on the network, but most of the processing will take place 
locally. Setting your installation up in this manner means that TeleMagic will run faster for 
individual users, though it takes up more room on the user’s computer. If you want to 
optimize TeleMagic, it is recommended that you perform workstation setup on each 
workstation that will be used to access TeleMagic. 

 To install TeleMagic on a network workstation, select Workstation Setup from the File 
menu and follow the on-screen instructions. 

Note: You must have approximately 60 MB free disk space available on each 
workstation’s hard disk for storing TeleMagic files if you are using this node option. 

Step 10: Backing up the Installed Program Directories 
At this point you would be wise to make a complete backup of your TeleMagic installation 
before users begin actually using it. 

We also recommend that you hide any sensitive files at this point. The file REBUILD.EXE, 
used to run an external rebuild, is an example of a file that should not be available to most 
users. Like an internal rebuild, an external rebuild packs and reindexes TeleMagic files, 
helping the program run more efficiently. However, rebuild should only be run when you are 
certain that no other users are in TeleMagic. To keep rebuild in the hands of qualified users, 
you should at this point place the file REBUILD.EXE in a safe place. The icon in the 
TeleMagic program group that represents the external rebuild utility should also be hidden 

Network Installation Checklist  
Use the following checklist to verify that the installation was complete:  

??Read this chapter and the installation insert. Carefully follow any instructions and 
precautions, paying special attention to information specific to your network. 

??Ensure that the network meets the planned minimum requirements and capacity for each 
user and all network traffic. 

??Ensure that each planned user’s workstation is adequate to the tasks in the program. 
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??Establish a security plan. Security is established for the prevention of inadvertent as 
well as intentional data loss. Therefore, even if you feel that your data is not particularly 
sensitive, you should still establish protocols to minmize losses due to accidents, natural 
disasters, and so forth. 

??Install TeleMagic on the master, shared network directory. 

??Open TeleMagic for the first time, adding yourself as a user while doing so. Test the 
installation on your computer while logged into the network with a user-equivalent network 
logon. 

??Create any shared databases that you will want in your system, or customize the 
database(s) that are automatically installed. (This step may be performed any time after 
installation. You may want to skip it at this point if you have not yet decided exactly what 
your database setup will be.) 

??Add users to TeleMagic. Be sure to set a password for the administration account. You 
may also want to supply “starter” passwords for each user. Users always have the ability to 
change their own password. (A TeleMagic supervisor has the ability to set these passwords 
to new values, in the event a user forgets his or her password.) 

??Perform the necessary setup for the program features (including database and 
installation preferences) users will be accessing. 

??Set up users’ working copies. Install TeleMagic on the users’ workstations and copy 
files, using the Workstation Setup option on the File menu. Test the installation on a user 
workstation with a user network logon. 

??Back up the installed program directories for safekeeping.
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TeleMagic Contact Databases 
When you installed TeleMagic, you were able to select from a list of pre-designed 
databases. If you selected any of these databases, you will be able to begin using them right 
away. No additional setup is required. (In addition to the databases you selected, TeleMagic 
comes installed with the Documentation and Company/Contact databases. The examples 
found in the TeleMagic documentation are based on the Documentation database.) 

Each of these databases includes sample records. Use these records to explore the databases 
and get a feel for how each database is used. It is possible that the installed databases will 
meet your requirements with little or no changes. If not, you can change the existing 
databases  as required to meet your needs, or to create your own databases.  

Database Installation and Configuration 
There are several ways to approach the task of adding a new database to your TeleMagic 
installation: 

?? Copy and modify an existing, installed database 

?? Install a database from the installation CD-ROM 

?? Add a database based on an existing template with pre-defined fields and views 

? Add a blank database (based on a blank template), with no fields and blank views 

When you are just starting, it is easiest to create a database from a pre-defined template, 
rather than starting with a blank view. The sample databases and templates included with 
TeleMagic are there to guide you in setting up your own custom layouts to hold your own 
information. We recommend that you create databases by installing and modifying these 
templates, or by copying and modifying the sample databases—when you are first learning 
database design, the creation process can be less frustrating and easier to get right by 
borrowing from the work of others. 

You cannot “break” anything as long as you conduct your experiments on sample data. If 
you do not copy over your live data, you cannot do any permanent harm. We encourage 
you to experiment; it will help you to become better acquainted with TeleMagic. 
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Making Your Own Database: Some Cautions 
It may help you to design your database on paper before you program it. This can keep you 
from getting bogged down in programmatic details while you are brainstorming. 

As you design your database, consider the impact your design will have on the efficiency of 
the program. A large number of memo fields, rollup lists, and OLE fields may slow down the 
operation of TeleMagic. Of course, you should make your database as complex as you need 
it to be, but use careful planning to avoid adding unnecessary items to the screen. In 
general, the simpler the screen you design, the more quickly the program will perform. 

 Hint: Schedule regular rebuilds of your database, especially if they contain notepads, 
to ensure maximum speed. 

Planning Database Location 
By default, databases will be created in sub-directories off the TeleMagic \TM\DATA 
directory. You can, however, store your database in any location you like, as long as it is in a 
new or empty directory. Before changing the location of the database from the default, if you 
are on a network, it is important to give some thought to network access before creating your 
database. Only users who have access to the selected network drive and directory will be 
able to use the database. Unless it is your intention to keep certain users from being able to 
access a database, make sure the network location you select is accessible to all. If you are 
on a network and add a database to your local C: drive, that database will only be accessible 
from your workstation. 

If you do choose to add a database to your C: drive, you should be careful that you do not 
use the same directory name that another user has used to add a database to a local drive. 
For example, if another user has a database stored in the path C:\DATABASE\ on his or her 
workstation, and you add a database to the path C:\DATABASE\ on your workstation, there 
is potential for confusion.  

TeleMagic recognizes databases by their location. When you select either of these locally 
stored databases from the Select Database selection box, TeleMagic will search your C: drive 
for the directory \DATABASE\ and use that database. If you try and open the database that 
is stored on the other user’s local drive, instead of being warned that you have no access to 
the database, you will be taken to the one on your local drive.  

To avoid running into such problems, we advise network administrators to monitor all 
database paths and ensure that they are unique.  
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Copying Existing Databases 
The easiest way of creating a new database is to copy an existing database. When you copy 
a database, all of the existing fields and views will be copied. You will also have the option of 
copying existing records and database security. 

To Copy an Existing Database: 

1. From the File menu, choose Select Database.  

The list of databases available in the program will appear: 

 

Sample Select Database Selection Box 

2. Highlight the database you would like to copy and click Copy. 

 The Copy a Database dialog box will open: 

 

Copy a Database Dialog Box 
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3. In the New Name: field, give the database a new, unique name.  

 The database path in the Directory field will default to the drive where the database 
you are copying is stored.  

4. At the end of the default directory path, enter a directory location for the database. If 
you do not want to add the directory to the default path, enter the complete path in 
the Directory field. 

or Click the Directory… button to select the path from a Windows Select Directory 
dialog box. (You must select an empty directory.) 

5. To copy the contact records for the existing database to the new database, mark Copy 
Contact Data. 

Note: If you copy contact data, any activities, documents, sales forecasts, or e-mail 
messages linked to the contact records will remain linked to the original record in the 
source database, not to the copied records. 

or If you would like to copy an empty database with no contact record, leave the Copy 
Contact Data box empty. 

6. If you have set up security and would like to copy any security access established for 
this database, mark Copy Security Settings . Anyone who is able to access the 
original database will be able to access the new database. It will also copy users’ 
rights within that database, such as the ability to view fields and add records.  

or If you do not want to copy security, leave the Copy Security Settings  box empty. 
Only Supervisor users will be able to access the database until you go into security 
and assign the database to security groups. 

7. Click OK to copy the database. 

8. The Select Database list dialog box will appear again, with the name of your new 
database listed. Close this box by clicking on the No Database button. You will be 
taken to a blank screen. 

9. Before you can use your new database, you must perform a Rebuild. From the blank 
screen, choose the Rebuild option from the File menu.  
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The Rebuild screen will appear: 

 

10. If other users are working in TeleMagic, before the rebuild screen appears, you will 
receive a message that any files in use will be skipped. You should schedule rebuilds 
periodically during times when no users are in TeleMagic so that all records will be 
rebuilt. 

11. Click the Database button. 

 The Database Files dialog box will open. 

12. In the Database Files dialog box, find your new database in the list on the left. Using 
the Add button, add it to the Databases to Rebuild list on the right. Click OK. 

13. The Database Files dialog box will close, returning you to the TeleMagic Rebuild 
dialog box. Click OK to start the rebuild. 

14. TeleMagic will display a Rebuilding… status report during the rebuild. When the 
status report disappears, the rebuild has completed.  

15. To open the new Database, choose Select Database from the File menu. Highlight the 
new database, then click Open. 

Adding a Blank Database 

To Add a Blank Database: 

1. From the File menu, choose Select Database.  

The list of databases available in the program will appear. 
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2. Select Add to open the Add a Database screen. 

 

 

The Add a Database dialog box will open: 

 

Add a Database Screen 

3. Choose Blank Database and click Install. 

The Add a Database dialog box will open: 

 

Sample Add a Database Dialog Box 

4. Enter a descriptive name for the database in the New Name: field.  

 The database path in the Directory field will default to the \DATA sub-directory off 
the TeleMagic root directory. 
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5. At the end of the default directory path, enter a directory location for the database. 

If you do not want to add the directory to the default path, enter the complete path in 
the Directory field. 

or Click Directory… to browse for a directory. (The directory must be empty.) 

6. Click OK. 

The new database will appear in the Select Database list. A message will appear 
informing you that you must rebuild the new database before using it. Click OK. 

7. Click the Usage button. 

The Database Description dialog box will open. Enter a description, instructions, or 
any other notes to help with managing this database in the memo field. This 
information will also be available from the Contact Utilities  menu, and in the Database 
section of the System Information screen. 

8. Click OK. 

9. The Select Database list dialog box will appear again, with the name of your new 
database listed. Close this box by clicking on the No Database button. You will be 
taken to a blank screen. 

10. From the File menu, select Rebuild. The Rebuild screen will appear: 

 

Sample Rebuild Dialog Box 
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If other users are working in TeleMagic, you will receive a message that any data files 
in use will be skipped. You should have rebuilds scheduled periodically to occur 
when no users are in TeleMagic so that all files can be rebuilt. 

11. Click the Database button. 

12. In the Database Files dialog box, find your new database in the list on the left. Using 
the Add button, add it to the Databases to Rebuild list on the right. Click OK. 

13. The Rebuild dialog box will reappear. Click OK to start the rebuild. 

14. TeleMagic will display a Rebuilding… status report during the rebuild. When the 
status report disappears, the rebuild has completed.  

15. To open the new Database, choose Select Database from the File menu. Highlight the 
new database, then click Open. 

Using the TeleMagic Template Maker 
The purpose of the Template Maker is to allow you to create “snapshots” or “templates” of 
your own TeleMagic databases, which can then be installed into another copy of TeleMagic. 
If you have multiple installations of TeleMagic, this will eliminate duplicated effort. Template 
Maker is a function of the DBUTIL feature. 

 Hint: If you are using Data Synchronization Server with your installations of 
TeleMagic, using the Template Maker may not be necessary. If the database 
exists in your central site, the entire template can be copied to remote 
installations of TeleMagic through synchronization. If the database exists in a 
remote site, use the Template Maker to transfer the database to your central site, 
then synchronize it to any other installations of TeleMagic. 

What is Included in a Template? 
Any settings that are user-specific or installation-specific (for example, security settings) will 
not be included in the template. Any settings that are database-specific will be included in 
the template: 

Customized Views Field Structure 

Contact Records Notebook 

Indexes Filters 

Import/Export Format Files Custom Reports 

Quick Lists Reports Menu Configuration 

If the following are set to database-specific in Directory preferences, they will also be 
included in the Template: 
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Toolbar Configuration Function Keys List Boxes 

Note:  In Directories preferences, you have the option of creating database-specific toolbars, 
list boxes, and function keys. If these options are set to be database-specific for any users, 
the associated files will be created in the database’s directory.  
 
 
 
 
 
 

Note:  Activities linked to contacts in the database will not be included in the template. If 
you want to include linked activities, you can do so through Data Synchronization Server (if 
the installation in which the database currently exists is the central site, and the template is 
being sent to an installation that is a remote site). Alternatively, when you create the 
template, do not elect to include contact records. You can then export the contact records 
with the linked activities to a file, which can be imported into any new databases created 
from the template. 

Converting a Database into a New Template 
Once you have designed and created the database from which you want to build a template, 
you can start the Template Maker.  

To Create a Template: 

Note:  You must exit TeleMagic before using the Template Maker. Any other users in 
TeleMagic must be out of the database from which you are creating the template. 

1. In the TeleMagic Program Group, double-click the Database Utility icon and skip to 
step 4. 

 

or Select Start, Run from the taskbar. 

 The Windows Run dialog box will open. 

2. In the Open: field, enter the path to the TeleMagic program directory 
(C:\TM\PROGRAMS\ by default), followed by DBUTIL.EXE. 

3. Click OK. 

4. Read the warning message and click I Agree when satisfied. 

 The TeleMagic Database Utility logon screen will open. 

5. Enter your user ID and password in the fields provided. 

 The logon dialog will close and the Database Utilities will become available. 

6. From the Contact menu, select Template Maker. 

 The Template Maker dialog box will open: 
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Sample Template Maker Dialog Box 

 The Where is TeleMagic? field will default to your TeleMagic root directory. 

7. If necessary, edit the path to the TeleMagic installation.  

or Use the Find… button to locate the program from a Windows Select Directory dialog 
box. 

Note:  You must select an installation of TeleMagic that has been opened at least 
once.  

8. In the Where should the template be created? field, type the path of the desired 
target location. You can enter an existing directory, or type a new directory name and 
TeleMagic will create it. 

Note:  The Template Maker can create a directory if it does not exist, but it will not 
create more than one level deep. This means that if you enter 
C:\NEWDIR\TEMPLATE, for example, the Template Maker will only be able to create 
\TEMPLATE if \NEWDIR already exists.  

or If necessary, use the Find… button to locate the target directory from a Windows 
Select Directory dialog box.  
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WARNING!  If you enter an existing directory, it is highly recommended that you 
select one that does not already contain a file named DBTYPES.DBF (template file). If 
you do so, instead of creating a new DBTYPES.DBF, the database will be added to the 
existing file. This may result in a DBTYPES.DBF that is too large to fit on a disk when 
being moved to another installation. 

9. In the list of Available Databases, highlight the database on which you want to base 
the template. 

10. In the Name for the template: field, give the template a unique name. (Make sure 
that the name you choose is unique in the target installation; if not, any existing 
template in the target directory or installation of TeleMagic with the same name will be 
overwritten by the new one.) 

11. If you would like all of the records in the database included with the template, mark 
Include Contact Records.  

12. Click Create. 

13. If the target directory does not exist, you will receive a message telling you this and 
asking whether you want to create it. Click Yes . 

 You will be prompted to confirm your decision to create the template.  

14. Click Yes . 

 The template maker will create the template and place it in the directory specified in 
step 5. When finished, you will see the message: 

 

15. Click OK. 

 The Template Maker dialog box will reappear.  

16. To close the Template Maker, click Exit.  

 You will be returned to the Database Utility main screen. 
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How to Install a Template 
The Template Maker creates DBTYPES.CDX, DBTYPES.DBF, and DBTYPES.FPT files when 
it builds a template. These files are all that is required to install the template at another 
location. The files can be transported using any means of electronic data transfer you 
choose. (If you use a compression program, make sure you copy the file to the PC or network 
containing the target installation of TeleMagic and decompress the file before attempting to 
install the template.) 

Adding Databases from Templates 
Installing a database from a template is a two-step process: 

1. Install the template in TeleMagic. 

Note:  This process only installs the template, not the actual database. Templates 
cannot be installed directly as databases; you must first install them as templates (or the 
framework for a database.)  

2. Once the template exists in TeleMagic, create a database from that template.  

To Add a Template to TeleMagic: 

1. From the File menu, choose Select Database. 

 The Select Database dialog box will open: 

 

Sample Select Database Selection Box 

2. Click Add. 

 The Add a Database selection box will open. 
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3. Highlight Add New Template and click Install. 

 The Install a Template dialog box will open: 

 

Install a Template Dialog Box 

4. Type the path to the directory containing the TeleMagic template. (Do not enter the 
file names.) Example: C:\TM\TEMPLATE 

5. Click OK. 

WARNING!  If there is an existing template in your installation with the same name as 
the template being installed, it will be overwritten. 

 There will be a pause while TeleMagic converts the DBTYPES files into templates. A 
status bar will open with the message “inserting additional templates into the list”. 
There will be a message when the process is complete. 

6. Click OK. 

 The new template will now be available from the Add a Database list. 

 You must now install a database based on the template. 

To Install a Database based on an Existing Template: 

Note:  If you have just installed the template, skip to step 3. 

1. From the File menu, choose Select Database. 

The Select Database dialog box will open. 

2. Select Add. 

The Add a Database screen will open, showing all currently installed templates. 

3. Choose a database template from the list and click Install.  

You will be asked for a new name and directory: 
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Sample Add a Database Dialog Box 

4. Enter a description for the database that will appear in the Select Database dialog box 
in the New Name: field.  

 The Directory field will already be partially filled in with the TeleMagic root drive and 
directory and the \DATA sub-directory.  

5. At the end of the default path, enter the directory location for the database. You must 
either enter an existing empty directory, or enter a new directory name and TeleMagic 
will create it. If you do not want to add the directory to the default path, enter the 
complete path in the Directory field. 

or Click the Directory… button to select the path from a Windows Select Directory 
dialog box. (You must select an empty directory.) 

6. Click OK. 

 TeleMagic will create the new database.  

When finished, you will be notified that you must rebuild the database before it can 
be opened. 

7. Click OK to close the rebuild notification. 

 You will be returned to the Select Database selection box. 
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8. Click the Usage button. 

The Database Description dialog box will open. Enter a description, instructions, or 
any other notes to help with managing this database in the memo field. This 
information will also be available from the Contact Utilities  menu, and in the Database 
section of the System Information screen. 

9. Click OK. 

10. Select No Database and perform a rebuild on the new database. 

Note: If this is a template from an installation of TeleMagic prior to V5, some changes 
to the screen may be required to compensate for structural differences between 
versions. 

Customizing a Database 
Once a database has been installed in TeleMagic, you should establish its preferences and 
grant users security access to it. 

If you have installed or copied a database based on an existing template, you can use the 
database immediately. If you have installed a blank database, or want to customize an 
existing database, you must first add or edit your fields, then place those fields on the 
contact page.
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Adding Fields to a Contact Database 
Adding a field to a database is a three-step process. First, you must create, define, and 
customize the field; then, you must rebuild the database; finally, you must use the Screen 
Designer to place the fields on the contact screen. This chapter discusses adding and 
customizing fields and walks you through the minimum database rebuild. 

Your database can store  a maximum of 252 fields on each level, excluding the TMSTART, 
TMLASTREV, and CONTACTID fields, no matter how few (or how many) are actually 
displayed on-screen. In cases where you have reached your 252 field limit, you will need to 
print out a Database Structure report , decide which fields you can afford to delete, delete 
them, and run a rebuild. 

Pre-defined Fields 
Every database comes with two fields already added to each level: a Start field (TMSTART) 
and a Last Revision field (TMLASTREV). These fields cannot be edited; they will not appear 
in the lists of fields in the Edit the Fields dialog box. 

 The Start: field is used to register when a record was first added to the database, 
and by whom;  

 The Last Revision: field tracks when a record was last changed, and by whom. 

These fields can be displayed on any page of any view, or you can choose not to display 
them at all. (If you decide not to have them appear on any page, they will still appear in 
browse and can still be used in reports .) Neither field can be edited or deleted.  

Note:  In addition to these two fields, there is a Contact ID field automatically included on 
each level. This field contains the unique number that TeleMagic uses to identify each 
record. This field cannot be directly displayed on the screen or in browse. 

Last Revision 
The Last Revision field shows the date and the time a record was last changed, and the User 
ID of the person who changed it . There is a separate Last Revision field for each level of a 
database. 

The prompt for the Last Revision field on Level 1 of any database is Last Revision (1); on 
Level 2 it is Last Revision (2); and on Level 3, Last Revision (3). (These prompts cannot be 
altered, but when designing screens you can choose to display the field without a prompt, 
and insert a text object in its place to serve as a prompt.) 



52 Database Management 

System Administrator Guide 

Start Field 
The Start field contains the date and the time a record was added, followed by the User ID of 
the person who added it . There is a separate Start field for each level of a database. 

The prompt for the Start field on Level 1 of any database is Start Date (1); on Level 2 it is 
Start Date (2); and on Level 3, Start Date (3). (These promp ts cannot be altered, but when 
designing screens you can choose to display the field without a prompt, and add an 
appropriate text object in its place.) 

Special Fields 
There are a number of fields that can be added to your database to perform special functions. 
These fields are recognized by their field names or prompts. 

Recall Field (RCL) 
Recalls are scheduled calls to contacts, generally for the purpose of following up on 
previous communication. You have the choice of setting activity-based recalls or contact- 
based recalls . Activity-based recalls are set in the Activity Manager by creating an activity 
with a type of Call. Contact-based recalls are created using a special field named RCL.  

The Recall field is designed to contain the date and time of the next scheduled recall. Unlike 
other fields, it holds both a date and time: 

 

Contact-based recalls are useful if the contact needs to receive a call, but it does not matter 
who places the call. Rather than creating an activity based recall that must be assigned to 
someone, you can create a Recall field to record the information that a call is necessary on 
the given date and time. 

Last Call Field (LCL) 
TeleMagic provides you with the ability to add Activity fields to your screen to track the last 
time an activity of any given type was completed for a contact. This is useful in tracking the 
last time a call was placed to a contact, assuming that the user placing the call uses the 
Create Activity Dialer preference. If some users are not tracking their phone calls through 
the Activity Manager, any Activity field in your database designed to contain the last 
completed Call type activity may not actually reflect the true last call. Adding a LCL field to 
your database will ensure accurate call tracking. 

The Last Call field contains information pertaining to the last call placed (or received) using 
the TeleMagic Dialer. When a call is terminated, the Last Call field will be updated with the 
date, time, User ID, and a plus sign (+) for incoming calls or minus sign (-) for outgoing calls. 
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Adding Fields 
You add TeleMagic data fields either from the File menu or through the Screen Designer. 
(The Screen Designer is a powerful feature which makes it possible for you to lay out your 
contact screens and add fields to your database at the same time.) 

Note:  Throughout this guide, we use the Documentation database to explore TeleMagic. 
The examples below are based on this database.  

To Add a New Data Field from the File Menu: 

1.  From the File menu, select Add/Edit Fields . 

The Edit the Field List dialog box will appear: 

 

Edit the Field List Dialog Box for Documentation Database  

2. From the Level radio buttons, choose a database level.  

 The field list will display all existing fields for that database level. The editing screen 
on the right of this dialog box will display the field information for the currently 
highlighted field. 

3. Click Add. 

 The right side of the dialog box will become active. 

4. In the Prompt: field, type a field prompt, exactly as you want it to appear on the field 
list.  
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 The field prompt is a plain-language description of the field contents. TeleMagic can 
display the field prompt as a field label on contact screens and in browse. The prompt 
can be up to 20 characters long. 

5. In the Field name: field, type a field name. The name can contain no more than ten 
alphanumeric characters. It cannot contain special characters or spaces and the first 
character cannot be a number or symbol. 

6. Select a field type from the Type: drop-down list. The following field types are 
available: 

?  Character fields can contain any type of data you like. This will probably be your 
most common field type.  

?  Date fields can only contain dates .  

? Number fields can only contain real numbers. You will not be able to type letters 
into a number field. 

Note:  You will not necessarily want to define each field which will contain 
numbers as a numeric field. For example, ZIP codes and postal codes are better 
left as character fields because this type of field is more flexible. On the other 
hand, if you will be performing mathematical calculations on a field, or using the 
field in filters or indexes which require that TeleMagic recognize the value of the 
number, you should use a numeric field. (Character fields do not recognize the 
value of the number itself, but rather the value of each digit from left to right. For 
example, if you used a character field in an index, the number 100 would be seen 
as smaller than 50 because 1 is smaller than 5.) 

?  Memo fields allow you to enter any amount of information in a scrolling window. 
You can enter letters, numbers, special characters, and spaces into a memo field. 

??Check boxes display on the screen as a box that may be marked or left unmarked. 
In reporting, these are logical fields that return a "Yes" if the box is marked, or "No" 
if it is not marked. 

? Phone fields contain telephone numbers. Phone fields will be referenced when 
using the Dialer feature. The contents will appear in the Dialer dialog box and the 
field will be preceded in the Contact Manager by a phone icon: . 

? Fax fields contain fax numbers. They will be preceded in the Contact Manager by a 
fax icon: . Click the fax icon to open the Fax dialog box with the fax information 
already filled in. If you include a pipe symbol ( | ) in a contact’s fax field, faxing to 
that contact will be disabled. 

? Pager fields contain pager numbers. The pager icon  precedes pager fields. Click 
the pager icon to open the Wireless Messaging dialog box with the pager 
information already filled in. 
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? Unique Number fields contain an automatically generated unique number. For 
example, you may have a page which creates an invoice. A unique number field can 
be used to generate the invoice numbers.  

? OLE - General fields hold pictures, sounds, charts, graphs, animations, and other 
objects created in other programs .  

? E-mail Address fields contain e-mail addresses and are preceded by the e-mail 
icon.  Click on the e-mail icon to open your default Windows e-mail application. 
See your operating system’s documentation for instructions on changing your 
default e-mail. If you use TeleMagic Internet Mail, setting this  as the default  will 
allow you to link e-mail messages to the contacts in your database. If you put a pipe 
symbol ( | ) in a contact’s e-mail field, e-mail to that contact will be disabled. (You 
would still be able to send e-mail to the contact directly from your e-mail 
application.) 

? Web Address fields contain addresses of web sites and are preceded by the web 
address icon.  Click on the web address icon to open your web browser and go 
to the indicated web site. 

? FTP Address fields contain FTP addresses and are preceded by the FTP icon.  
Click on the FTP icon to open your FTP client program and go to the indicated FTP 
site. 

? Newsgroup fields contain newsgroup information and are preceded by the 
newsgroup icon.  Click on the newsgroup icon to open your browser or e-mail 
program and retrieve newsgroup information. 

 Once you have selected a field type, TeleMagic will display a default field length for 
that type. 

Note:  If you have selected OLE, Checkbox, Memo, or Date as the field type, a pre-
set field length that cannot be changed will appear in the Length: field. If this is the 
case, skip the next step. 

7. If you do not want to use the default length, type the desired length in the Length: 
field, or use the spinner arrows to enter a field length.  

 

 

 

Note:  The field must be long enough to accommodate the maximum total number of 
characters you are likely to type into that field. TeleMagic will not save excess 
characters. If you try to enter more characters than the field can accommodate one of 
two things will happen, depending on your preferences. If you have Force “Tab” 
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Every Field marked in Display preferences, it will continue to replace the last 
character in the field until you stop typing. (For example, if you have a field with only 
three characters, when you type the fourth character, and every character after this, it 
replaces the third character, so typing “DEAR” will read “DER”.) If you do not have 
Force “Tab” Every Field marked, excess characters will be placed into the next field. 

 Hint: If you are setting up a fax field, consider adding another character to its 
length to accommodate the pipe ( | ) character. (This is used in faxing to 
instruct TeleMagic to not send faxes to the number in fields containing 
the pipe character. This allows you to maintain a record of the fax number, 
and still prevent faxes from being inadvertently sent to it . This is 
particularly useful if you have received a request from a contact that no 
faxes be sent for a limited time, such as while the contact is on vacation.) 
You can also make the fax field view-only so that non-supervisor users 
are not able to edit the pipe character out of the field. 

8. If this is a numeric field, specify if you want the number to contain decimal places. Use 
the spinner arrows to indicate how many characters you want devoted to decimals . (If 
included, a decimal point must be added to the field. The decimal point counts toward 
your field length. Adjust the field length accordingly.) 

Note:  In numeric fields, the number of decimal places must be at least two characters 
less than the total field length. (This will allow you to account for the decimal places 
plus the decimal point.) 

9. If you want the first letter of every word in the field capitalized, mark the Auto 
Capitalization checkbox. If you do this, TeleMagic will capitalize nouns, pronouns, 
adjectives, verbs, adverbs, and subordinating conjunctions. Articles (“a,” “an,” 
“the”) coordinating conjunctions (“and,” “but,” “or” etc.) and prepositions (“to,” 
“for,” “in,” etc.) will not be capitalized. 

 Hint: This option is useful if the field is to contain proper names, titles, or other 
information that is generally capitalized. 

Note:  If you have names that begin with Mc or Mac, such as MacKay, TeleMagic will 
correctly capitalize them. If you have initials, such as IBM, TeleMagic will only know 
to capitalize it if each letter is separated by a period (e.g., I.B.M.). 

or If you do not want to automatically capitalize the contents of the field, leave this 
checkbox blank. 

10. If you want this field to be available when merging in the word processor, mark the 
Include in Merge checkbox. 

or If you do not want this field to be available when merging documents, leave this 
checkbox blank. The contents of the field will not be available in word processing 
documents. 
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 Hint: Word processors have a maximum number of fields which can be 
displayed in the Merge Field list. (This number will vary by word 
processor.) Once that maximum has been reached, any additional fields 
will not be shown. This is especially an issue if you are merging from 
Level 3, as fields from all three levels will be included in the merge. To 
avoid this, and the problem of having to scroll through a long list of 
fields, we recommend that you exclude any fields which will not be used 
in documents from the Merge Field list.  

11. If you want this field included in the Contact Browse window, mark Include in 
Browse. 

or If you do not want this field to appear in the browse list, leave this checkbox blank. 
(The more fields you include in browse, the longer it will take to load.) 

12. If this is a numeric field, and you want to display a currency symbol, mark the 
Currency Field checkbox. This activates the currency symbol.  

Note:  The currency symbol is set in Database preferences. 

  Hint: If the currency symbol you want to use does not appear on your 
keyboard, you can use the Windows Character Map to find the keyboard 
command that will generate the symbol. Open the Character Map by 

selecting the icon from the Accessories group. (If this option is not 

available, you will need to install it.) Use the list of fonts to locate the 
currency symbol you want to use. At the lower right-hand corner of the 
Character Map dialog box you will see a line that says Keystroke: , then 
the keystroke needed to generate that character. (For example, the 
keystroke for the £ character in Times New Roman font is ALT+0163.) In 
the Currency Symbol field in TeleMagic, type the keystrokes needed to 
generate the desired currency symbol. (Following the above example, 
hold down the ALT  key and type 0163. £ will appear in the Currency 
Symbol: field.) You must open Database Preferences and change the 
currency symbol there. On most keyboards, you must use the keys on the 
numeric keypad, not the ones along the top of the keyboard, to enter the 
symbol in this way. Changing the currency symbol in Preferences affects 
all currency fields in the database, even those that have already been 
created. 

13. Click OK. 

The new field prompt and name will appear highlighted on the field list. The field name 
will appear in brackets to the right of the prompt. 
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?  Customizing Fields 
Customizing data fields includes setting up templates , establishing validation rules, and 
writing formulas for calculated fields. 

Note:  Customizing date fields is handled through System Preferences. 

Templated Fields 

 

Template Field 

 If you want the first letter of every word in the field capitalized, mark the Auto 
Capitalization checkbox. If you do this, TeleMagic will capitalize nouns, pronouns, 
adjectives, verbs, adverbs, and subordinating conjunctions. Articles (“a,” “an,” 
“the”) coordinating conjunctions (“and,” “but,” “or” etc.) and prepositions (“to,” 
“for,” “in,” etc.) will not be capitalized. 

 Hint: This option is useful if the field is to contain proper names, titles, or other 
information that is generally capitalized. 

Note:  If you have names that begin with Mc or Mac, such as MacKay, TeleMagic will 
correctly capitalize them. If you have initials, such as IBM, TeleMagic will only know 
to capitalize it if each letter is separated by a period (e.g., I.B.M.). 

or If you do not want to automatically capitalize the contents of the field, leave this 
checkbox blank. 

Creating a custom template for a field means specifying in what format data may appear in 
the field. There are two types of templating characters (also known as input mask 
characters): literals and formatting characters. Literals are used to force a character into a 
field. For example, you may want to place a hyphen into a phone field so users do not have 
to type the hyphen in every phone number. Formatting characters act as place-holders for 
data you can type into a field. They allow you to specify what type of character can be 
placed into the field at a particular spot. For example, you may have a field which contains 
customer account codes that always start with a letter followed by four digits. You would 
use formatting characters to specify that the first character must be a letter and the next four 
must be numbers. Users would not be able to enter any other type of characters in those 
spaces . 
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 Hint: Templates can prevent data entry errors and save keystrokes. By setting up 
templates for highly-structured fields, you can prevent data entry mistakes such 
as typing special characters or the letters “O” and “l” instead of the numbers 0 
and 1.  

You can create custom templates for every field type except Checkbox, Date, Memo, and OLE 
fields. Templates are created by clicking the Template button in the Edit the Field List dialog 
box. A dialog box will appear with templating options specific to the current field Type:. 

The Character, Phone, and Number Template dialog boxes contain a list of the formatting 
characters (placeholders) available with each field type. Any characters entered into the 
template that are not contained on the list will be treated as literals and will appear in the field 
exactly as typed into the Template: field. 

The Unique Number Template dialog box allows you to define the parts of your unique 
number. 

Note:  If you do not create a custom template, TeleMagic will apply the default template for 
the field type (with the exception of Unique Number fields, which must have a custom 
template).  

Creating Templates for Character Fields 

Character fields are the least restrictive, and therefore the most often used. Character fields 
can contain any type of data you like. You can allow the field to remain without any limits on 
the characters it may contain, or you can use a template to make the field contain specific 
types of characters at specific points . Character fields usually contain data which includes 
letters, but in some cases there can be numbers only. (For example, ZIP and other postal 
codes are usually character fields.) News Group, FTP, Web, and E-mail fields all use the 
character template box. 

Use the Character Template dialog box to customize character fields: 
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Character Template Dialog Box 

The Character Template dialog box contains an Input Mask: field where you can enter your 
template characters (formatting characters and literals), descriptions of six formatting 
characters (input mask symbols), and seven customization checkboxes. 

The formatting characters are used as follows: 

?? A  Indicates that only letters are allowed in this position. 

?? X  Indicates that any character is allowed in this position. 

?? 9  Indicates that only numbers are allowed in this position. 

?? #  Stands as a placeholder for numbers, signs (+ and -), periods, and spaces. 

?? N  Allows either letters or numbers in this position, but nothing else. 

?? !  Allows any character, but displays any letters entered in this position in 
uppercase. 

The checkboxes work as follows: 

?? Letters Only indicates that only letters are allowed in the entire field. 

Note:  If you create an input mask that includes numbers, signs, and spaces, you 
will not be able to enter data at the location of those formatting characters. If you 
select this option with a template that only includes numbers, signs, and spaces, 
you will not be able to type in the field. 

?? Uppercase forces all letters in the field into uppercase. 

?? Center centers all data in the field. 

?? Select the field on entry will cause the entire field to be highlighted when you 
click in it. 
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?? Right Align will override the default left alignment of the field, and cause all data to 
be right aligned. 

Note:  If you center or right align the field, it will format it according to the actual 
size of the field, not the size of your display. If the field’s display on the screen is 
larger or smaller than the actual field size, it will affect the appearance of centering 
and right aligning. 

?? Trim beginning and ending spaces will clear the field of any unwanted spaces at 
the beginning or end of the field. 

?? Don’t save literal characters with the data will cause literal characters (characters 
that are the same for all records, such as dashes, parentheses, and percent marks) to 
not be part of the physical data stored in your database. This option can save disk 
space by not taking up storage space for characters that will not change. The 
tradeoff, however, is that the actual data would not include the literals ; thus, it 
would not display in browse, merge, and reports as it does on the screen. 

Note:  Marking this  option instructs TeleMagic that the necessary literal characters 
are not part of the data, so it should add them to the display. If you enter data either 
from list boxes or on group replace with this option selected, make sure that you do 
not include the literal characters in the entry. If you do, it would be added once as 
data, and once by TeleMagic as part of the template. (The data would, however, 
display correctly in browse and merge fields.) 

Creating Templates for Number Fields 

Note:  If you want only to include a decimal or currency symbol in the field, it is not 
necessary to create a template. 

 

Number Template Dialog Box 

The Number Template dialog box contains an Input Mask: field where you can enter your 
template characters (formatting characters and literals), descriptions of four formatting 
characters (input mask symbols), and five formatting checkboxes. 
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The formatting characters are used as follows: 

  “.”  (period)  Indicates the position of the decimal point; 

 “,”  (comma)  Shows where larger numbers should be separated by a comma; 

Note:  If your Display Preferences are configured to use a different decimal point 
symbol and separator character, these will be used in place of the period and 
comma. 

           9  Stands as a placeholder for numbers and/or signs (+ and -); 

#  Stands as a placeholder for numbers, signs (+ and -), and spaces; 

Note:  You cannot use non-numeric place holders (such as an “X”) in number field 
templates. Any characters that work as a place holder in other field types will be interpreted 
as literals in number fields if they do not appear on this list. 

The formatting checkboxes work as follows: 

? Left Justify will override the default right justification of the field; 

? Blank if Zero will leave the field blank if no number has been entered into it, or if 
the number entered is zero; 

? Use Leading Zeros will cause any unfilled digits in the field to appear as zeros 
preceding the number. For example, if the field has a length of five characters, and 
the number currently in it is 26, it will display as follows: 

00026 

?? Select the field on entry will cause the entire field to be selected when you click in 
it, allowing you to overwrite the contents of the field with a single keystroke; 

?? Scientific Notation can be used to handle extremely large numbers. For example, it 
will change 10 million to .10000E+8. 

Creating Templates for Phone, Fax, and Pager Number Fields 

Note:  Phone field templating also applies to pager and fax number fields. 

Depending on what country you are in and what countries you regularly call, your database 
may require a variety of phone fields templated to contain numbers of varying lengths. For 
example, if you are in the United States, US and Canadian phone numbers will be of a 
standard length, with a fixed number of characters for area code, exchange, and number. 
International phone numbers, on the other hand, will require country codes, and have a 
variety of city codes, and numbers of variable lengths. 

If you regularly place international calls, you can use phone field templating to accommodate 
the different phone numbers you may encounter. 
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Phone Number Template Dialog Box 

The Phone Number Template dialog box contains an Input Mask: field where you can enter 
your temp late characters (formatting characters and literals), two default buttons that allow 
you to quickly select pre-defined standard templates for US and International phone 
numbers, descriptions of six formatting characters (input mask symbols), and seven 
customization checkboxes.  

The input mask symbols are used as follows: 

? A  Indicates that only letters are allowed in this position; 

? X  Indicates that any character is allowed in this position; 

? 9  Indicates that only numbers are allowed in this position; 

? #  Stands as a placeholder for numbers, signs (+ and -), periods, and spaces; 

? N  Allows either letters or numbers in this position, but nothing else; 

? !  Allows any character, but displays any letters entered in this position in 
uppercase. 
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The default buttons work as follows: 

? Select Default US Phone to automatically enter 999-999-9999 in the Input Mask: 
field. This will automatically place the dashes in the field, and the rest of the field 
must contain numbers.  

? Select Default Intl Phone to automatically enter 011-###-####-####### in the 
Input Mask: field. This will automatically place 011 in the field (the international 
access code) and three dashes . The rest of the field must contain numbers, spaces, 
and signs (+ and -). 

Note:  If your selected field length is not long enough to contain the default 
international template, TeleMagic will automatically set the length to 20. 

The formatting checkboxes work as follows: 

?? Letters Only indicates that only letters are allowed in the entire field. 

?  Uppercase forces all letters in the field into uppercase. 

? Center centers all data in the field. 

? Select the field on entry will cause the entire field to be highlighted when you 
click in it. 

? Right Align will override the default left alignment of the phone field, and cause all 
data to be right aligned. 

Note:  If you center or right align the field, it  will format it according to the actual 
size of the field, not the size of your display. If the field’s display on the screen is 
larger or smaller than the actual field size, it will affect the appearance of centering 
and right aligning. 

? Trim beginning and ending spaces will clear the field of any unwanted spaces at 
the beginning or end of the field. 

? Don’t save literal characters with the data will cause literal characters (such as 
the dashes and parentheses in phone fields) to not be part of the physical data 
stored in your database. For example, with this checkbox marked, although a phone 
field would display as: 619-555-1465, TeleMagic would only actually store 
6195551465. This option can save disk space by not taking up storage space for 
characters that will not change. The tradeoff, however, is that the actual data would 
not include the literals ; thus, it would not display as formatted in browse, merge, 
and reports. 
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WARNING!  Do not use this with the default international number, or any other 
phone field that has been templated to contain literal numbers that must be dialed. 
(The default international number includes 011 as literals in the template. Since this 
number must be dialed when placing the call, it needs to be stored with the rest of 
the data.) 

 

Note:  Marking this  option instructs TeleMagic that the literal characters are not 
part of the data, so it should add them to the display. If you enter data from either 
list boxes or on group replace with this option selected, make sure that you do not 
include the literal characters in the entry. For example, if you enter (619) 555-1465 in 
a phone field with this option marked, TeleMagic will know to put in the first 
parenthesis as the literal, then it will begin to enter your data, in this case, another 
parenthesis . The final entry would be ((61) 9)5-55-1. (This would, however, display 
correctly in browse and merge fields.) 

Creating Templates for Unique Number Fields 

TeleMagic can create unique, non-editable, sequential numbers that are automatically 
generated when each new record is added. These fields are useful in generating numbers 
such as customer ID’s, contract numbers, and fulfillment numbers. Unique Number fields are 
limited to fixed text strings and variable number characters.  

 Hint: Unique number fields generate sequential numbers. These numbers cannot be 
edited. If you need to establish a field to contain unique numbers that are not 
necessarily sequential and need to be hand-entered, you can use a character 
field instead of a unique number field. (Examples of unique but non-sequential 
numbers are: Social Security numbers, Dun & Bradstreet reference numbers, and 
Unit Product Codes.) When a character field is used, the number will not be 
automatically generated, but the field can be templated to contain a combination 
of variable alphanumeric characters.   

If you have selected Unique Number as the field Type:, clicking on the Template button in 
the Edit the Field List dialog box will open the Unique Number Template dialog box: 
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Unique Number Template Dialog Box 

Use the checkboxes in this dialog box to build the unique number, one section at a time. As 
you build the number, it will appear in the Example:  text box. You can include literals, make 
various date-related information appear as part of the unique number, or you could simply 
have an auto-incrementing unique number appear in this field. When you mark a checkbox, 
the associated item will be added to the end of the unique number template. The order in 
which you mark the checkboxes controls the order that the items will be shown in the unique 
number. If you leave a checkbox blank, the associated item will be removed from the 
template. 

Note:  You can only add each item once to the template. 

? Unique Number Counter places the counter portion of the unique number into the 
template. The counter will default to 5 characters. (It can be no longer than the total 
length of the field.) This option must be marked to generate unique numbers. 

? No. of digits: controls the number of characters that will be reserved for the 
counter part of the unique number (the portion that increments for each new 
record). 

? System ID allows you to include the installation of TeleMagic’s System ID as part 
of the unique number. If you are using Data Synchronization Server, including the 
System ID is required in order to synchronize the unique number field. 

? Literal makes an unchanging character or string of characters part of the unique 
number. 

? Century adds the current century to the unique number. 

Note:  In this context, and in the context of all date-related information in the unique 
number, “current” refers to the time when the unique number is actually generated 
(i.e., when the record containing the number is created) and not to the time when 
the template itself was created. 
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? Year makes the current year part of the unique number. 

? Month Number makes the number of the current month part of the unique number. 
(For example, the month number for January would be 01, February would be 02, 
etc.) 

? Month Name makes a three-character abbreviation of the current month’s name 
part of the unique number. 

? Day of Month makes the current date part of the unique number. 

? Day of Week makes the current day part of the unique number. 

Note:  Each item you select will count toward the length you have allotted for the field. If 
your temp late exceeds the field length, you will receive a warning. If you receive this 
warning, either remove items from the template, or increase the field length. 

 Hint: Once you have created a unique number template, if you want any existing 
records in your database to receive the unique number, use the Reset Unique 
Numbers feature to assign a unique number to the existing records. 

To Create a Simple Unique Number Template: 

Note:  In this example, we are adding a field which will display a simple, unique number for 
each record added to a database. 

1. From the File menu, select Add/Edit Fields . 

The Edit the Field List dialog box will open. 

2. Choose a database level from the level radio buttons. 

3. If this is a new field, click Add. 

or If you are changing an existing field, highlight the field and click Change. 

4. Select Unique Number from the Type: drop-down list. 

5. Set the field Length:. A length of 6 will accommodate up to 999,999 unique numbers 
(by default, unique numbers start at 1). 

6. Click Template. 

The Unique Number Template dialog box will appear. 

7. Mark Unique Number Counter. 

8. In the No. of digits: field, type (or use the spinner arrows to enter) 6 and press TAB. 

The number of places will appear as a series of x’s in the Example:  text box: 
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9. If you want to specify a starting number for the counter, enter it in the Starting 
number: field. 

10. Click OK to exit the Unique Number Template dialog box. 

The Template: text box will display the template you have just created: 

 

Unique Number (Contract Number) Template 

Note:  In unique number templates “N” followed by a whole number will create a 
unique number of that length. For example, “N9” will create a number which is nine 
digits long. 

11. Click Save Field to end the changes to the field. 

12. Click OK to exit the Edit the Field List dialog box. 

To Create an Advanced Unique Number Template: 

Note:  In this example, we are going to create a template that will generate a unique number 
for every new contract added to the database. The unique number will use current date 
information, and will be preceded by the letters CON to indicate that it is referring to a 
contract. 

1. If you have not done so already, from the File menu, select Add/Edit Fields  to open 
the Edit the Field List dialog box. 

2. Choose a database level from the level radio buttons. 

3. If this is a new field, click Add and add the field. 

or If you are changing an existing field, highlight the field and click Change. 

 The editing screen will become active. 

4. Make sure that Unique Number is selected in Type:. 

5. Set the field Length: to 13. This will be long enough to accommodate the various 
parts of the unique number built into this example. 

6. Click Template. 

 The Unique Number Template dialog box will appear. 

7. Mark the Literal checkbox to insert the literal information as the first part of the 
unique number. 
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This allows you to add unchanging characters to your unique number. In this example 
we are creating a unique number that will be generated for every contract in the 
database. To indicate this, we will use a literal at the start of the unique number. 

8. In the Literal text box, type con (short for contract). Press TAB. 

The literal will appear in the Example:  text box. 

9. Mark the Year checkbox to add the current year to the number template. 

10. Mark the Month Number checkbox to add the current month to the number template. 

11. Mark the Day of Month checkbox to add the current day’s date to the number 
template. 

 The Example:  will look something like this: 

 

12. Mark the Unique Number Counter checkbox to add the counter section of the 
number. 

13. In the No. of digits: field, type or use the spinner arrows to enter the number 4. (This 
will assign four places to the counter.) Press TAB. 

 The number of places will appear as a series of X’s at the end of the example: 

 

Note:  Make sure you allow a realistic number of digits in the unique number counter 
of your template. Four X’s will allow 9,999 unique numbers; five X’s will allow 99,999; 
and so on. In our example, because the date will change every day, four digits are 
enough. This will provide unique numbers for as many as 9,999 records being added 
to the database every day. However, if your unique number template is quite simple, 
allowing, for example, four unique digits and nothing else (no dates, etc.) you will run 
out of unique numbers the day you add your 10,000th record. When this happens, the 
counter portion of the unique number will roll over back to 1. In this case, you will end 
up with records with duplicate numbers. To solve the problem you must change the 
template to allow at least one more digit and reset unique numbers. 

14. If you want to specify a starting number for the counter, enter it in the Starting 
number: field. 

15. Click OK to exit the Unique Number Template dialog box. 

The Template text box will display the template you have just created. 
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Unique Number (Contract Number) Template 

Note:  In unique number templates, “Y,” “M,” and “D” are place holders for the 
current two-digit numeric year, month, and day, respectively. “N” followed by a whole 
number will print a unique number n characters long. Fixed text strings (literals) are 
surrounded by quotation marks. 

A unique number will be generated based on this template for every new record 
added, incorporating the year, month, and day. For example, using the sample 
template above, if the first record were added on January 1, 2099, TeleMagic would 
begin assigning a sequential list of contract numbers beginning with: con9901010001. 
(Unique numbers are filled in automatically. They cannot be edited.) 

16. Click OK to end the changes to the field. 

17. Click OK to exit the Edit the Field List dialog box. 

?  Advanced Configuration 
Advanced configuration includes field validation, calculated values, and default values. 

Validation means being able to set a criterion that must be reached for data to be 
accepted in the field. With the Validation option, you create an expression that must 
evaluate to True before an entry can be made in the field. 

Calculated fields are fields that are automatically filled in based on an expression. 
An example of a calculated field would be a numeric field designed to contain the 
sum of two other numeric fields. Users will not be able to add to or change the 
contents of a calculated field. 

WARNING! It is possible to perform calculations on values that are not known when the 
expression is written, such as the contents of fields and calculated values. This is especially 
likely, and difficult to detect, where rounding takes place in the generation of data used in 
the expression. Take precautions when performing calculations where it is  possible to 
attempt to divide a value by zero. This will inevitably result in unexpected results. In 
Windows NT series, including Windows 2000, a fatal error will result. In other versions of 
Windows, zero will be returned. Although the latter case may seem preferable to receiving a 
fatal error, note that a problem with the expression or the data may not be immediately 
apparent using these operating systems. Also note that validations are performed after 
calculations in most cases, so making the denominator field a validated field will not 
necessarily detect zero values.  
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Default value fields are similar to calculated fields but are slightly more flexible. In 
the case of a default value field, a calculation is performed when the record is first 
added, but the results of that calculation can be edited if necessary. 

 Hint:  When deciding whether to use a calculated field or a default value field, 
think about whether the value being returned will ever vary. For example, 2+2 will 
always be 4. In this case, there is no reason for the calculated value to ever be 
changed. On the other hand, if you have a field designed to pull the first name out 
of a contact name field (as in the case of a Dear field), you may occasionally need to 
overwrite the results with a nickname. In this case, a default would better serve. 

??Field Validation 

Field validation is a way of ensuring that entries made into a field conform to certain pre-
determined standards. In the Contact Manager, you can set validation through a list box that 
requires that any entry in the field must match one of the list box items . This type of 
validation is fairly flexible—if a user wants to make an entry that is  not currently valid, all he 
or she needs to do is add the item to the list box. Field validation handled through the Edit 
the Field List dialog box allows more rigid control of the field by making the validation criteria 
one of the field properties. 

From Expression validation means that TeleMagic verifies that an entry conforms to the 
requirements of a formula, or expression. For example, you may want to bar certain users 
from making entries in a field; or you may want to require that any entries made in a date field 
be for the current date or later. 

To Create a Field Validation Expression: 

1. Follow steps 1 through 10 of To Create and Define a New Data Field from the File 
Menu: earlier in the chapter. 

2. Select the Validated radio button: 

 

Validated radio button 

 The Expression button will become available. 

3. Click Expression.  

The Expression Builder dialog box will open: 
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Expression Builder 

4. From the Tables drop-down list, select the contact table that contains the fields that 
will be used in the expression. There is a contact table for each level in your database. 
You can select any table, or all tables. You cannot select 2 of the 3 tables in a 3-level 
database. 

5. Enter the validation expression, then click OK. 

Example 1: To create an expression that would bar the user JRC from editing the 
field, create this expression:  cUserID # “jrc”    
cUserID is a variable that looks for the current user; # is a logical 
function meaning “not equal to”; and jrc is the User ID of the user 
being barred from the field. (The User ID must be entered in quotation 
marks.) 

Example 2: To require that the entries in a date field named Due on Level 2 must 
be for today’s date or later, create this expression:  Contact2.Due 
>= date() 
Contact2.Due is the field name (if the desired field has been added 
since the last rebuild, it will not yet be available on the Fields list; run 
a rebuild before creating the calculation); >= is a logical function 
meaning “greater than or equal to”; and date() is a date function 
referencing the current system date. 

 Hint: If you want to validate against information in existing fields or using 
variables, you can select them from the lists. If you want to validate 
against information in the field you are currently creating, you must first 
save the field, rebuild the database, then create the expression. 
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6. Click Save Field to save the field. 

The new field prompt and name will appear highlighted on the field list. The field name 
will appear in braces to the right of the prompt. 

7. Click OK to exit the Edit the Field List dialog box. 

?  Calculated Fields 

Calculated fields draw upon data from other fields to calculate entries such as sales totals or 
future dates. The values are calculated and filled in whenever the data on which they are 
based changes . You cannot type over or otherwise manually change calculated fields. When 
creating a calculated field, you will use an expression to indicate which fields are to be used, 
and what operations are to be performed using data from those fields. 

Note:  Because the expression in a calculated field of itself validates the field, you will not be 
able to use the Validation feature with a calculated field. 

To Create a Calculated Field: 

1. Follow steps 1 through 10 of To Create and Define a New Data Field from the File 
Menu: earlier in the chapter. 

Note:  You cannot select Memo, OLE, or Unique Number fields for use with the 
calculated field feature. 

2. Select the Calculated radio button: 

 

Calculated Radio Button 

 The Expression button will become available. 

3. Click Expression. 

 The Expression Builder dialog box will open. 

4. From the Tables drop-down list, select the contact table that contains the fields that 
will be used in the expression. There is a contact table for each level in your database. 
You can select any table, or all tables. You cannot select 2 of the 3 tables in a 3-level 
database. 

5. Build the calculation expression. 
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 Use the Fields list to choose from a list of field names. Use the Variables, String, 
Logical, Math, and Date drop-down boxes to choose from sets of related operators 
and functions. 

Example 1 Calculated Date (Shipping Date). In the Documentation database, we 
assume that the product shipping date is two weeks after the contract 
date. For the field {shipdate}, we can calculate the shipping date by 
adding 14 days to the date in the {condate} field. From the Fields list, 
choose the field name Contract Date {condate}; then type 14. Your 
expression will look like this: 

Contact3.condate+14 

(If you want to place the date information into a character field, place the 
above expression inside the parentheses in the dtoc() date function to 
convert the date to character.) 

Example 2 Conditional Calculated Date (Warranty Expiration). In the Documentation 
database, if the product has a warranty, the warranty expires 60 days after 
the product delivery date. This requires a conditional expression, also 
known as an iif (immediate if) statement: 

 

In this example, the translation of the above statement would be:  “If the 
Warranty? checkbox on the Sales Contract screen is marked, add 60 days 
to the date in the Delivery Date Field on that screen; otherwise leave this 
field blank.” 

6. When the expression is complete, click OK. 

 TeleMagic will close the Expression Builder and enter the expression on the editing 
screen. 

7. Click Save Field to save the field. 

8. Click OK to exit the Edit the Field List dialog box. 

?  Default Fields 

Default values draw upon data from other fields to calculate default entries. Default values 
are entered automatically whenever you add a record. They can be typed over or changed as 
necessary. 



 Customizing Fields 75 

 System Administrator Guide 

Note: Unlike calculated fields, if you change the data in the field(s) on which the default is 
based, the default will not be reevaluated. In cases where you have changed the default 
value, this will prevent your entry from being overwritten. 
 

Note:  TeleMagic will fill in default fields when importing. If there is no data being imported 
into the field, it will populate the field using the default value expression. 

When creating default fields, you will use expressions to indicate which fields are to be used, 
and what operations are to be performed using data from those fields. 

To Create a Default Value: 

1. Follow steps 1 through 10 of To Create and Define a New Data Field from the File 
Menu: earlier in the chapter. 

Note:  You cannot select Memo, OLE, or Unique Number fields for use with the 
default value field feature. 

2. Click Default Value. 

 

 The Expression Builder dialog box will open. 

3. From the Tables drop-down list, select the contact table that contains the fields that 
will be used in the expression. There is a contact table for each level in your database. 
You can select any table, or all tables. You cannot select 2 of the 3 tables in a 3-level 
database. 

4. Create an expression to define what should be entered in the field by default. You can 
enter literal text in quotation marks, or create an expression that will pull data from 
other fields. 

Example Fill-in (Dear). Assuming that names are entered first name, space, last 
name, if you enter this expression into the Dear: {dear} field of the first 
(Contact Data) level of the Documentation database, it will find the first 
name in the Contact Name field and place it in the Dear: field: 

left(contact2.contact,at(“ ”,contact2.contact)-1) 

 In this example, the translation of the above statement would be:  
“Starting from the left of the Contact field, return everything up to the last 
character before the first space.” 

5. Click OK to save the expression. 

 You will be returned to the Edit the Field List dialog box. 
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6. Click Save Field to save the field. 



  Database Installation and Configuration 77 

System Administrator Guide 

Database Rebuild 
As soon as you have finished creating, defining, or customizing data fields, you must 
rebuild your database. If you do not, the new field names will not be available to you in 
various program lists, and TeleMagic will not be able to record or save information into 
those fields. This section gives instructions for performing a simple rebuild that will affect 
the current database only. 

To Rebuild the Database: 

Note:  All other users must be out of the database before performing a rebuild. 

1. From the File menu, select Rebuild. 

The TeleMagic Rebuild dialog box will appear: 

 

The TeleMagic Rebuild Dialog Box 
2. Click the Database button to select the databases which have been changed and that 

you want to rebuild. 

 A Database Files dialog box will appear: 
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Database Files Dialog Box 

3. Select the database(s) you want to rebuild and click Add. 

Note:  Only select a database if you are certain that no other users are currently 
working in that database. 

4. Click OK. 

 You will return to the Rebuild dialog box. 

5. Make sure that the System, Global, User Tables, Floating, DSS Tables, and 
Automation Server Tables checkboxes are not marked. 

Note:  If you want to rebuild any of these other areas of TeleMagic, we strongly 
recommend that you refer to the Rebuild section of the Maintenance chapter of this 
guide before proceeding. 

6. Click OK. 

 The database will be rebuilt. A status bar will keep you informed of its progress. 

Screen Design 
If you have added fields to your database, in order to begin using them you must now add 
them to your contact views. See the following chapter: Screen Designer for instructions. 



 

 

 

SCREEN DESIGNER 
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Creating Views for a Contact Database 
What is a Contact View? 

Each database level that is in use has a view. (If there is no view for a level, that level will not 
be accessible in the database.) The view is all of the pages, or screens, you can access on 
the level. For any database level, you can attach multiple views. In other words, if you 
change views, you will be able to see a different set of pages on the same level. 

We all fill out many kinds of paper forms ? to renew a driver’s license, to apply for insurance, 
to open a checking account—as part of the daily routine of organizing modern life. So we 
know that a form is one or more pages formatted with blanks for specific information. To “fill 
out a form” means to fill in the blanks that someone has laid out, pre-formatted on a page. A 
TeleMagic contact view is like a set of paper forms laid out on the computer screen with 
blanks for each record’s data. 

Just as each department of a large company may use several different forms, each level of a 
contact database may need several different contact views. And just as each departmental 
form can consist of one or more pages, you may need more than one page for each contact 
view. 

Why you would want to create or customize a View 
TeleMagic comes with a selection of sample databases with the views already provided. 
Many of these have already been customized for specific businesses. It is possible that you 
will never need to create a new view or change your existing views. On the other hand, you 
may have specific requirements in your business that are not met by the existing databases, 
or you may want to modify one of those databases to fit your needs, or simply to change the 
“look” of the screen to provide a more customized appearance. 

You may want to add additional views to those already existing in your database. How you 
need to view your data may depend upon what you are doing at the moment. Therefore, as 
with paper forms, you can tailor TeleMagic contact views  to specific uses. However, a 
TeleMagic contact view has a significant advantage over a paper form. With a paper form, 
you must retype data common to all forms into each form. In TeleMagic, if you type 
information into a field in any one page, it will be updated on any other page or view on 
which that field appears. There is no need to retype data (like name, address, and phone 
number) which is common to different pages. 

In this section, you will learn how to create your own contact views for your data. You will 
have complete control over what data you will see, how you will enter it and how it will 
appear on your computer screen. 
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What You’ll Need 
Specific Windows skills 

You should know how to use a mouse, open a menu, and select options from a menu or 
dialog box. Specifically, you should be able to “drag and drop” with the mouse.  

Note: The Screen Designer uses both the right and left mouse buttons. Windows 
defaults are for those users who use the mouse with their right hand and primarily use 
the left mouse button. Where the instructions tell you to use the mouse, use the left 
mouse button. Only use the right mouse button when you are specifically instructed to 
do so. If you have your mouse configured to primarily use the right mouse button, use 
the right button where you are instructed to use the mouse, and only click the left 
button if the instructions specify to use the right button. 

Some familiarity with TeleMagic 

Navigation in the Screen Designer is very similar to navigation in TeleMagic. You will be 
more comfortable working in the Screen Designer if you know how to switch among 
levels, pages, and views. 

Some understanding of basic design and layout terms  

You will be more comfortable with the screen design instructions if you understand 
what “font”, “size” or “point size”, “pen”, and “fill” mean. 

An installed database 

You must have a database open when using the Screen Designer. Any views or screens 
created will be for that database. You should have your database installed and have a 
good idea of what changes you want to make before proceeding. If you are starting with 
a database that has existing views, you should know whether you want to modify an 
existing view, or add a new one. 

Basic understanding of your contact database structure 

If you have designed your own contact database, this is no problem. But if you are 
learning to use an existing contact database, you will find screen design easier if you 
find out a few things about it. How many levels does it have? What is stored at each 
level? What fields exist in the database? What fields will need to be added? How will 
you use your data? Who will enter your data, and how? 

If you are working with an existing contact database, you may find it helpful to print out 
a Database Structure Report. This will allow you to see how many levels exist in the 
database and what is stored at each level. A Database Structure Report will also supply 
you with other information that you may find helpful. 
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What You Can Do 
You can create an unlimited number of multi-page contact views  for each contact 
database.  

Perhaps you can easily collect some information over the phone, but must enter other 
information from mail deliveries. The separate phone and mail input fields might be good 
candidates for separate contact views, or for separate pages of the same view. 

You can create up to 999 pages for each view. 

Multiple pages can help to organize data entry, as well as make data easier to scan by 
placing it in a logical format. For example, in a customer data view, you might want to put 
sales lead data on a separate page from addresses and phone numbers. 

You can define the size of any page in your view. 

You have the ability to make a page as small as approximately ¾ of an inch square or 
large enough to fill your monitor. Remember that monitor resolution will affect how the 
page is displayed. A page that fills your screen may not fill, or may overfill, the screen of 
a user operating in another resolution. Consider the resolution of the monitors in use at 
all workstations that will be required to access TeleMagic, and use the resolution that 
works best for those who will be using the page. 

You can place an unlimited number of fields in a view. 

You can create up to 252 fields per level in a contact view. You can display these fields 
on more than one screen in the view; there is no limit to the number of fields that you 
can display in a contact view. You do not have to display all the fields in your contact 
database in any particular view. You can display your information wherever it may be 
required. 

You can organize multiple views in a three-level hierarchy linked by level of detail. 

There are many possible arrangements for your database, depending on what 
information you need to associate. For example, you may deal with several large 
companies, and have many contacts at each. In this case a database may be designed to 
contain company information on Level 1, contact information on Level 2, and details on 
individual contracts on Level 3. Or, you may do several special projects for large 
companies. In this case, a database may be designed to contain the company’s data on 
Level 1, a record on Level 2 for each job, and expenses for each job on Level 3. If you are 
a law firm, you may have a number of attorneys, each with their own clients. In this case 
a database may be designed to contain the attorney on Level 1, the clients on Level 2, 
and each case on Level 3. 

When designing your database, give some thought about what information needs to be 
associated with what other information and plan your levels accordingly. 
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You can add any type of field to a contact screen. 

In addition to character, date, number, memo, checkbox, phone, fax, pager, auto 
incrementing (unique number), OLE, e-mail address, web address, FTP address, and 
newsgroup fields, you can add objects such as notes, rollup lists, pictures, and more. 

You can use the same field on more than one page or level. 

You are not limited to using each field only once. You may place a field on any page or 
level, as many times as you like. In this way, you can display the same information, such 
as company name, in multiple places. Any changes to the field made on any page or 
level will be updated automatically everywhere it appears. 

You can add on-screen prompts to help you remember what goes into a field and how to 
enter it. 

If you have a memo field in your database, you can add a notepad area to any page to 
allow you to jot free-form notes as you talk to a contact. 

You can view lists of documents, activities, e-mail messages, and sales forecasts linked 
to a record. 

You can “roll up” field entries from a lower level (child record). 

Sometimes you may want to see a summary of specific information from a lower level 
without having to go to that level. 

For example, you might have five outstanding contracts with a client. While looking at 
that client’s customer data, you might want to see how many contracts you have, and 
their expiration dates, but not other contract details. Assuming that “contract number” 
and “expiration date” are fields on the sales contract level, you can design your 
customer view so that a list of sales contract numbers and their expiration dates appears 
on your customer data screen. That way, as the contract expiration date approaches, 
you can flip to the contract details on the level below. 

You can control layout. 

You decide where to place a field on the screen and its size. You can match on-screen 
layout to the flow of a branch script, so that you can enter data as you work through 
your script. You can control text backgrounds, colors, and fonts to make important 
information stand out on the screen. You can stack objects in order to place a label on 
top of a picture. You can add pictures and shapes to customize the appearance of your 
screen. 
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What You Cannot Do 
You cannot give two different contact views the same name. 

Every paper form has a unique name, or a unique number, to distinguish it from the 
others. Your TeleMagic contact views also need unique names, so that TeleMagic  can 
find and open the view you want to fill out. Contact view names need only vary by one 
character. For example, you could name a series of views SCRIPTA, SCRIPTB, SCRIPTC, 
etc., with no problem. 

You cannot give different pages of the same contact view the same name. 

If TeleMagic is “looking at” a view, it must have some way of telling which page is 
which within that contact view. However, you can use the same name for different pages 
of different views. For example, you could use PAGE1, PAGE2, and PAGE3 as page 
names within a view called COMPANY DATA (because each page name is unique). At 
the same time, on another level of the same database, you could use PAGE1, PAGE2, 
and PAGE3 again as page names within a view called CUSTOMER DATA (because 
CUSTOMER DATA is a different contact view). 

You cannot exceed maximum page size. 

TeleMagic allows you to create as many pages as you need for your view, but it  limits 
the size of each page to what will fit on your screen. If you need more than one screen 
full of information in your view, you must create another page. 

If you create a contact screen that fills a high-resolution screen display, you will not be 
able to see the entire screen at a lower resolution. 

Computer monitors are capable of displaying screens with varying resolutions. If you 
create a contact page for 800 X 600 pixels, it will be “too big” to fit on a 640 X 480 screen 
because it will consist of too many pixels. If you want to be able to edit your page on a 
low-resolution screen, you must make it small enough to fit within the lower resolution 
screen’s size limits. 

You cannot make a contact page smaller than the minimum page size. 

Designing Your Contact View 
Contact view design is a six-part process: 

1. Planning your contact views, either on paper or in a graphics program. 

2.  Starting the Screen Designer. 

3. Adding fields to the database, if you have not done so already. It is recommended 
that this be done prior to screen design. 
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4. Placing text, and objects, such as fields, pictures, and rollup lists on the screen. 

5. Completing layout, including moving, sizing and layering text and objects, drawing 
lines, and customizing fonts and colors. 

6. Saving your work. 

Planning Your Contact Views 
Before you start the Screen Designer, you should thoroughly plan your screen composition 
and layout. How many views do you want? What data should appear in each? How many 
pages do you want for each? What data should appear on each page? Forethought now will 
save much work later. 

For example, the Documentation database has three views (one for each level), two with two 
pages and one with three pages. The first view contains company data; the second contact 
data, and the third product and contract information. 

Once you have planned your views, sketch them on paper or in a graphics program. To use 
the Screen Designer most efficiently, give yourself a model from which to work. 

 Hint: If you will be creating multiple views that share some information (for instance, if 
you are creating views that will all contain basic address information for multiple 
departments) create a view with the common information then copy that view 
and modify the copies for each additional view. 

Starting the Screen Designer 
If you are new to database screen design, we recommended that you practice design skills 
before attempting to alter your existing database. Consider working on a copy of the 
database you want to change so in case you are not satisfied with your changes, you still 
have the original layout to work with. Alternatively, you could make a backup of TeleMagic 
and restore the backup if you decide not to keep the changes to your database. 

Before you open the Screen Designer, you should turn off your screen saver. You should 
also close any applications that come up automatically (such as e-mail programs that pop up 
alerts). 

To Open the Screen Designer: 

Note: You must select a database before you start the Screen Designer. 

 From the Contact Manager menu, select Contact Utilities , Screen Designer. 

 The Screen Designer Window will open: 
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Sample Screen Designer Window 

The Designer Window 
The Screen Designer window is similar in appearance to the Contact Manager window. You 
will notice that the standard TeleMagic menu has been replaced by the Screen Designer’s 
menu. This menu offers options applicable to screen design. The System Toolbar is replaced 
with the Screen Designer Toolbar. The Screen Designer Toolbar consists of tools to help 
you with object placement and various effects: 

 

Screen Designer Tools Toolbar 

All of the controls on this toolbar are provided with ToolTips. To access the ToolTip for a 
given control, place your cursor over it and the ToolTip will appear in a few seconds. Most 
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of the functions on this toolbar can also be accessed from the Object menu. The Screen 
Designer Toolbar is dockable, but it cannot be reconfigured. 

The Screen Designer toolbar allows you to navigate through the Screen Designer and offers 
quick access to Screen Designer tools  used to insert new fields and drawing objects on your 
screen, as well as tools to change levels, views and pages, and perform other functions: 

Screen Designer Toolbar (undocked) 

The center section is one page of a view. If you have an existing view, you will see the last 
page you had open in the Contact Manager. If you are working with a database with no 
existing views, you will be at a blank page. 

Navigating in the Designer 
The Screen Designer allows you to quickly navigate between existing views, pages, and 
levels. 

The level selector buttons allow you to quickly add and edit views on any level of your 
database. To access the views and pages available on any level, simply click the appropriate 
level selector button. 

The Change View button opens the Select a View dialog box, from which you can select the 
view that you want to edit. 

The Change Page button opens the Select a Page dialog, from which you can select the page 
that you want to edit. (Pressing PAGE UP  and PAGE DOWN on the keyboard will move you to 
the previous and next pages, respectively.) 

Using these tools, you can move quickly among all of the existing pages in your database, or 
navigate to the desired level and view when adding a new page. 

Adding Views and Pages 
By now you should already have decided how many views you will need, and have a good 
idea of how many pages you want on each view. You will need to add a view for every 
database level you want to use. You will need at least one page for each view. 

To Add a New View: 

1. From the Screen Designer toolbar, select the level to which you want to add the view: 
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2. Click the Add button. 

 The Add View or Page dialog box will open: 

 

Add View or Page Dialog Box 

3. Select Add View. 

 The Page Properties dialog box will appear over a new blank page. 

4. Enter the name of the view in the View field. 

5. Enter the name of the page in the Page field. 

6. Change default settings as required. 

7. Click OK. 

To Add a Page: 

Note: Adding a page will cause the page to be added using TeleMagic’s page properties 
defaults. If you have customized a page and want to use those properties, select to copy 
the page instead of adding a new one. 

1. From the Screen Designer toolbar, select the level to which you want to add. 

2. Click the Add button. 

 The Add View or Page dialog box will open. 

3. Select Add Page. 

 A blank page will be added to the current view. The Page Properties dialog box will 
appear where you can name the page and set appearance defaults. 

4. Enter the name of the page in the Page field. 

5. Change default settings as required. 

6. Click OK. 
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To Copy a Page: 

Note: Copying a page will copy both the page’s properties and any objects that have been 
placed on the page. 

1. Go to the page you want to copy and click Copy on the toolbar. 

 The Copy View or Page dialog box will open: 

 

Copy View or Page Dialog Box 

2. If you want to copy the current page to an existing view, select Current page to a 
new page in an existing view. 

or Select Current page to a new page in a new view to create a new view. 

3. If you are copying the current page to a new view, enter the view name in the New 
View Name field. 

4. Enter the page name in the New Page Name field. 

5. Click OK. 

 A Copy Complete message will appear. 

6. Click OK to acknowledge the message. 

 A new page will be added with the objects and properties of the source page. 

7. Change the page’s properties as required. 

To Copy a View: 

1. Go to the view you want to copy and click Copy on the toolbar. 

 The Copy View or Page dialog box will open. 
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2. Select All pages in current view to a new view. 

3. Enter the view name in the New View Name field. 

4. Click OK. 

 A Copy Complete message will appear. 

5. Click OK to acknowledge the message. 

 A new view will be added with all of the pages of the source view, and all of the 
objects and properties of those pages. 

Setting Page Properties 
Page properties are the setup options available for the page. They include such items as the 
size of the page, the color of the page, and the default font for items placed on the page. You 
will also name your view in the Page Properties dialog box. (Aside from the name, there are 
no view-specific properties.) 

Note: If you do not set properties for a page, the default colors will be black on light gray. 
The default font will be MS Sans Serif 8 point. The default page size will fit on a monitor with 
640 by 480 resolution. The default grid will be 10 by 10 pixels. 

To Set Page Properties: 

1. With your mouse, right click on the page. 

Note: If you are working on a page with existing objects, make sure you click on the 
page, not one of the objects. 

or From the Page menu, select Properties. 

 The Page Properties dialog box will appear: 
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Page Properties Dialog Box 

 If you have added a page to the existing view, the View field will display the name of 
the view to which the page is attached. 

2. Give your new view a name, or edit the name of an existing view in the View: field. 
The name may be up to 50 characters long. If there are multiple pages in the view, any 
changes made here will be reflected in the Page Properties dialog box for all pages in 
the view. 

3. Enter the name for the current page in the Page: field. The name may be up to 15 
characters long. 

4. Click Change Font to open the Font dialog box and select a font, style, and size for 
this page. Depending on the font selected, you will be able to set the script from this 
dialog as well. The current font is indicated in bold. 

5. To include a wallpaper background for your screen, specify the file name and path in 
the Wallpaper Bitmap File field. 

or Click on the Find… button to browse for your wallpaper. 

6. The selected pen color is indicated in the Pen Color section. To change the pen 
color, click on the Color… button and select the desired color from the palette. Click 
OK when you have made your selection. The pen color will be used for fonts and 
object outlines. 

7. The selected fill color will be indicated in the Fill Color section. To change the fill 
color, click on the Color… button and select the desired color from the palette. Click 
OK when you have made your selection. The fill color will be used as the background 
color of the screen, as well as for the center of objects drawn on the screen. 
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8. If you want to use a preset size, select it from the Preset drop-down list. A preset size 
will fill the entire space available for the contact screen for the selected monitor 
resolution. You will be able to select the preset screen size for the resolution in use on 
your current workstation and lower resolutions. (Higher resolutions will not be 
available on the list.) 

WARNING! Set your page size to the lowest resolution being used by any user who 
may need to use the view. If you are on a machine that displays 800 by 600 pixels, and 
you set this as your page size, anyone on a machine that with a lower resolution will 
not be able to see the entire screen.  

or If you want to specify a custom size, enter the number of pixels in the Height and 
Width fields. 

Note: If you are setting properties for a screen with objects already on it, you will not 
be able to make the screen smaller than the space occupied by the objects. 

 The Screen Designer grid allows you to see how objects on your screen are aligning 
and gives you the option of automatically aligning objects to the grid. 

9. If you want to specify a custom grid size, set the height and width in pixels in the 
Vertical Pixels and Horizontal Pixels fields. 

10. When satisfied with your screen properties, select OK. 

To Manually Adjust the Page Size: 

1. If you want to quickly adjust the size of your page without opening the Page 
Properties dialog box, move your cursor near the right side, lower side, or lower-right 
corner. 

 The cursor will change to a two-headed arrow configuration. The direction of the 
arrow will indicate the directions you can move the edge(s). When sizing at the 
corner, you will be changing both height and width of the page simultaneously. 

2. Click and drag the page to the desired dimensions. 

Note: If you are sizing a screen with objects already on it, you will not be able to make 
the screen smaller than the space occupied by the objects.

 

Placing Objects on the Page 
Objects are placed on a page using the object placement tools: 
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Object Placement Tools on the Screen Designer Toolbar 

Note: TeleMagic’s processing speed is not significantly affected by how many records, 
indexes, or filters you use. However, your hardware’s handling of screen painting time is 
significantly affected by the number of items on the screen. The more fields, labels, different 
fonts, colors, pictures, lines, and boxes you use, the longer your computer will take to 
“draw” a new screen. Once the screen is drawn, the more OLE fields you use, the longer your 
computer will take to display graphical data when you flip from record to record. 

Pointer Tool  
The pointer tool is used to select, move, and size objects on the page. 

Text Tool  
An important step in screen layout is adding text to your contact page. Text can be used to 
manually add field prompts, or to add instructions or descriptions to a page. For example, 
you might want to tell users that certain fields on the screen must be filled in. In this case, 
you could add a text message “All Fields Colored Blue Are Mandatory.” Or you may want to 
tell users where the information contained in certain fields can be obtained. 

Adding and Changing Labels on a Contact Screen Page:  

To change the text or properties of an existing label, right-click on the label. The Text 
Properties dialog box will open. Make changes as required using this procedure. 

To Add a New Label: 

1. Click the Text  button . 

2. Point to the approximate location on the blank contact page for your text  and click and 
drag the cursor to the approximate size of the label. Release the mouse button. 

 The Text  Properties dialog box will appear. 
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Text Properties Dialog Box 

3. Type the text  in the Text field. 

 Example: Company Information: 

4. Select Transparency Mode from the drop-down list. Select Opaque for the fill color to 
be visible, Transparent for the background color to be visible. 

5. To use a font other than the default for this page, click the Change Font button. Select 
the font, style, and size from the Font dialog box. You will also be able to change the 
script for some fonts from this dialog box. 

6. Select the alignment from the Alignment drop-down list. This will determine where in 
the label field the text will be placed. 

7. To use a pen color other than the default, click the Color… button in the Pen Color 
section and select the desired color from the palette. This will determine the color of 
the text in your label. 

8. To use a fill color other than the default, click the Color… button in the Fill Color 
section and select the desired color from the palette. This will determine the 
background color for the label field. This color will only be visible if Opaque is your 
transparency mode. 

9. Click OK when satisfied with your choices. 

 TeleMagic will place the label on your contact page.  

10. To add another piece of text, repeat steps 1 through 9, typing your next label into the 
Text Properties dialog box. 
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 Hint: After you use a tool, TeleMagic will automatically return to the pointer 
tool to allow you to work with the object you have just placed on the 
screen. If you will be placing multiple pieces of text on the screen without 
using the pointer tool between each one, click twice on the text tool to 
lock it in place. (The text tool will appear dimmed when it is locked.) Each 
time you click on the screen, you will receive a Text Properties dialog box 
until you select another tool. 

Field Tool  
Probably the most common thing you will want to add to your screens will be database 
fields. The field tool allows you to add character, date, number, memo, checkbox, phone, fax, 
pager, unique number, OLE, e-mail address, web address, FTP address, and newsgroup fields 
to the contact screen. You can create fields directly in the Screen Designer as you add them 
to the page. 

The following instructions assume that you are working with fields that already exist. If you 
do need to create any fields while working in the Screen Designer, the basic steps are the 
same as those you would follow when accessing the Edit the Field List dialog box from the 
File menu. 

To Add a Data Field to a Contact Screen: 

1. Click the Field button . 

 Hint: After you use a tool, TeleMagic will automatically return to the pointer 
tool to allow you to work with the object you have just placed on the 
screen. If you will be placing multiple fields on the screen without using 
the pointer tool between each one, click twice on the field tool to lock it in 
place. (The field tool will appear dimmed when it is locked.) The field tool 
will continue to be used until you select another tool. 

2. Point to the approximate location on the blank page for your data field. If you want to 
display the entire field, click on the screen. When the field is added, the text region 
will be large enough to contain the entire contents of the field in the selected font. 

Note: The location of your mouse when you click on the page defines the upper-left 
corner of the field text region, or the upper-left corner of the prompt if you include the 
field prompt. If the entire field will not fit horizontally on the page, or if you place the 
field too close to the right edge of the page, the display will be trimmed on the right 
side. If you place the field too close to the bottom edge of the page, it will be moved 
up until it will fit on the screen. 

or If you want to specify the size of the display, click and drag to the desired length. 
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Note: When a field is created, you define its length. The length is the maximum 
number of characters that can be stored in the field. When you define the size of the 
text region for the field display, the size you define will not affect the amount of data 
that can be stored in the field; it will only affect how much of that data is displayed on 
the page. It may also affect how the text appears if you are using right alignment or 
centering the data in the field. (Data will be aligned to the actual field length, not the 
display size.) 

 The Select a Field dialog box will appear: 

 

Sample Select a Field Dialog Box 

 The list of fields will include all the database fields from the level for which you are 
creating a page. The levels above the current level may be displayed by clicking the 
appropriate radio button. 

Note: If you have not yet added fields to your database, there will be only two fields 
in this list: TMSTART and TMLASTREV. You can add fields now by clicking Edit 
Field List….  

3. If you are on Level 2 or Level 3, and you want to use a field from a higher level, select 
the appropriate radio button.  

4. Use the scroll arrows to locate the field you want to use. 

Note: The actual field name will not appear on your final page. TeleMagic will insert a 
blank box to contain the information represented by this field name. 

5. If you want to display the field’s prompt, mark the Display Prompt with Field 
checkbox. 
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6. If you want to set field properties, mark Open Field Properties. This is the default 
selection. Changes to this control are retained for the next time you add a field. 

7. Click OK. 

If Open Field Properties is marked on the Select Field dialog box, the Field Properties 
dialog box will open, allowing you to set appearance defaults. If not, proceed to step 
10. 

8. Change default settings as required. 

9. Click OK. 

10. Repeat steps 1 through 9 for each field you want to add. 

 Your screen may look similar to the following: 

 

Sample Screen with Fields and Text 

Field Properties 
Field properties allow you to set specifics concerning the appearance of fields, including the 
font, color, and justification. 

To Set Field Properties: 

Note: If you have just added a field, the field properties dialog box will already be 
open. 
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1. Right-click on the field whose properties you want to set. 

or Highlight the field and select Properties from the Object menu. 

 The Field Properties dialog box will open: 

Note: If you have just added a field, the Field Properties dialog box will already be 
open. 

 

Sample Field Properties Dialog Box 

 The prompt and field name will be displayed in the Field Description field. This field 
cannot be edited. 

Note: In the case of check box fields, a Field Prompt field will appear instead, 
allowing you to change the prompt. 

2. The font characteristics will be indicated in the Font section. To change the font 
characteristics for this field, click Change Font and select the desired font, style, and 
size from the Font dialog box. Click OK when you have made your selection. 

3. Use the Alignment drop-down list to control where in the field text is placed in the 
event that it does not fill the field. 

?    Select Left to align the text  to the left-hand side of the field. 

?    Select Center to center the text  between the left and right-hand side of the field. 

?    Select Right to align the text  to the right-hand side of the field. 

4. If your field type is a date field, you have the option of placing a date picker icon next 
to the field. The icon will allow you access to a Go To Date dialog box when entering 
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dates into the field. If you are setting properties for a date field and want a date picker 
icon attached to the field, mark the Display Icon checkbox. 

5. Use the Transparency drop-down list to control whether the field is transparent or 
opaque. 

?? Select Opaque if you want the area defined by the field display to appear as a solid 
rectangle. If you select this option, any objects located behind the field will not be 
visible. 

?  Select Transparent if you want the area defined by the field display to be invisible, 
with only the field text showing. If you select this option, objects located behind 
the field will be visible with the exception of anything directly covered by the field 
text. 

6. Pen color will be indicated in the Pen Color section. Click Color… to change the pen 
color. A Color palette will open. Select the desired color and click OK when you have 
made your selection. 

7. Fill color will be indicated in the Fill Color section. Click Color… to change the fill 
color. A Color palette will open. Select the desired color and click OK when you have 
made your selection. 

Note: If you have selected Transparent from the Transparency drop-down list, 
choosing a fill color will automatically change this option back to Opaque. 
(Transparent objects do not have a background.) 

8. Select a field style, Plain or 3D, from the Field Style radio buttons. 

9. Select OK to save the field properties.  

 

Prompt Properties 
If you have chosen to include the field’s prompt with the field, you can set properties for 
that prompt. 

To Set Prompt Properties: 

1. Right-click on the prompt whose properties you want to set. 

or Select the prompt and choose Properties from the Object menu. 

 The Prompt Properties dialog box will appear.  

2.  See Adding and Changing Labels , earlier in this chapter, for instructions. 

Note: Except in the case of checkbox fields, the text of the prompt is display only. If you want 
to edit the prompt, you must do so from the Edit the Field List dialog box. 
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Activity Fields Tool  
Activity fields are special fields designed to display information taken from the Activity 
Manager. These fields give you quick access to such data as the first call to, or last meeting 
with, a contact. Activity fields are linked to the Activity Manager, so that any time you link 
an activity to a contact, the date and time of that activity are displayed in the respective 
activity fields. 

To Add an Activity Field to a Contact Screen: 

1. Click the Activity button . 

2. Point to the approximate location on the blank contact page where you want the top 
left corner of the field to begin, and click. 

 The Activity Field dialog box will open: 

 

Activity Dates 

3. Select from the Display the: drop-down list using the following guidelines: 

? Select First Completed to display the first activity that was completed for the 
contact. 

? Select Last Completed to display the most recently completed activity for the 
contact. 

? Select Next Incomplete to display the next pending activity for the contact. 

4. If you want to limit the activities displayed in the field to a specific activity type, enter 
the type into the activity that is a: field. 

 Enter the field type exactly as it appears in the Type field of activities or press F2 to 
access the Type field’s list box. Only activities that match the specified type will be 
used.  

or If you want the field to display first/last/next dates for any activity, no matter the type, 
mark the Any activity type for the contact checkbox. 
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5. When finished, click OK. 

 The activity field will appear on the contact page.  

 Hint: Use the text tool to enter a description of the field to allow users to 
quickly identify the activity being displayed. 

Activity Field Properties 
You can set properties to control the font, color, and transparency of your activity fields. 

To Set Activity Field Properties: 

 Right-click on the field whose properties you want to set. 

or Select the field and choose Properties from the Object menu. 

 The Field Properties dialog box will appear. This dialog contains the same options as 
are available when setting properties for a standard TeleMagic field. 

See Field Properties, earlier in this chapter, for instructions. 

List Tool  
Rollup lists allow you to place lists of information related to a contact that is taken from other 
areas of TeleMagic on your contact page. Rollups include:  

Contact rollups, which display a list of a record’s child records. 

Activity rollups, which display linked activities. 

Document rollups, which display linked documents. 

E-mail rollups, which display linked e-mail. 

Sales list rollups, which display Sales Forecasting information. 

To add a Rollup List to a Contact Screen:  

1. Click the Rollup tool . 

 The List Type dialog box will open. 

2. Click on the button corresponding to the type of rollup list you want to add. 

 The Expression Builder will open with the available fields listed.  

3. See the following topics for specific instructions on each type of rollup list. 
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 Contact List  
Sometimes, you need to be able to “roll up” information from lower levels into a list on one 
screen. Contact rollup lists allow you to select fields from a lower level and display them in a 
scrolling list. For example, on the Documentation database Company Data screen, there is a 
“rollup” of all the contacts for that company. The information in this rollup list is “pulled” 
from the Level 2 records associated with that company. 

Rollup lists only work from the top down. You can roll Level 2 records onto a Level 1 page, 
or Level 3 records onto a Level 1 or Level 2 page, but you cannot roll up anything onto a 
Level 3 page? because there is no Level 4 in any TeleMagic  database. 

To Add a Rollup (Child) List to a Contact Screen: 

1. Click on the Rollup tool and select Contact List. 

Note: If you are working with level 1 of a three-level database, a Create List for Which 
Level? dialog box will appear. Select the level which contains the fields you want to 
display. 

 The Build List Expression dialog box will appear. 

 

Build List Expression Dialog Box 

2. From the Fields list, select the first field you want displayed in your rollup list. 

 Example: Contact Name: {contact}. 

WARNING! Rollup lists do not recognize field-level security settings. This means 
that users will see all the fields in a roll-up list, even when they do not ordinarily have 
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rights to view one or more of those fields. Avoid placing sensitive information in a 
rollup list. 

 The field name, with its database level will appear in the Create a character or 
memo expression text box followed by a + sign. 

3. Type " (opening quotation marks), then three to five blank spaces, then " (closing 
quotation marks), then another + sign. (This will place blank spaces between the fields 
in the display, allowing easier viewing of the field data.) 

4. From the Fields: list, select the next field for your roll-up list. 

5. Repeat steps 3 through 5 as necessary. Include any other expression parameters you 
need. 

6. When finished creating your expression, click OK. 

 The List Properties dialog box will open. 

7. Click OK to accept the current list properties. (See the List Properties topic for 
information on changing the list properties.) 

The roll-up list will appear on your contact page: 

 

Sample Rollup List 

 The scroll box will dis play the expression that defines the fields that will be displayed. 
Above this, Xs will show the amount of space that will be allotted for the data in each 
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field. This display allows you to align any text you want to use as labels to indicate 
the contents of each field on the screen. 

Note: Rollup fields will not wrap. (i.e., If there is more text than will appear on one line, 
the information will not appear on the next line. It will simply not be displayed.) Size 
the rollup as necessary to display all of the needed information. 

Activity Rollup List 
Activity rollup lists allow you to see a list of all activities linked to a contact. (If Apply 
Security in Activity Lists is selected in Database Preferences, only those activities to which 
the user has access will be displayed.) This enables you to view directly on the screen a list 

of the same activities that you would see from clicking the Activities button  on the 
toolbar, or selecting Rollups  and then Activities from the Current Record menu. Adding 
this information as a rollup, however, gives you the advantage of being able to select what 
activity information is included in the list. Additionally, it gives you filtering and sorting 
options that are not available from the standard Activity List. 

To Add an Activity Rollup List to a Contact Page: 

1. Click the rollup tool and select Activity List from the List Type dialog box. 

 The Build List Expression dialog box will open, with the default activity list expression 
displayed. This expression will display date, time, user, and description for every 
scheduled and completed activity to which you have access for a contact. 

 

            The Build List Expression Dialog Box 
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3. You can edit the expression according to your requirements (no changes are 
necessary). When finished, click OK. 

 The List Properties dialog box will open. 

4. Click OK to accept the list properties. (See the topic on Rollup List Properties to 
change the list properties.) 

 TeleMagic will place the rollup on the screen: 

 

Sample Activity Rollup 

 The scroll box will display your expression. Above this, Xs will show the amount of 
space that will be allotted for the data in each field. This display allows you to align 
any text you want to use as labels to indicate the contents of each column in the 
rollup. 

Note: Rollup fields will not wrap. (i.e., If there is more text than will appear on one line, 
the information will not be displayed.) If the Xs extend beyond the display, 
information will be cut off when the field is in use. Size the rollup as necessary to 
display all of the needed information. 

 Document Rollup List 
The document rollup displays a list of all of the documents linked to a contact. 

To Add a Document Rollup List to a Contact Page: 

1. Click on the rollup tool and select Document List from the List Type dialog box. 

 The Build List Expression dialog box, with a default expression offered, will open: 
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 The Build List Expression Dialog Box 

 When you add a word processing document in TeleMagic, the entries you make in 
the Add dialog box are stored in a table named Wpdesc. The Fields list will allow you 
to select from the fields in this table. 

2. The default expression offered will display up to 35 characters of the document 
description, when the document was created, the user ID of the author, and which 
folder contains the document (global, database, or user). To accept the default 
expression, proceed to step 4. 

or From the Fields list, select the fields you want displayed in the rollup. (Build the 
expression in the same manner you would build an expression using fields from the 
Contact or Activity Manager.) 

4. When you are satisfied with your expression, click OK. 

 The List Properties dialog box will open. 

4. Click OK to accept the list properties. (See the topic on List Properties to change the 
list properties.) 

 TeleMagic will place the rollup on the screen.  

E-mail Rollup Lists 
The E-mail Rollup displays a list of e-mail messages linked to the contact. 

To Add an E-mail Rollup List to a Contact Page: 

1. Click on the rollup tool and select Email List from the List Type dialog box. 

 The Build List Expression dialog box will open: 
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 The Build List Expression Dialog Box 

 E-mail messages are stored in a table named Dbmail. The Fields list will allow you to 
select from the fields in this table.  

2. From the Fields list, select the fields you want displayed in the rollup. (Build the 
expression in the same manner you would build an expression using fields from the 
Contact or Activity Manager.)  

3. When you are satisfied with your expression, click OK. 

 The List Properties dialog box will open. 

4. Click OK to accept the list properties. (See the topic on List Properties to change the 
list properties.) 

 TeleMagic will place the rollup on the screen. 

Sales Rollup List  
The Sales Rollup displays Sales Forecasting information linked to the contact. 

To Add a Sales Rollup List to a Contact Page: 

1. Click on the Rollup tool and select Sales List from the List Type dialog box. 

 The Build List Expression dialog box will open: 
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The Build List Expression Dialog Box 

 Sales Forecasting information is  stored in a table named Tmsales. The Fields list will 
allow you to select from the fields in this table.  

2. From the Fields list, select the fields you want displayed in the rollup. (Build the 
expression in the same manner you would build an expression using fields from the 
Contact or Activity Manager.)  

3. When you are satisfied with your expression, click OK. 

 The List Properties dialog box will open. 

4. Click OK to accept the list properties. (See the topic on Rollup List Properties to 
change the list properties.) 

 TeleMagic will place the rollup on the screen.  

List Properties 
Rollup list properties allow you to control the appearance of your lists, the font used for the 
text, what records are included, and how they are sorted. 

To Set List Properties: 

1. With your mouse, right-click on the scroll box for the rollup list whose properties you 
want to set. 

or Select the rollup and choose Properties from the Object menu. 
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 The List Properties dialog box will open: 

 

Sample List Properties Dialog Box 

 The Display field will show the expression that was added when the rollup was 
created. 

2. If you need to alter the expression, click Expression… and use the Expression Builder 
dialog box to make any needed changes. 

3. If you want to limit the information that is displayed in the rollup list, mark the Filter 
checkbox. 

or If there is already a filter and you want to change it, click the Expression… button 
associated with this field. 

The Expression Builder will open. 

4. Create an expression to define the information you want included in the rollup. 

 Example: If you were creating a filter expression for a contact rollup list, and wanted 
to limit the child records included in the list to only show records with data in the 
Documentation Database’s Contract Number field (indicating that there is a contract 
with the contact), you would create this expression: !empty(contact3.conno). 

5. If you want to set security to limit the records that are displayed in the rollup list for 
the non-supervisor users, mark the Security checkbox. 

WARNING! Rollup lists will bypass the standard TeleMagic record level security. If 
there are sensitive records in your database, create security for the rollup list to limit 
non-supervisor access. 

 The Expression Builder will open. 
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6. Create a security expression for the rollup list. Click OK when finished to save the 
expression and return to the List Properties dialog box. 

7. Use the Sort drop-down box list to control the order in which records will be placed 
on the list. Select: 

? None if you want the list items to display in natural order. This is the order in which 
the item was added in TeleMagic. 

? List if you want list items to display according to the first field selected for your 
Display expression. (If the first field is a character field, items will be in alphabetical 
order; if it is a date field, they will be in chronological order, etc.)  

? Expr. if you want to access the Expression Builder dialog box where you can create 
a sort expression. When you select Expr., the Expression Builder will open. Create a 
sort expression for the rollup list. Click OK when finished to save the expression 
and return to the List Properties dialog box. 

 Hint: You do not necessarily need to use the fields that are being 
displayed on the rollup in your sort expression. 

Note: If you need to edit any of the expressions after they are initially created, use the 
appropriate Expression button to access the Expression Builder. 

 If you select List or Expr., the Ascending/Descending drop-down list will become 
available. 

8. Select Ascending if you want the list to display from A to Z, 0 to 9, or oldest to most 
recent (depending on the field type). 

or Select Descending if you want the list to display from Z to A, 9 to 0, or most recent to 
oldest. 

9. If you want to specify a default view and page to be used when users double-click on 
the record, mark Select Default.  

The View and Page drop-down lists will become enabled. 

10. Select the default view from the View drop-down list. 

11. Select the default page from the Page drop-down list. 

12. The selected font, style, and size will be indicated in the Font section. To change the 
font, click Change Font and select the desired font, style, and size from the Font 
dialog box. 

Note: If you select a proportional font, the columns of your text will not align properly. 
To keep your fields in columns, select a non-proportional font, or use the default font. 
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13. The pen color will be indicated in the Pen Color section. To change the pen color, 
click Color… and select the desired color from the palette. Click OK when you have 
made your selection. 

14. The fill color will be indicated in the Fill Color section. To change the fill color, click 
Color… and select the desired color from the palette. 

15. Select a field style, Plain or 3D, from the Field Style radio buttons. 

16. When you are satisfied with your selections, click OK. 

PageFrame Tool  
If you want all 5 rollup lists on your page, you can add them as a single control: 

Rollup PageFrame 

To Add a PageFrame: 

1. Click on the PageFrame tool . 

2. Click on the approximate location of the PageFrame on your contact page. The upper-
left corner of the PageFrame will be about where your cursor was pointing when you 
clicked. 

 The PageFrame will be placed on the page. You can adjust its position on the page by 
clicking and dragging, as required. 

3. Right-click in the blank area to the right of the Sales  tab to open the PageFrame 
General Properties dialog box. 

4. Click Change Font to open a Font dialog box and set the font and style for the tabs. 

5. Click the Color… buttons to open Color dialog boxes and set the pen and fill colors 
for the PageFrame itself. 
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6. Click the button for each frame to open the PageFrame List Properties dialog box and 
set your preferences for the selected frame. Follow the same guidelines for setting up 
these frames as for their respective individual rollup lists, found earlier in this chapter. 

or You can open the PageFrame List Properties for individual frames without opening the 
PageFrame General Properties dialog box by right-clicking anywhere on the frame or 
its tab. 

7. Click OK to save your settings and return to editing. 

Button Tool  
You can use buttons to launch programs, change the page or view, and run function keys. 
See the online help for instructions on creating function keys. 

To Add a Button: 

1. Click the Button tool . 

2. Click on the approximate intended location for the upper-left corner of the button. 

 The Button  Properties dialog box will open. 

3. You can label the button with text, a graphic, or both. Enter text, if desired, in the Text 
field. 

Note: If you use both text and a graphic, you will need to resize the button for both to 
be displayed. You can either resize the control manually, or choose Auto Resize. 

4. If you want to label your button with a graphic, enter the path to the graphic in the 
Graphic field. 

or Click the ellipsis button to open the Browse window and search for the graphic. 

5. Choose whether the button will trigger an external program or an internal function by 
selecting the appropriate radio button. 

6. If the button will launch an external program, click Program…. This will open the 
External Program dialog box. Enter the path and filename, and any required parameters, 
in the fields indicated. You can click the ellipsis button to open a File window and 
search for the program, if desired. When you have identified the program that is to be 
run, click OK. 

or If the button will trigger an internal function, choose whether the button will run a 
function key or change the page and view from the Internal Function drop-down list. 
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If you are running a function key, select the function key from the Function Keys 
drop-down list. If the button will change the view and page, select the view and page 
from the drop-down lists as indicated. 

7. To change the font for any text on the button’s label, click Change Font and select the 
desired font, weight, style, and size. Click OK when you have made your selection. 

8. To change the color of the font for any text on the button’s label, click Color… and 
choose the desired color. Click OK when you have made your selection. 

9. If you want the button to be sized automatically to accommodate any text and 
graphics that you have used in its label, mark Auto Size (design time). 

10. When you are satisfied with your button, click OK. 

 The button will be placed on the screen. It can be moved and resized as necessary. 

Line Tool  
Use the line tool to draw horizontal or vertical lines on your page. 

To Draw a Line: 

1. Click on the line tool . 

or Double-click on the line tool to draw multiple lines. The tool will dim. 

2. Click on the contact page and drag to the desired length of the line. 

3. If you are drawing multiple lines, repeat this process for each line you want to draw. 
When you have finished, click on another tool to deselect the line tool. 

Line Properties 
Line properties allow you to control the size and color of lines on the screen. 

To Set Line Properties: 

1. With your mouse, right-click on the line whose properties you want to set. 

or Select the line and choose Properties from the Object menu. 

 The Line Properties dialog box will open: 
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Line Properties Dialog Box 

2. To set the thickness of the line, select a point size from the Size: drop-down list. 

3. The pen color is indicated in the Pen Color section. To change the pen color, click 
Color…. Select the desired color from the palette. Click OK when you have made your 
selection. 

4. Click OK to save your settings. 

Rectangle/Circle Tool   
The rectangle tool is used to draw rectangles, ovals, and circles. 

To Draw a Rectangle: 

1. Click on the rectangle tool . 

or Double-click on the rectangle tool to draw multiple rectangles. 

2. Click on the contact page and drag to the desired size of the rectangle. 

The Rectangle Properties dialog box will open, allowing you to set appearance 
defaults. 

3. Change default settings as required. 

4. Click OK. 

5. If you are drawing multiple rectangles, repeat this process for each rectangle you want 
to draw. When you have finished, click on another tool to deselect the rectangle/circle 
tool. 

To Draw a Circle: 

1. Click on the rectangle tool . 

or Double-click on the rectangle tool to draw multiple circles. 
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2. Click on the contact page and drag to the desired size of the circle. 

 It will appear as a rectangle. 

 The Rectangle Properties dialog box will open: 

 

Rectangle Properties Dialog Box 

3. From the Border Type drop-down list, select Normal. 

Note: Ovals and circles can only have borders of Normal type. 

 The Roundness field will become available. 

4. In the Roundness field, select the degree of roundness of the circle, on a scale from 1 
to 99. 1 will cause a nearly imperceptible rounding of the edges; 99 will create an oval 
or circle (depending on whether you started with a rectangle or a square). 

5. Click OK. 

Rectangle and Circle Properties 
Rectangle and circle properties allow you to control the appearance of your rectangles and 
circles, and create special 3-D effects. 

 

To Set Rectangle and Circle Properties: 

1. Right-click on the rectangle or circle. 

or Select the rectangle or circle and choose Properties from the Object menu. 

 The Rectangle Properties dialog box will open. 

2. If your object is a rectangle or square, use the Type field if you want to create a 3-D 
effect. 

?     Select Normal if you do not want to use any special effects. 
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Note: Ovals and circles can only have borders of Normal type. 

? Select 3D Inset to make the rectangle appear indented on the page. 

Example:  

? Select 3D Outset to make the rectangle appear raised on the page. 

Example:  

? Select 3D Groove to give the rectangle an embossed appearance. 

Example:  

3. Select the point size for the border of the rectangle from the Size drop-down list. 

Note: You will not be able to set the point size for a 3-D groove rectangle. 

4. If you want to round the edges of a rectangle, select a degree of roundness from the 
Roundness drop-down list. Selecting 99 will create a circle or oval. 

Note: You will not be able to use 3-D effects with a rounded rectangle. 

5. Use the Mode drop-down list to select the transparency of the rectangle or circle. 

? Select Opaque to make the rectangle or circle appear as a solid object. Objects 
placed behind the object will not be visible. 

? Select Transparent to view only the outline of the rectangle or circle. 

6. The color of the border is indicated in the Border Color section. To change the color 
of the border, click Color…. Select the desired color from the palette. Click OK when 
you have made your selection. 

Note: If you are using 3-D Groove this setting will not be available. 

7. The color of the inside of the object will be indicated in the Fill Color section. To 
change the fill color, click Color…. Select the desired color from the palette. Click OK 
when you have made your selection. 

Note: This setting will not be available if the object is transparent. 

8. Click OK to save the object properties. 
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Picture Tool  
The picture tool allows you to place graphic pictures on your screen. Pictures can be used to 
illustrate a view with company logos, borders, backgrounds, or other graphics. Backgrounds 
can be placed on an entire screen, or behind a group of fields to provide emphasis. 

Note: Do not confuse pictures added with the picture tool with pictures placed in OLE fields. 
A picture added using the picture tool will appear the same on every contact record. An OLE 
field is just like a data field, except that it contains an OLE object (e.g., a picture) instead of 
text. The picture must be added to each record and will likely be different for each contact.  

To Add a Picture to a Contact Screen: 

1. Click the Picture tool . 

2. Click on the contact page and drag to the approximate size of your picture. You will be 
able to move and resize the picture later, if necessary. 

 The Select Picture dialog box will appear: 

 

Select Picture Dialog Box 

3. In the Name field, enter the path and file name of the picture you want to use or click 
Find to locate the picture using a Windows Open dialog. (The picture must be a 
Windows Bitmap file.) 

 The picture will display in the Preview window. 

4. Use the Alignment drop-down list to select how the picture should fit the frame in the 
event that it does not fill it exactly. 
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 Hint: Use the Preview window to see how your alignment choices will affect 
the display. (Unless your picture display is the exact size of the Preview 
window, this will not be an exa ct display; rather it will give you an 
example of each alignment option.) 

? Select Scale if you want to size the picture so that it does not extend beyond the 
limits of the frame, while retaining its original shape. The image will fill as much of the 
frame as possible while keeping the relative proportions of the bitmap picture. This 
will protect your picture from vertical or horizontal distortion. 

Example: If you insert a picture this size:  

into a frame this size:  

the final picture will be this size:  

? Select Stretch if you want the picture to exactly fit the frame you have drawn. If 
the frame is a different shape and/or size than the picture, the picture will be 
resized and/or reshaped to fit the frame. If necessary, the picture will be distorted 
vertically or horizontally to fit the frame. 

Example: If you insert a picture this size:  

into a frame this size:  

the final picture will be this size:  
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? Select Crop if you want the picture to retain the proportions of the original bitmap image 
without being distorted horizontally or vertically. If the picture is larger than the frame, it 
will be trimmed on the bottom and left edges so it does not extend beyond the edges of 
the frame. If it is smaller than the frame, it will not be affected. 

Example: If you insert a picture this size:  

into a frame this size:  

the final picture will be this size:  

? Select Center if you want the picture centered horizontally and vertically in the frame 
while retaining its original proportions. If the frame is smaller than the picture, the 
picture will be trimmed to fit the frame. If it does not fit horizontally, it will be trimmed 
equally on the left and right edges. If it does not fit vertically, it will be trimmed 
equally on the top and bottom edges.  

Example: If you insert a picture this size:  

into a frame this size:  

the final picture will appear like this:  

5. From the Mode drop-down list, select Transparent if you want any white areas of the 
picture to be invisible. Any objects behind the picture (including the fill color of the 
page) will be visible in any areas of the picture that were originally white.  

 Example: If your original picture looks like this:  
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and was placed in transparent mode on a gray background with text 
located behind the picture, it would appear like this:  

 

or Select Opaque if you want the picture to completely cover any objects that are placed 
behind the area included in the bitmap. White areas of the picture will display as 
white. (If the frame extends beyond the actual picture, you will still be able to view 
objects placed behind the frame.) 

 Example: If your original picture looks like this:  

and was placed in opaque mode on a gray background with text located behind the 
picture, it would look like this: 

 

6. Click OK to save your picture and its properties. 

Note: To access the picture properties again, right click on the picture, or select it and 
choose Properties from the Object menu. 
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Completing Layout 
Once you have placed all the text, fields, and objects required onto the contact page, you 
can complete screen layout. There are two aspects to completing screen layout: object 
properties and object placement. Object properties include any settings specific to the 
object, such as transparency, font, and color. Object placement is the object’s relationship to 
the screen and other objects on the screen. This includes moving, sizing, and layering 
objects. 

Note: TeleMagic’s processing speed is not significantly affected by how many records, 
indexes, or filters you use. However, your hardware’s handling of screen painting time is 
significantly affected by the number of items on the screen. The more lines, boxes, different 
fonts, colors, pictures, fields, and labels you use, the longer your computer will take to 
“draw” a new screen. Once the screen is drawn, the more OLE fields you use, the longer your 
computer will take to display graphical data when you flip from record to record. 

Selecting, Deselecting, and Rubber Banding Objects 
In order to manipulate an individual object on the screen, you must first select the object. 

To Select an Object: 

1. Click the Pointer tool . 

2. Click on the object you want to select.  

 A dotted line will appear around the object: 

 

To Select Multiple Objects (Rubber Banding): 

1. Click the pointer button. 

2. Point at an area on the page that does not currently have an object placed on it. 

Note: If you point at an existing object you will not be able to define the rubber band 
area; the individual object will be selected. 

3. Hold down the mouse and drag. 
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A dotted line will define the rubber-banded area: 

 

 When you release the mouse, every item within the rubber-banded area will be 
selected. 

or Hold down the shift key and click with the left mouse button on each item you want 
selected. 

or Click twice on the pointer tool.  

 It will turn into a rubber band tool:  

 Every object that you click on while this tool is in use will be selected. (Objects that 
are already selected will be deselected when you click on them while this tool is in 
use.) 

 Hint: The pointer tool is used both to select and move objects. If you click and 
drag with the pointer tool on a blank spot on the screen, a rubber band 
will be drawn. If you click and drag with the pointer on an object, that 
object will be moved. The rubber band tool is only used to select objects. 
If you click on an object and drag when this tool is in use, it will select the 
objects; the item on which you click will not be moved. If you need to 
draw a rubber band, but there is not a blank spot on the page to click on, 
use the rubber band tool. 

To Deselect an Object: 

 With the pointer tool selected, hold down the shift key and click with the left mouse 
button on the object. 

or 

 With the rubber band tool selected, click on the object. 
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To Deselect All Selected Objects: 

 With the pointer tool selected, click anywhere off the objects. 

To Invert Object Selection: 

1. With the pointer tool selected, hold down the shift key. 

2. Press the left mouse button and rubber band the objects you want inverted.  

3. Release the mouse button. 

 Every object within the rubber-banded area that was previously selected will be 
deselected, and vice versa. 

 or 

1. Click twice on the pointer tool to select the rubber band tool. 

2. Rubber band the objects you want inverted. 

 Every object within the rubber-banded area that was previously selected will be 
deselected, and vice versa. 

or  

 Simply point and click with the rubber band tool selected to invert a single object. 

Note: The rubber band tool automatically inverts any objects that are selected while it 
is in use. You must hold down the shift key to achieve the same result with the pointer 
tool. 

Setting Multiple Object Properties 
If you want to quickly change the properties of a group of objects, you may do so using 
multiple object properties. (For example, you may want to change the font of all of your text 
objects, or change the background color of a group of fields.) 

To Set Multiple Object Properties: 

1. Select the group of object whose properties you want to set. 

2. Right-click on one of the objects or select Properties  from the Object menu. 

 If all of the objects you selected are of the same type, the Properties dialog box for 
that type will open. If the objects are of different types, the Multiple Object Properties 
dialog box will open: 
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Multiple Object Properties 

3. Select the desired properties for your objects. (Properties will only be applied to 
object types subject to the property in question.) 

Note: Review the single object properties information, earlier in this chapter, for more 
information on how these settings will affect your objects. 

4. Click OK to save the properties. 

Sizing, Moving, and Layering Objects 
Once you have placed your objects on the screen, you may need to size, move, and layer 
them so that they are in the correct position. 

Layering Objects 
Layering objects means placing objects in front of, or behind, other objects. For example, if 
you have drawn a box around a group of fields to separate them from other objects on the 
screen, you will need to place the box behind the group of fields. 
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Sample Screen with Objects Drawn Over Fields 

To Send an Object to the Back 

1. Select the object you want to send to the back. 

2. From the Object menu, select Send to Back. 

or On the keyboard, press CTRL+J. 

or Click the Send to Back button on the toolbar . 

 The object will be sent to the back: 
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Sample Screen with Objects Sent to the Back 

To Bring an Object to the Front 

1. Select the object you want to bring to the front. 

2. From the Object menu, select Bring to Front. 

or On the keyboard, press CTRL+G. 

or Click the Bring to Front button on the toolbar . 
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 The object will be brought to the front: 

 

Sample Screen with Objects in Different Relative Positions 

Gridlines and Position Indicator 
When moving and sizing objects, it is often helpful to know how objects are aligning with 
other objects. Very often, simply looking at an object is not an accurate indication of 
alignment. TeleMagic provides tools to help you in this process.  

Gridlines 

You can have TeleMagic draw a grid on your page that will give you a visual indication of 
the alignment of objects. You also have the option of causing objects to “snap” to the 
nearest grid line (automatically align along the grid line). This will help you to keep size and 
alignment uniform. 

To Show the Grid: 

 On the toolbar, mark the Show Grid checkbox. 

or From the Grid menu, select Show Grid. A check mark will appear beside the menu 
option. 

 The grid will appear on your page: 
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Sample Page Showing the Gridlines 

 Objects drawn on the page will be placed in front of the grid. You can use the lines to 
see where any object is in relation to other objects.  

 Hint: If you have objects that appear on top of another object (such as the 
fields placed on the rectangle in the above illustration) that you need to 
align to the gridlines, temporarily make the background object 
transparent. You will then be able to see the gridlines through the object. 
Align the foreground objects to the grid, then make the background 
object opaque again. 

To Turn Off the Grid: 

 On the toolbar, unmark the Show Grid checkbox. 

or From the Grid menu, select ?Show Grid. The check mark will disappear from beside 
the menu option. 
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To Snap Objects to the Grid: 

Note: The grid does not necessarily need to be displayed to use snap to grid. 

 On the toolbar, mark the Snap to Grid checkbox. 

or From the Grid menu, select Snap to Grid. A check mark will appear beside the menu 
option. 

 All new objects that you draw will be aligned to the grid. Existing objects will not be 
moved to align to the grid unless you select them. 

To Turn Off Snap to Grid: 

Note: In order to crop or scale OLE objects and pictures properly, it is necessary to 
deactivate the Snap-to-Grid feature. 

 On the toolbar, unmark the Snap to Grid checkbox. 

or From the Grid menu, select ?Snap to Grid. The check mark will disappear from beside 
the menu option. 

To Change the Grid Size: 

1. From the Grid menu, select Grid Size. 

 The Grid Size dialog box will open: 

 

Grid Size Dialog Box 

2. Set the height and width in pixels in the Vertical Pixels and Horizontal Pixels fields. 

3. Click OK to save the grid settings. 
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Position Indicator 

The status bar in the Screen Designer provides a position indicator that will tell you the 
coordinates of your objects. When an object is highlighted, the status bar will give you 
detailed information concerning its position: 

 

In the above example, the top of the object is 47 pixels  from the top, 11 from the left, 266 from 
the bottom, and 293 from the right-hand edge. It is 219 pixels high and 282 pixels wide. 

Moving Objects 
You can move objects singly or in groups to position them on the page or in relation to other 
objects. 

To Move a Single Object: 

 With the pointer tool selected, click on the object and drag it to its new position. 

Note: The rubber band tool is used solely for selecting objects. You will not be able to 
drag an object if this tool is active. 

or With either the pointer or rubber band tool, select the object and use the ARROW keys 
to move it one pixel at a time or, if you have Snap to Grid on, one grid line at a time. 

To Move Multiple Objects: 

1. Use the Pointer tool to draw a rubber band around all of the objects you want to 
move. 

2. With the pointer tool, point to one of the selected objects and drag or use the ARROW 
keys. (You must be pointing directly on a selected item. If you click on a non-selected 
item or on the page, it will deselect the objects.) 

 Hint: If you want to move an object one pixel at a time, use the arrow keys 
instead of dragging. This will allow you to precisely control the position 
of your objects. (If you have Snap to Grid selected, this will move the 
object one grid line at a time.) 

 The objects will remain in their original positions, relative to one another, as you drag.  

An outline of the area in which the objects are contained will indicate where the 
objects will be placed when you release the mouse. 
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Centering Objects 
You have the ability to center objects vertically, horizontally, or both. If you have multiple 
objects selected, you also have the option of centering the objects individually or as a 
group. 

To Center Objects: 

1. Select the object(s) you want to center. 

2. From the Object menu, select Center. 

 The Centering Objects dialog box will open: 

 

Centering Options Dialog Box 

or Click one of the centering buttons on the toolbar: 

To center the object(s) vertically, click . 

To center the object(s) horizontally, click . 

If you have selected a group of objects, you will have the option of centering them 
individually or as a group. If you have a single object selected, skip to step 4. 

3. If you have multiple objects selected, choose Individually if you do not want to retain 
the objects’ spatial relationship to each other. Each object will be centered 
independent of the other objects in the group. The objects will end up stacked on top 
of each other. 

Note: This option does not apply if you are using the toolbar controls. 

 Example: If you individually center the selected items in the illustration below: 
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 The result will be similar to this: 

 

 Hint: This is useful if you want to center one object inside of another. Select 
both objects, center them as a group, and then adjust the position of the 
group if necessary. 

or Select As a group if you want the objects to retain their positions relative to each 
other, while the entire group is centered. 

 Example: If the objects in the previous illustration were centered as a group, the result 
would be similar to this: 
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4. If you want the selected object(s) centered vertically between the top and bottom 
edges of the page, select Vertically. 

5. If you want the selected object(s) centered horizontally between the left and right 
edges of the page, select Horizontally. 

Note: Choosing both vertical and horizontal centering will place the object(s) in the 
middle of the screen. 

Aligning Objects 
You can align groups of objects vertically or horizontally, as well as the left, right, top, and 
bottom edges. 

To Align Objects Vertically: 

1. Select the group of objects you want to align. 

2. From the Object menu, select Align Centers Vertically. 

or Click the Align Centers Vertically button  on the toolbar. 

The centers of the selected objects will be aligned on a common vertical axis. 

To Align Objects Horizontally: 

1. Select the group of objects you want to align. 

2. From the Object menu, select Align Centers Horizontally. 

or Click the Align Centers Horizontally button  on the toolbar. 

The centers of the selected objects will be aligned on a common horizontal axis. 
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To Align Objects’ Left Edges: 

1. Select the group of objects you want to align. 

2. From the Object menu, select Align Left Edges. 

or Click the Align Left Edges button  on the toolbar. 

The left edges of the selected objects will be aligned. 

To Align Objects’ Right Edges: 

1. Select the group of objects you want to align. 

2. From the Object menu, select Align Right Edges. 

or Click the Align Right Edges button  on the toolbar. 

The right edges of the selected objects will be aligned. 

To Align Objects’ Top Edges: 

1. Select the group of objects you want to align. 

2. From the Object menu, select Align Top Edges. 

or Click the Align Top Edges button  on the toolbar. 

The top edges of the selected objects will be aligned. 

To Align Objects’ Bottom Edges: 

1. Select the group of objects you want to align. 

2. From the Object menu, select Align Bottom Edges. 

or Click the Align Bottom Edges button  on the toolbar. 

The bottom edges of the selected objects will be aligned. 

 

 

 



  Working with the Pages in a View 135 

 System Administrator Guide 

Sizing Objects 
When an object is first placed on the page, you can define the general size you want the 
object to be. Should you need to adjust the size after the object is placed, you can simply 
drag it to new dimensions.  

To Size an Object: 

1. Select the object. 

 A dotted line will appear around the object: 

 

 The bottom and right edges of the object will be outlined in a darker shading. 

2. Click on the shaded area. 

 Your mouse will change to a two-headed arrow:  (horizontal positioning);  
(vertical positioning); or  (simultaneous horizontal and vertical positioning, 
accessed from the lower right-hand corner). 

3. Drag the item to the desired size. 

or While holding the CTRL key, press the arrow keys to resize the object. 

 Hint: If you have multiple objects that you want to be the same size, refer to the 
position indicator as you drag the item. 

To Make Multiple Objects the Same Size: 

1. Select the group of objects you want to resize. 

2. From the Object menu, select Same Size. 

or Click the Same Size button  on the toolbar. 

The objects will be resized. 

Note: How you select the objects will determine how they will be resized. If you use 
the Shift key and left-click each object, the objects will be resized to match the first 
object you selected. If you click and drag the mouse in order to rubber band the 
objects, they will be resized to match the largest object in the group. 

To Make Multiple Objects the Same Width: 

1. Select the group of objects you want to resize. 

2. From the Object menu, select Same Width. 
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or Click the Same Width button  on the toolbar. 

The objects will be resized. 

Note: How you select the objects will determine how they will be resized. If you use 
the Shift key and left-click each object, the objects will be resized to match the width 
of the first object you selected. If you click and drag the mouse in order to rubber 
band the objects, they will be resized to match the widest object in the group. 

To Make Multiple Objects the Same Height: 

1. Select the group of objects you want to resize. 

2. From the Object menu, select Same Height. 

or Click the Same Height button  on the toolbar. 

The objects will be resized. 

Note: How you select the objects will determine how they will be resized. If you use 
the Shift key and left-click each object, the objects will be resized to match the height 
of the first object you selected. If you click and drag the mouse in order to rubber 
band the objects, they will be resized to match the highest object in the group. 

Deleting Objects 

To Delete an Object: 

1. Select the object you want to delete. 

2. On the keyboard, press the DELETE key. 

WARNING! Do not click Delete on the toolbar. This will delete the entire page. 

Edit Input Order  
TeleMagic lets you control the order in which you add data to fields on a contact page. 
When you are inputting data on a screen, you use the TAB key to move from field to field. 
By using the Set Input Order menu option in the Screen Designer you can decide in 
advance the field order you want your cursor to follow when you press TAB. 

You can set the input order manually, or you can have TeleMagic set the order based on the 
rows and columns in which the fields are arranged. When manually setting the edit order, 
you designate the TAB sequence of each item relative to every other item on your contact 
page. When allowing TeleMagic to set the order, TeleMagic  will read the page, note the 
position of items on the page, and set the edit order from top to bottom and left to right. 
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Note: If you are using object layering, changing the input order may affect how objects are 
layered. When you add fields and other objects to your page, TeleMagic internally numbers 
the objects according to the order in which they were placed on the page. The first object is 
number 1, the second is number 2, and so on. This numbering allows TeleMagic to keep 
track of which objects have been added over the top of other objects. (For example, if you 
add a rectangle as the first object, then draw a line through it, TeleMagic will see the 
rectangle as #1 and the line as #2. It will use that numbering to determine that #1 was added 
first and should be behind #2.) If you use the Bring to Front or Send to Back features, 
TeleMagic renumbers the objects to reflect their new positions. (When you send anything to 
back, it becomes #1; when you bring anything to front, it becomes the highest number. All 
other objects are renumbered accordingly.) This same numbering is used to determine input 
order. The field with the lowest object number is the first field in TAB order. Changing the 
input order will also change the objects’ layered positions. (For example, you will not be able 
to have field X partially behind field Y and TAB to Y first. The act of placing X behind Y sets 
X’s TAB order higher than Y’s.) If you have placed fields on top of another object, such as 
an opaque rectangle, it is possible that changing the TAB order of the fields could send some 
of them behind the rectangle. Be sure to double-check your layering after setting input order 
to make sure all fields are still visible and in the proper position. If you need to make any 
adjustments, make them to non-field objects, where possible, to avoid affecting the input 
order. 

Before you set the input order, it may be helpful to view the current order for your fields. 

To View the Edit Order: 

 From the Page menu, select Show Input Order. 

 A numbered square will appear on the field: 
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Sample Page Showing Edit Order 

 As the above example illustrates, each field will have a small number in the upper 
right-hand corner indicating TAB order: 

 

The initial TAB order is based on the order in which fields are added. The numbering 
displayed in the above example illustrates the TAB order that would be used for this 
sample screen. Unless you intentionally added fields in the order you will be using 
them, chances are the input order will need to be adjusted, as is demonstrated in the 
above example. 

To Set the Edit Order Manually: 

1. From the Page menu, select Set Input Order. 

 The Input Order dialog box will appear:  
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Input Order Dialog Box 

TeleMagic lists all the fields on the page in the input order box. The order in which 
they are listed is the current TAB sequence. The item at the top of the list is the first 
field your cursor will appear in; the second item is where your cursor will next appear 
when you press TAB, and so on down the list. 

Note: All fields on the contact screen are listed in the Input Order dialog box. 
Sometimes, however, a blank space at the end of the drop-down box seems to indicate 
that the end of the list is being displayed. Always check for other available fields by 
using the scroll bar to scroll to the end of the list. 

2. Select an item. 

 A positioning arrow will appear on the corresponding list order button, and the 
selected item will become highlighted. 

3. Drag the item to its new position in the list order. 

4. Repeat as necessary, then click OK. 

Note: When you move objects around on the screen, your edit order as designated in 
the Input Order dialog box will not be affected. If you change the layering order (Bring 
to Front and Send to Back), the input order will be affected. 

To Set the Edit Order Using the Quick Order Option: 

1. From the Page menu, select Set Input Order. 

 The Input Order dialog box will appear. 
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2. Click the By Row button. 

 Objects and fields will be edited in order as they are positioned first across, then 
down the page. 

or Click the By Column button. 

 Objects will be edited in the order they are positioned first down, then across the 
page. 

3. Click OK. 

Backing Up Your Work 
The Backup feature on the File menu will allow you to create a backup copy of your current 
screen design. This is useful if you will be making changes that you are not sure you will 
want to keep. You can make a backup, make the changes, and then return the database to the 
state it was in prior to the backup if you are not satisfied with your changes. 

To Back Up Your Database Views: 

1. From the File menu, select Backup. 

 There will be a pause as TeleMagic copies the field structures and screen designs. 
When it is complete a Backup Complete message will appear. 

2. Click OK. 

To Restore from Backup: 

WARNING! If you select to restore a backup, any changes to both views and field 
structure since the last backup will be lost. 

1. From the File menu, select Restore. 

 You will be asked to confirm your decision to restore the backup. 

2. Click Yes to continue. 

or Click No to abort. 

 If you select Yes  there will be a pause as TeleMagic copies the field structure and 
screen design from the backup copy to your database. When it is complete a Restore 
Complete message will appear. 

5. Click OK. 
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Saving Your Work 
We recommend that you save the changes you have made to your screen design frequently. 

Note: Whenever you make changes to a view or contact page, you can either save or cancel 
those changes. However, once you have saved changes, you cannot cancel those changes. 
If you do not want to keep the changes after saving, you must restore from backup.  

To Save Changes to a Page: 

 Click Save on the toolbar. (Save replaces the Edit button when you are in edit mode.) 

or 

1. Navigate to another page, view, or level. 

 You will be asked if you want to save your changes. 

2. Select Yes . 

To Cancel Changes: 

 Click Cancel on the toolbar. (Cancel replaces the Delete button when you are in edit 
mode.) 

 or 

1. Navigate to another page, view, or level. 

 You will be asked if you want to save your changes. 

2. Select No. 

Converting Fields to Drop-down Lists 
Drop-down lists are functionally equivalent to validated list boxes. If you use validated list 
boxes in your database, you can replace them by converting the fields to drop-down lists. 
Doing so will result in expanding the field to a list rather than opening the list in a separate 
dialog box. You cannot enter data directly in a drop-down list; all entries must be selected 
from the list. Only character and numeric fields can be converted to drop-down lists.  

When you convert a field, only the specific instance of the field is converted. For example, 
assume that you have 2 pages in your database: page A and page B. If you display a 
particular field on both pages, but convert it to a drop-down list on page A, page B will 
remain a field with a traditional list box. If you make changes to the list box on page B, the 
changes will be reflected on the drop-down list after you have performed a rebuild that 
includes rebuilding list boxes. You could also update the drop-down list by opening the 
Screen Designer to page A, unmarking the Dropdown list checkbox on the fields Properties 
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page, saving your work, then going back and re-marking  the Dropdown list checkbox, and 
saving your work again. 

To Convert a Field to a Drop-down list: 

1. Identify the field that is to be converted to a drop-down list. If you have not already 
added the field, do so now following the instructions under Field Tool, earlier in this 
chapter, or the online help. The field should also have a list box already attached. If 
the field does not have a list box, create one now with all of the entries that should be 
included in the list. See the online help for instruction on creating list boxes. 

Note: It is possible to convert a field that does not have a list box to a drop-down list. 
Since drop-down lists do not accept entries except from the list, this would leave no 
way for users to enter data in that instance of the field. 

2. Open the Screen Designer to the page where the field that you want to convert is 
displayed. 

3. Open the Properties page for the field. You can open the Properties page either by 
right-clicking on the field and selecting Properties from the context menu, or by 
selecting the field, opening the View menu, and selecting Properties. 

4. Mark Dropdown list. 

5. Click OK. 

 The Properties page will close. 

6. Repeat steps 2-5 for any other fields that you want to convert. 

7. Save your work and exit the Screen Designer. 

 The field will appear as a drop-down list. 
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Working with the Pages in a View 
Arranging Pages in Your View 

The way pages are arranged in the Screen Designer will control the order in which pages are 
presented when you page up and down through them in the Contact Manager. The 
arrangement of pages can be very important during data entry. Forethought now will save 
unnecessary jumping around later when you are trying to enter information into a record.  

To Arrange the Pages in Your View: 

1. From the toolbar, select Order. 

or From the Page menu, select Set Page Order. 

 The Page Order dialog box will open, displaying the pages in the current view: 

 

Sample Page Order Dialog Box 

2. Click on the button to the left of the page name and drag the page to its new position. 

3. Click OK to save the page order. 

Removing Pages and Views from Your Database 
You can easily remove any existing pages or views from your database when they are no 
longer required. 

To Delete a Page or View: 

1. Navigate to the page you want to delete. 

2. Click Delete on the toolbar. 

 The Delete View or Page dialog box will appear: 
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Delete View or Page Dialog Box 

3. If you want to simultaneously delete all pages in the current view, select Delete View. 

or If you want to delete the current page, select Delete Page. 

 You will be asked to confirm your decision to delete. 

4. Click Yes  to delete the page or view. 

or Click No to abort. 

Exiting the Screen Designer 
To Exit the Screen Designer: 

1. Click Save on the toolbar to save any changes to the current page. 

2. From the File menu, select Close. 

or Click Close on the toolbar. 

 The Screen Designer will close. 

Note: If you have made drastic changes to the database or modified the list of fields 
(by accessing the Edit the Field List dialog box) you should rebuild the database. 
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TeleMagic Security versus Network 
Security 

Note: Access to TeleMagic  Enterprise security settings is restricted to supervisor users. 

We recommend that you plan and set up your network’s groups and security first, before 
installing TeleMagic. 

TeleMagic security should not be confused with network  security, although the two can 
and should work together. Network security can contain groups. These groups should not 
be confused with TeleMagic’s security groups. Network security groups control access to 
directories and files on the network. TeleMagic’s security groups relate only to access to 
areas of TeleMagic. 

TeleMagic’s security allows you to control which databases users can access. Within the 
databases, you can control what records users may view, edit, and delete. (A user would not 
even know about being unable to reach every record in the database if he or she were not 
granted view rights.) You can also control what fields in a record users can view. (You can 
use this to allow general access to a record, but restrict sensitive data to users who need to 
see it.) 

Planning Security within TeleMagic 
Note: Owners of the single-user version of TeleMagic need not worry about security, unless 
multiple people are going to share the same PC. In that case, this chapter is still applicable, 
although only one person can use the product at a time. 

TeleMagic security has two major branches: system security and database-related security. 
A system administrator creates and adds members to security groups; defines exactly what 
system features and databases each group will be able to access; and then, taking one 
database at a time, decides what database-related features and database fields that group 
will be able to access. 

You do not have to use TeleMagic security, but we strongly recommend doing so if you 
have any sensitive information you want to keep protected, or if you want to limit system 
administration in TeleMagic to certain individuals.  

Note: If you do not want to use TeleMagic security, assign all users to the Supervisor 
security group. 

If you are using TeleMagic NetClient – Browser Edition, there are additional considerations 
related to security. See the TeleMagic NetClient – Server Guide, the TeleMagic Application 
Server help, and Browser Edition help (BROWSER.CHM) for more information. 
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Security Groups  
Security groups, or collections of users, offer the easiest way to provide security by 
department or job function. By keeping users in a group, it is easy to make changes in their 
security arrangements because you make them once for the group, instead of for each user.  

 Hint: It is for this reason that we recommend you create master template users for 
each group of users, then copy that user every time you need to add someone 
new to that group. The template user’s security and group memberships will be 
copied as well, saving you from doing it manually. 

System Security 
Security is controlled from the TeleMagic  security screens. There are two security screens: 
the System Level Security screen, and the Database and Field Security screen. The System 
Level Security screen is where security groups are actually created. This screen also controls 
who is a member of which security group, and to which of the major features and databases 
the group has access. 

To Add a Security Group: 

1. From the Options menu, select Security. 

 

Sample System Level Security Screen 

 You have the choice of adding a security group by copying any existing group, or 
adding one from scratch. The first time security is opened, the Supervisor group will 
be the only group listed. Copying the Supervisor group will give the group full 
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security access to most areas of TeleMagic by default. Adding will create a group 
with no default access. 

Note: There are some areas of TeleMagic to which you cannot grant access to non-
supervisor users. If you copy the Supervisor group, rights to these areas will not be 
copied. Access will only be granted to areas that appear on either this screen or the 
Database and Field Security screen. 

2. If you want to add a security group based on the Supervisor group, select Copy. 

or If you want to add a group with no default security, click Add.  

3. Type the name of the new group into the Change security group description: field. 

 Hint: If you are creating security groups for your master template users, 
consider giving the group the same name as the template user. 

? Select Add new database if you want users in the group to be able to add and 
change databases at the Select Database dialog box.  

? Select Delete databases if you want to grant users in the group rights to delete 
existing databases. 

? If you want users in the group to be able to access Preferences, mark the Edit 
preferences checkbox. 

Note: This will grant users the ability to open the Preferences dialog box and set 
their own User Preferences. This will also give you the option of allowing access 
to Database Preferences for any databases to which you are granting the group 
access. Access to database preferences is controlled from the Database and Field 
Security dialog box. (Installation preferences are only available to Supervisor 
users.)  

 

Note: If you are creating security for your master template users and have not yet 
established their preferences, make sure to check the box. You can always remove 
it later after preferences have been established, if necessary. 

? Mark Allow rebuild if you want to grant members of the group access to the 
Rebuild feature. 

Note: If you grant rebuild access, make sure the users are aware of the cautions 
against running a rebuild when other users are in TeleMagic and are familiar with 
the various options available. 

4. To add or remove members of the group, click Current Members. 

 The Select Members for this Security Group dialog box will open. 

5. Select the users to be added to the group from the Available Users lis t on the left side 
of the dialog box. You can select multiple users by holding the CTRL and/or SHIFT 
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keys. Click Add to add the selected user(s) to the group. You can add all users from 
the Available Users list by clicking Add All without selecting any particular users. To 
remove users from the group, select them from the Current Members list in the same 
way that users were selected on the Available Users list and click Remove , or click 
Remove All to remove all of the group’s members. 

Note: If a user is a member of more than one security group, TeleMagic combines 
rights, allowing the user access to any feature allowed by any group to which the user 
belongs. Of course, if a user is a member of the Supervisor group, he or she will have 
full rights to all features automatically. 

 

Note: Make sure that all users are members of at least one security group. If a user is 
not a member of a security group, that user will not be able to access existing 
databases. If you are adding users instead of copying a template user, by default, 
those users will have no rights. 

 Members of the security group will only be able to access databases that appear in 
the Accessible Databases  list. 

6. When you are satisfied with the group membership, click OK to save changes and 
return to the System Level Security dialog box. 

7. To grant access to a database, click the name of a database in the Existing 
databases list to highlight it.  

? Click Add or double-click the selected database to cause it to appear in the 
Accessible Databases  list. 

? Click Add All to cause all the existing databases to appear in the Accessible 
Databases list. 

8. To make a database inaccessible to members of the group, highlight the database in 
the Accessible Databases  list. 

? Click Remove  or double-click a database in the Accessible Databases  list to 
cause the selected database to disappear from the list. 

?    Click Remove All to clear the Accessible Databases  list. 

9. If you want to set security for the databases to which you have granted access, 
highlight the database and click Database security….  

or Click Save to save the new group. 

 If you have added this group by copying the Supervisor group, users will have full 
access to the databases on the list. If you have added the security group by clicking 
Add, users will have access to all records, but they will only be able to view rollup 
lists. (No other fields will be available.) 
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Database-Related Security 
In many companies, users will keep sensitive information in their TeleMagic  databases. If 
none of the information in the database has to be shared, a user can keep it private by 
creating and saving the database to his or her local hard drive. However, non-sensitive 
information in the database must often be shared. The best way to do this is by keeping it on 
the network, in a directory accessible by everyone. To protect sensitive data, but still allow 
for general access to other parts of the same database, TeleMagic  security options allow you 
to determine who can see and change what data. 

For example, you may have a group of order-fillers who should be able to add but not 
change existing information. You can use database security to limit their access to editing 
records, while allowing unlimited add rights. 

Database-related security is controlled from the Database and Field Security Screen. 

To Add Database Security and Visibility Rules to a Security Group: 

1. If you have not already opened the System Level Security screen, select Security 
from the Options menu. 

 The System Level Security screen will open. 

2. From the Change settings for security group: drop-down list, select the group 
whose security you want to modify. 

3. If it is not already there, add the database for which you want to establish security to 
the Accessible Databases  list. (Highlight it on the Existing Databases  list and 
click Add.) 

4. Select Database security… to bring up the Database and Field Security screen: 
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Sample Database and Field Security Screen 

5. From the Database Security for: drop-down list, choose the database for which you 
want to establish security and visibility restrictions. 

 The Field Level Security section allows you to control access to specific fields. You 
can either allow access to all fields, or you can specify access to individual fields. The 
Full Access All Fields checkbox will default to being unmarked (which prevents 
accidental Full Access status), allowing no access to any field in the selected 
database. 

6. To grant complete access to all fields, mark the Full Access All Fields  checkbox, 
then proceed to step 12. 

or Choose the fields that the group will be given access to by clicking the Field Security 
button. This will bring up the Field Level Security screen.  
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Sample Field Level Security Screen 

7. From the Show Fields from Level: drop-down list, select the level you want to 
modify, or choose All Levels to list all fields in the database. 

8. Select an access level from the Show Fields for Access Level: drop-down list. The 
fields that appear in the Selected Fields list are the fields that are configured to use the 
access level currently selected in the drop-down list. All fields are set to No Access 
by default. You may choose one or more of the following options: 

??????No Access—The group will have no access to the field. 

?     View Only—The group will be able to view but not edit the field. 

? View Only {Add Notes}—The group will be able to view but not edit the field. In 
the case of memo fields, the group will be able to add notes to the field using the 

Add Note button on the Contact Manager toolbar , but will not be able to 
edit existing notes. 

?? Edit/View {Use Listbox}—The group will be able to edit and view the field, and 
will be able to use, but not alter, the list box created for the field. 

?? Edit/View {Modify Listbox}— The group will be able to edit and view the field, 
and will be able to use and alter the list box created for the field. 

9. Choose the fields which will have the access level you selected in step 8. You can 
choose multiple fields by holding the CTRL key while clicking on subsequent choices, 
or choose a range of fields by holding the SHIFT key while clicking on the last field in 
the series. Click the Add button to select the fields, or choose Add All to select all of 
the available fields. 
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If you want to deselect a field, highlight the field in the Selected Fields list and click 
the Remove  button. To deselect all fields, click on the Remove All button. 

10. Repeat steps 8 and 9 for each access level as necessary. Do this for each database 
level if you did not select the All Levels option from the drop-down list. 

11. When you have finished configuring field security for the database, click Close. You 
will be returned to the Database and Field Security screen. 

12. In the Database Specific Security section of the screen, set the security group's 
access to various database-specific features using the following guidelines: 

Mark the Add checkbox if you want memb ers of the group to be able to add records to 
the selected database. 

Mark Import if you want to allow members of the group to be able to import records 
from outside TeleMagic into the database. 

Mark Export if you want members of the group to be able to exp ort records from 
TeleMagic to be used in other databases, or other applications. 

Mark Group Options if you want members of this group to be able to use the Group 
Replace, Group Delete/Recover, Reset Unique Numbers, and Set Multiple Recalls 
features. 

Mark Screen Designer if you want members of this group to be able to design their 
own contact views or change existing views. (Each database level is composed of one 
or more views. A view defines the way fields and other objects appear on the screen.) 

Mark Database Preferences if you want the group members to be able to change the 
Database and Key Field preference settings for the database. If this is unmarked, 
users will not have access to database related pages on the Preferences dialog box.  

Note: If you did not grant the group rights to edit preferences on the main System 
Level Security screen, Database Preferences will be dimmed on this screen. 

Mark Filters: Edit to grant users rights to edit existing filters for the database. Mark 
Add to grant rights to add new filters. With neither selected, they can only use 
existing filters. 

Mark Indexes: Edit to grant users rights to edit existing indexes for the database. 
Mark Add to grant rights to add new indexes. With neither selected, they can only 
use existing indexe s. 

Mark User Reports: Edit to grant rights to edit existing Quick Lists and custom 
reports. Mark Add to grant rights to add new reports. 

 

WARNING! If you are limiting access to view certain fields in the database for 
this group, do not grant access to create or edit reports and Quick Lists. 
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TeleMagic uses the FoxPro report generator, which does not respect field level 
security. Users will be able to report on information they would not normally be 
able to see in the database. 

13. The Sales Forecasting feature allows you to track the progress of a sale from the initial 
contact through to the actual sale. At the time of the initial contact, a projected sale 
amount is entered. When the sale is closed, an actual sale amount is entered. A 
number of reports have been designed for productivity tracking and calculating 
profits. To maintain data integrity, you may want to limit users’ access to edit and 
delete existing sales forecasts. 

 Use the Sales Forecasting:  radio buttons as follows: 

? No Access will keep members of the group from choosing the Sales Forecasting 
menu option or toolbar icon. This setting is the default. 

? Add/Limited Edit will permit access to Sales Forecasting, and allow users to add 
forecasts and edit all but the Rep, Quotation, Budget Amount, Projected Sale 
Date, and Probability of Closure fields. 

? Full Edit/Add will allow access to add sales forecasts, and to change that data 
later. 

? Delete/Full Edit/Add will allow Full Edit access, and allow users to delete 
existing forecast records. 

14. Use the View…, Edit…, and Delete… buttons to control access to specific records. 

Note: By default, users will have access to open, modify, and delete all records in the 
database. If you do not want to limit access, skip to step 16. 

 Choosing the View, Edit, or Delete buttons will bring up the Record Expression dialog 
box, where you can build expressions to control access to groups of records: 
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Record Expression Dialog Box 

15. Create a filter to define which records members of the group may view, edit, or delete. 
If no filter has been created for the group, users will have access to all records in the 
database. Once a filter is created, users will only be able to access records that meet 
the filter criteria. (These filters are created in exactly the same manner as Contact 
Manager filters.) 

 Hint: Create the filter first in the Contact Manager to test that it is actually 
isolating the desired records. This will avoid any surprises later if filter 
specifications are inaccurate. 

16. When the filter expression is complete, click OK.  

You will return to the Database and Field Security screen. 

17. Repeat steps 5 through 16 for each database to which the group has access. 

18. When you have set the security for all applicable databases, click Close. 

 You will return to the System Level Security screen. 

19. Click Save to save any changes you have made to both the Database and Field 
Security and System Level Security screens. 

20. Click OK to exit security. 
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Other TeleMagic Security Issues 
User Security 

With the exception of activity security, there is no separate user security per se; it is all 
administered through the group security options as illustrated earlier in this chapter. 

To give a single user a special security setup, create a security group with the desired 
settings, and make that user the only member of the group. 

If a user leaves your company, you should delete the user from TeleMagic and use the 
Activity Archive feature to remove that user’s activities. (Delete his or her network logon, 
too). It is also a good idea to check for local databases, in case the user kept important 
information on his or her local hard drive. 

Note: One way users can protect sensitive data is to store databases and contact information 
on local hard drives, or in network directories only accessible to them. Warn users who store 
databases locally that their database description as it appears in the Database Selection 
dialog box should mention that the database is local and have some sort of unique identifier, 
such as the user’s name. 

Changing Passwords 
Users can have their own passwords, which prevents unwanted users from easily logging in. 
We recommend that you assign TeleMagic  passwords to all users in companies with any 
sensitive information. 

TeleMagic Supervisor users can change other users’ passwords at any time. 

To Change a User’s Password: 

1. From the Options menu, select Preferences . 

 The Preferences dialog box will open. 

2. Click the Users  tab. 

 The Users page will open. 

3. Highlight the user whose password you want to change and click Properties. 

 The Properties dialog box will open. 

4. Click Change Password. 

 The Change Password dialog box will appear: 
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Sample Change Password Dialog Box 

Note: If a non-supervisor user is changing his or her own password, this dialog box 
will appear slightly different. The user’s current password must be entered before 
being allowed to change it. If a non-supervisor user has lost their current password, 
the new password must be entered for the non-supervisor by a supervisor user.  

5. Enter a password for the user in the Enter New Password: field. 

6. Enter the password again in the Verify New Password: field. 

Note: If the entries do not match, you will be required to enter the password again. 

 Hint: Make sure you note the password and give it to the user. The user will be 
required to enter the password to access TeleMagic.  

 You will be returned to the Configuration Options screen. 

7. Click OK. 

 The Change Password dialog box will close. 

8. Click OK. 

 The Properties dialog box will close. 

9. Click OK to save changes and exit Preferences. 

or Click Apply to save changes without exit ing. 

Activity Security 
Each user is responsible for granting security access to his or her own calendar. To maintain 
users’ privacy, this is the one area of security that is not automatically granted to Supervisor 
users. (Supervisor users will be able to archive, or group delete, activities for a user who has 
not granted the supervisor calendar access.) 
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Preferences and Security 
TeleMagic Preferences can be divided into three areas: User Preferences, Database 
Preferences, and Global Preferences. User Preferences are settings that affect the current 
user only. Database Preferences affect all users working in the current database. Global 
Preferences affect all users in all databases in the current installation. 

TeleMagic’s security system gives you three possible configurations for security groups 
regarding preferences: 

? No access at all 

You will fully deny access to the Preferences  option on the Options menu if you 
place a user in a security group which, in the System Level Security screen, is given 
no rights to Edit preferences: 

 

System Level Security Screen’s Edit Preferences Checkbox 

Before you remove a security group’s access to preferences, you should make sure 
that its current settings are correct. Do this by printing a user preference report for 
that user.  

Without access to preferences, users may not be able to use some of the more basic 
TeleMagic features; for example, they cannot set up the Dialer feature, or set a path 
to a word processing program. On the other hand, restricting access to preferences 
forces the users to use the settings you have already configured for them. (If you 
restrict access to preferences, make sure that these areas are set up in advance if 
you want the users to be able to fully use TeleMagic.) 

? Access to User Preferences, but not to Database Preferences 

You can control a security group’s access to Database Preferences on a per-
database basis. If a group has been granted overall rights to edit preferences, you 
will have the additional option of granting rights to edit Database Preferences. 
Rights to edit Database Preferences are allowed or denied on the Database and 
Field Security screen: 
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Database and Field Security Screen’s Database Preferences Checkbox 

If a group cannot edit database preferences, but can edit other preferences, 
Database Preferences will not be available. 

Note: Be sure that users who have access to Database Preferences understand that 
any changes made to these preferences will affect all users. 

? Full access to user, database, and installation preferences 

Only the Supervisor group will have full access to all preferences, including the 
sensitive installation preferences. 

Security Reports 
Once you have set up your security arrangements, you can generate reports on them. There 
are two security reports: User and Group. These will report the security for one or more 
users, or a particular TeleMagic security group. Security reports are available from the 
Reports menu under System Reports. 

? The Group Security Report lists every security group, including the rights for those 
groups and what users are members. 

? The User Security Report shows the security setup for a particular user, including 
to which group that user belongs, and what rights that user has.
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What are Preferences? 
Preferences are user-defined configuration options. They are part of what makes TeleMagic 
so powerful, because you can use them to tailor the program to fit every need—not only 
those of your company, but also the needs of each individual user.  

When you open a page on the Preferences screen, the scope will be indicated in the title bar 
of the Preferences dialog box. Preferences can be user-specific, database-specific, or global: 

? User preferences apply to the current user, and consist of Activity, Contact, Dialer, 
Directories, Display, Fax, Wireless Messaging, and Writing configuration options. 
Additionally, if the user is not a supervisor, it will include User setup for the user’s 
own User ID. 

? Database preferences include the configuration options for the current database and 
key fields for the current database. 

? Global preferences apply to the whole installation, and include the System and User 
configuration options. Installation preferences are available only to supervisor users.  

Note: Toolbar and function key configuration options can belong to any of the three groups, 
depending on your Directories setup choices. E-mail preferences are accessed from the 
TeleMagic Internet Mail application. They are included in this section because their function 
is similar to the other preferences. E-mail preferences are not copied when creating new 
users. 

User, Database, and Global Preferences 
This section includes an overview of the areas affected by each preference set. 

User Preferences 
User preferences establish how the screens will look and feel for each user, and where 
TeleMagic will store each user’s files. Options selected for user preferences will affect all the 
current user’s databases. These preferences will become effective any time anyone logs into 
TeleMagic with that User ID, regardless of the location of the workstation being used.  
You can also create a template for users, in which you can set the preferences for each user. 
When new users are added by copying the template, these user preferences will be copied as 
well. Using security, you can either force users to use the preferences you have established, 
or allow them to edit them. User preferences must be establis hed for each user separately 
unless the user is added by copying, which grants the new user the existing user’s 
preferences. To set a user’s preferences, you must be logged into TeleMagic as that user. 
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By default, user preferences will include all those choices offered under the Activity, 
Contact, Fax, Wireless Messaging, Writing, Display, Dialer, and Directory tabs. You can also 
choose to have user-specific toolbars and function keys as defined in Directories 
preferences. E-mail preferences are, effectively, user-specific.  

Activity Preferences 
Activity preferences are user preferences that allow you to establish defaults for use of the 
Activity Manager. You can control the maximum number of activities that may be scheduled 
in a day, how often, for how long, on which days, where your activity files are stored, 
defaults when linking activities to contacts, and whether users must have scheduling rights 
to your calendar to include you in a group activity. 

When you attempt to schedule an activity which conflicts with these settings, a dialog box 
will appear to warn you of the conflict. This helps you to avoid over-booking, missing 
appointments, or accidentally scheduling a meeting on a weekend. If you wish, you can 
ignore and override these warnings. 

 Contact Preferences 
Contact preferences allow you to instruct TeleMagic to automatically open and display the 
database, contact views, and pages you most often use. 

 Hint: Pay particular attention to your Contact preferences when working with your 
template users. It is likely that different classes of users will need to see different 
views of TeleMagic by default. 

Dialer Setup 
Dialer preferences allow TeleMagic to properly auto-dial your phone. To use the Dialer 
efficiently, you should specify your area code and dialer prefix, and select the modem used 
to dial the phone. 

You can also specify how you want to handle notes about your call, the default call result, 
and whether you want TeleMagic to immediately dial the next contact after completing a call. 
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Directories Preferences 
You can store Function Key, List Boxes, and Toolbar Configuration settings in any one of 
three directories: a Global, a Database, or a User directory.  

? Changes made to settings stored in a Global Directory will affect all users in all 
databases.  

? Changes to settings stored in a Database Directory are valid for all users, but only 
in the current database. 

? Changes to settings stored in the User Directory will be valid for all databases, but 
only for the current user.  

Display Preferences 
Display preferences are user preferences that allow you to choose the display formats you 
wish to use for time and numbers. You can also specify how your cursor will move among 
fields during data entry. 

E-mail Options 
E-mail preferences are specific to TeleMagic Internet Mail. They are User Preferences in the 
sense that they are specific to individual users. To access E-mail preferences, open 
TeleMagic Internet Mail and select Tools, Options from the main menu. 

Fax Preferences 
Fax preferences allow you to set defaults for sending faxes. Although the default settings 
can be changed at the time a fax is actually sent, if you frequently use the same settings, 
establishing them in Preferences can save time and ensure accuracy. 

You will need to set your Fax preferences for faxes to be sent locally. Among other things, 
fax preferences allow you to have TeleMagic  configure and/or list any faxmodems in your 
system, give your faxmodem a “name”, indicate whether you want to use or ignore any 
locally installed faxmodem, and switch your faxmodem’s speaker on and off.  

Wireless Messaging Preferences 
Wireless Messaging preferences allow you to specify the settings for receiving and/or 
sending messages. For this, TeleMagic needs to know information concerning the modems 
and paging carriers in use by your users. 
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Note:  There are a number of precautions of which you should be aware before setting up 
Wireless Messaging.  Review the heading Before Setup in the Wireless Messaging Setup 
section of the Feature Setup chapter before proceeding. 

Writing Preferences 
These user preferences allow you to choose your word processor(s) and the location of all 
word processing files, and to control whether you want notepads stamped with a date, time, 
and file name during a mail merge.  

User Setup 
If a user is not a supervisor, the User preferences will only include that user in the list of 
installed users. The controls for adding and copying users will not be available. This will 
allow the user to change his or her own name or password, if necessary.  

Database Specific Preferences 
You can use database-specific preferences to establish key fields, name database levels, and 
establish certain display defaults for that database.  

Database-specific preferences must be established for each database. You must open each 
database in turn to establish their preferences. (Unlike User preferences, you do not need to 
repeat the setup for each User ID.) Options selected for database preferences affect the 
database currently open, no matter who logs in as a user.  

WARNING! Be sure that the database you have open is the one you want to change. 

By default, database-specific preferences include Database and Key Fields preferences. 
Some users may also use database-specific toolbars and function keys (as defined by users’ 
Directories preferences).  

 Hint: If some users will be using database-specific toolbars and function keys, set 
your own Directories settings for these options to Database and set up the 
toolbars and function keys for each database. You may then continue to use the 
database-specific setup, or change your Directories setting as necessary for 
your own User ID. 

Database Preferences 
Database preferences allow you to set default names for each contact database level, create 
a controlling level for your database, set the default currency symbol, and set up a standard 
contact address format. Also included are settings for locking a record when dialed, 
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Microsoft Outlook e-mail setup (covered in detail in on-line help), applying security in 
activity lists, calculating upper and lower levels on save, and saving merge documents. 

Database preferences will affect the current database only, and they will be in effect for all 
users of that database. Setting Database preferences for one database does not 
automatically set them for any other databases. You will need to open each database in turn 
and set the Database preferences. 

Key Field Preferences 
Every database level contains “key” fields, such as Company Name and Contact Name, 
which contain specific “key” information. TeleMagic uses the information in these fields 
when performing certain functions in the program, such as creating reports and sending 
faxes. For example, if you want to print a Contact List report, TeleMagic needs to know 
which fields in the database contain the contact name, company name, and address when it 
creates the report. 

Key Field preferences allow you to specify which Contact Manager fields will contain this 
key information. 

Key Field preferences will affect the current database only, and they will be in effect for all 
users of that database. Setting Key Field preferences for one database does not 
automatically set them for any other databases. You will need to open each database in turn 
and set up the Key Fields. 
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Global Preferences 
Global  preferences are used to specify authorized users, system and user IDs, user 
passwords, and the date formats in use in the entire installation. Global preferences are 
established once for the entire system—you do not need to log in as different users or open 
different databases to set them. Installation preferences are only available to those users 
with supervisor security access to TeleMagic and are normally set and controlled by the 
system administrator. Global Preferences only affect one installation; if you have more than 
one installation, each will have its own set of global preferences. 

By default, installation preferences include System, Users, Toolbar, and Function Key 
preferences. (Depending on each user’s Directories preferences, some users may use either 
user or database-specific function keys and toolbars.) 

 Hint: If users will be using a global, or system wide, toolbar or function keys, set your 
own Directories settings for these options to Global and set up the system 
toolbar and function keys. You can then continue to use the global setup, or 
change your Directories setting as necessary for your own User ID. 

Function Key Setup 
Note: Depending on your Directories preference settings, function keys may be stored in 
either your user directory, the database directories, or the global directory.  

Function key assignments allow you to automate common operations, so a single keystroke 
can perform functions such as setting a recall or faxing a specific document to a specific 
group of contacts. Many users will have regular tasks they want to make simpler; TeleMagic 
function keys can accomplish this. Function keys are set up using TeleMagic expressions, 
which allow a great range of activities. 

 Hint: TeleMagic comes with two sample function keys designed to stamp information 
in a contact’s notepad. You can use these function keys as is, or simply as 
examples when learning how to create your own  

Assigning function keys involves TeleMagic expressions, which can be very complex. 
Become familiar with expressions to harness the full power of function keys; experiment by 
assigning short expressions to a key and trying it out. If you gradually add more complex 
functions to keys, you are more likely to get the intended result. 
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System 
System preferences include information on TeleMagic’s System ID (used in database 
synchronization), default Wireless Messaging number, date display format, downtime, and 
Automation Server passwords. 

Toolbar Configuration 
The TeleMagic System and Contact Manager Toolbars are fully customizable. All menu 
commands have been allocated buttons that you can place on the System Toolbar in any 
order you want. You can also create an unlimited number of user-defined tools for the 
System Toolbar, linked either to external programs or to function key expressions. Feel free 
to experiment with this toolbar, since you can return to the default toolbar at any point. 

There are actually two Contact Manager Toolbars, a primary and a secondary. Twenty-six 
tools are available for assignment to the Contact Manager Toolbars. All of the toolbars are 
dockable, meaning you can place them wherever you like on the screen and adjust their 
dimensions as necessary. There are docking ports along each edge of the screen where the 
toolbars will snap into place if dropped nearby. 

Users 
User setup is used to add new users to TeleMagic and to edit existing ones. As a supervisor 
user, you can maintain the complete list of users in TeleMagic. (Non-supervisor users will 
only be able to change their own settings on the Users Preferences page.)
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Setting Preferences 
To Set or Change Preferences: 

1. From the Options menu, select Preferences . 

 The Preferences dialog box will appear, defaulting to the Activity page: 

 

Preferences Dialog Box (Activity Preferences) 

2. Click on the tab corresponding to the desired page. 

3. Press F1, or click the Help button, at each preference set to view details and 
instructions concerning the available options. 

4. When you have finished editing the selected preference set, click Apply or click on 
another tab. 

5. When finished with the Preferences screen, click OK to save the changes to the 
current preference set and exit the screen. 

or Click Apply to save all changes without closing the dialog box. 

or Click Cancel to cancel the changes to the current preference set and exit the dialog 
box. 

Note: Selecting Cancel will not affect preferences that have been applied on earlier 
pages. 



170 Preferences 

System Administrator Guide 

To Set or Change Preferences in TeleMagic Internet Mail 

1. Open TeleMagic Internet Mail. From the Tools menu, select Options. 

 The Preferences dialog box will open: 

 

TeleMagic Internet Mail Preferences 

2. Click on the tab corresponding to the desired page. 

3. Press F1 at each preference set to view details and instructions concerning the 
available options. 

4. When you have finished editing the selected preference set, click on another tab. 

5. When finished with the Preferences screen, click OK to save the changes to the 
current preference set and exit the screen. (Pressing ENTER at any time will also save 
the current preferences and exit the screen.) 

or Click Apply to save all changes without closing the dialog box. 

or Click Cancel to cancel the changes to the current preference set and exit the dialog 
box. 

Note: Selecting Cancel will not affect preferences that have been applied on earlier 
pages. 
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FEATURE SETUP 
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Feature Setup 
Many of the program features in TeleMagic require some setup before being used. It is a 
good idea to perform this setup as part of your installation process. This way, when users 
first open TeleMagic, it will be completely set up and ready for their use. 

Contact Manager Setup 
If you are using one of the databases provided by TeleMagic, most of the setup required for 
the Contact Manager has already been performed for you. If you are creating your own 
database, or wish to modify one of the existing ones, some preparation may be desired. 

The actual setup of your screens and fields is discussed in the Database Management and 
Screen Designer chapters of this guide. The Preferences chapter of this guide gives an 
overview of the configuration options available for the Contact Manager. In addition to 
these areas, you can add filters and indexes to your database to control how records are 
viewed. 

Note:  List boxes can be a beneficial part of your initial setup. In addition to allowing for 
quick data entry, list boxes allow you to control what can be entered into a field. 

Creating Indexes 
Indexes are used to control the order in which contact records appear in your database. 
Indexes are also used to tell TeleMagic what field(s) to use when performing a search for a 
particular record. Special indexes can be set up for use with duplicate record checking. 

When you create an index, you tell TeleMagic which field to use to re-order records 
alphanumerically, or by date. To create filters based on activity data, use the 
HASACTIVITY() function. To create indexes based on activity data, use the 
FIRSTACTIVITY(), LASTACTIVITY(), or NEXTACTIVITY() functions. 

You can use multiple fields for indexes. For example, you could sort all records first by 
country, and then within countries by region. Then, you might group all of the records 
within a region by state. Or, you can choose to sort all records by account representative, 
then by order amount. 

Note:  Having many indexes can increase the time it takes to perform rebuilds and update 
records. Plan your indexes carefully and create only those indexes you need. 
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To Create a New Index: 

1. From the Contact Manager menu, select Contact Utilities , Edit Indexes . 

The Indexes selection box will open. It will list all existing indexes: 

 

Documentation Database Indexes Selection Box 

2. Click Add. 

The Select a Level to Index dialog box will open: 

 

Documentation Database Select a Level to Index Dialog Box 

Note:  This dialog box will reflect the names of the database levels in the current 
database. The current level will be highlighted. 

3. Choose the level you wish to sort. 

 Example:  Level 3 (Sales Contract). 
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 The Add Index dialog box will open: 

 

Add Index Dialog Box 

4. In the Index Name field, give the index a unique name. 

 Example:  Contract Implementation Date. 

5. If you would like to create a filtered index, select from those included on the Index 
Filter list. See the on-line help topic Filtered Indexes for more information on filtered 
indexes. 

6. Click Edit. 

 The Index Expression dialog box will open: 
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Index Expression Dialog Box 

7. From the Fields list, select the field by which you wish to sort. 

 The field name will appear in the expression box followed by a default + sign. 

8. Click OK.  

The Index Expression dialog box will close. 

If you have selected a character field, the Case Sensitive checkbox will become 
available. If you have not selected a character field, continue to step 10. 

9. If you would like your index to recognize upper-case and lower-case characters, mark 
the Case Sensitive checkbox. If this is marked, the index will place all of the records 
with an upper-case character at the start of the index field at the top of the index, 
followed by all of the records with lower-case characters at the start of the index field. 
(e.g., A - Z, a - z.) This is useful if you want to do further sorting by case. A case 
sensitive check will also be applied when you are searching for a record based on the 
data in the index field. If you wish records to be sorted alphabetically, regardless of 
case (e.g., Aa - Zz), unmark the Case Sensitive checkbox. 

Note:  If you do not choose Case Sensitive, an UPPER() statement will be 
automatically added to your expression. This statement is used to instruct TeleMagic 
to not pay attention to case by viewing everything in a character field as uppercase. 
This statement can only be removed from the expression by marking Case Sensitive. 

10. Mark Check Duplicate if you would like the field on which the index is based to be 
used in duplicate record checking. As you add contact records, you may want 
TeleMagic to check to make sure that the records are unique. For example, you may 
add a Level 2 contact record without realizing that that same contact already has a 
record under a different Level 1 parent. With duplicate record checking, you can 
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instruct TeleMagic to check for duplicate data when you enter text in the index field 
and warn you if a match is found. 

 Hint: Consider including the field name in the index name. The check is performed 
when the record is saved and, if a duplicate is found, the name of the index that 
found the duplicate is reported.  

11. Mark Multiple Index Search if you would like this index to be included when 
performing a search across multiple indexes. When searching for a contact record, all 
indexes with this option marked will be used. 

12. Mark Maintain Position if you would like to retain your position in the index when 
data in the index field changes. For example, if you were indexing on the State field 
and changed a record’s state field from CA to NY, when you scrolled to the next 
record with Maintain Position marked, you would move to the next record in 
California. If Maintain Position is not marked, TeleMagic will see NY in the field and 
move you to the next record in New York. 

Note: In Contact Manager, when you select a filter for a large database, then switch to 
upper or lower level, you may experience a major slow down if your active index has 
the Maintain Position checkbox selected. Either don't check the box or make sure that 
other index hasn’t. 

13. Mark Don’t display this index in the Contact Manager if you do not want this 
index displayed in the lists of indexes in the Contact Manager, Custom Reports, and 
Quick List. The index will still be available elsewhere in the application. 

14. Select the Ascending or Descending radio button. 

Note:  Ascending means from A to Z, 0 to 9, or oldest to most recent. Descending 
means from Z to A, 9 to 0, or most recent to oldest. 

In the Contact Manager, you have the option on Levels 2 and 3 to only view records 
associated with the current parent record. In order to show you only these records, 
TeleMagic creates an automatic index on the records’ Contact IDs (which include 
information about the parent record). In order to be used when this option is selected, 
an index must begin with the portion of the Contact ID relevant to the selected level. If 
you have selected a character, unique number, phone, or memo field as your index 
expression, the Use this index with the Contact Manager’s “See Only” option 
checkbox will become available. When selected, this checkbox will place the 
appropriate Contact ID information into the index. This option is not available on 
numeric or date fields. 

15. If you would like to be able to use this index when the See Only option is active in the 
Contact Manager, mark this checkbox. 

or If you would like this index to be available when the See Only option is not in use, 
leave this checkbox unmarked. 
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Note:  Indexes that have been selected for use with See Only will not appear on the 
list of indexes in the Contact Manager when this feature is not in use. Indexes that 
have not been selected for use with this feature will not be available when See Only is 
in use. 

16. Click OK. 

Note:  Before your new index will appear on the Index list, you must rebuild it. If you 
are creating more than one index, create all your indexes first, then rebuild. To build 
the indexes now, click Build Indexes. 

17. Click Close. 

 The Index selection box will close. If you have not performed a build on your new 
indexes, the Index Rebuild warning notice will appear. Click Yes  to proceed with the 
rebuild. If you choose not to rebuild now, you will be able to do so later. 

To Create a Multiple-Field Index with all Fields of the Same Type: 

1. From the Contact Manager menu, select Contact Utilities , Edit Indexes . 

 The Indexes selection box will open. It will list all existing indexes. 

2. Click Add. 

 The Select a Level to Index dialog box will open. 

Note:  This dialog box will reflect the names of the database levels in the current 
database. The current level will be highlighted. 

3. Choose the level you wish to sort. 

 The Add Index dialog box will open. 

4. In the Index Name field, give the index a unique name. 

5. If you would like to create a filtered index, select the filter from the Index Filter list. 

6. Click Edit. 

 The Index Expression dialog box will open. 

7. From the Fields list, select the first field on which you wish to index (sort). 

 Example:  Country. 

8. From the Fields list, select the second field on which you wish to index (sort). 

 Example:  Region. 

Note:  The order of the fields in the expression is important. When the index is used, 
the records will be sorted on the first field, then sub-sorted on each subsequent field. 
(For example, if you select the County field, records will be grouped and alphabetized 
by the contents of the County field. If your next field is Region, records in the same 
county will be further sorted by region, and so on. If two records are in the same 
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region, they will only be next to each other in the index if they are als o in the same 
county.) 

9. Repeat step 8, as necessary. 

Note:  Every field selected must be the same field type; i.e., you cannot select a 
mixture of character and date fields, or date and numeric fields, etc. If you are using 
numeric fields, you must convert the numeric field to a character field in the 
expression. If you do not, instead of sub-sorting on the second field, the index will 
add the fields together and sort on the total. To convert a numeric field to a character 
field, use the str() function. 

 Your completed index expression will look similar to the following: 
contact1.country+contact1.region+contact1.state  

10. Click OK. 

Note:  If you receive an “Expression Invalid: Operator/operand type mismatch” error 
message, you have fields of multiple types in your expression. 

 The Index Expression dialog box will close. The sort index field selections will appear 
in the Indexes dialog box. 

11. If you would like your index to recognize upper-case and lower-case characters, mark 
the Case Sensitive checkbox. If this is marked, the index will place all of the records 
with an upper-case character at the start of the index field at the top of the index, 
followed by all of the records with lower-case characters at the start of the index field. 
(e.g., A - Z, a - z.)  

Note:  If you do not choose Case Sensitive, an UPPER() statement will be 
automatically added to your expression. This statement is used to instruct TeleMagic 
to not pay attention to case by viewing everything in a character field as uppercase. 
This statement can only be removed from the expression by marking Case Sensitive. 

12. Mark Check Duplicate if you would like the field on which the index is based to be 
used in duplicate record checking. This is only used for the first field selected in the 
index. 

13. Mark Multiple Index Search if you would like this index to be included when 
performing a search across multiple indexes. When searching for a record, all indexes 
with this option marked will be used. 

14. Mark Maintain Position if you would like to retain your position in the index when 
data in the index field changes. For example, if a record’s state is changed from 
California to Oregon, with Maintain Position marked, when you scroll to the next 
record, you will be at the next record in California. Without this option marked, you 
will be at the next record in Oregon, as determined by the data currently existing in the 
field. 

15. Select the Ascending or Descending radio button. 
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Note:  Ascending means from A to Z, 0 to 9, or oldest to most recent. Descending 
means from Z to A, 9 to 0, or most recent to oldest. 

In the Contact Manager, you have the option on Levels 2 and 3 to only view records 
associated with the current parent record. In order to show you only these records, 
TeleMagic creates an automatic index on the records’ Contact IDs (which include 
information about the parent record). In order to be used when this option is selected, 
an index must begin with the portion of the Contact ID relevant to the selected level. If 
you have selected a character, unique number, phone, or memo field as your index 
expression, the Use this index with the Contact Manager’s “See Only” option 
checkbox will become available. When selected, this checkbox will place the 
appropriate Contact ID information into the index. 

16. If you would like to be able to use this index when the See Only option is active in the 
Contact Manager, mark this checkbox. 

or If you would like this index to be available when the See Only option is not in use, 
leave this checkbox unmarked. 

Note:  Indexes that have been selected for use with See Only will not appear on the 
list of indexes in the Contact Manager when this feature is not in use. Indexes that 
have not been selected for use with this feature will not be available when See Only is 
in use. 

17. Click OK. 

Note:  Before your new index will appear on the Active Indexes list, you must rebuild 
it. If you are creating more than one index, create all your indexes first, then rebuild. 
To build the indexes now, click Build Indexes. 

18. Click Close. 

 The Index selection box will close. If you have not performed a build on your new 
indexes, the Index Rebuild warning notice will appear. Click Yes  to proceed with the 
rebuild. If you choose not to rebuild now, you will be able to do so later. 

?  To Create a Multiple-Field Index with Fields of Different Types:  

1. From the Contact Manager menu, select Contact Utilities , Edit Indexes . 

 The Indexes selection box will open. It will list all existing indexes. 

2. Click Add. 

 The Select a Level to Index dialog box will open. 

Note:  This dialog box will reflect the names of the database levels in the current 
database. The current level will be highlighted. 

3. Choose the level you want to sort. 



180 Preferences 

System Administrator Guide 

 The Add Index dialog box will open. 

4. In the Index Name field, give the index a unique name. 

5. If you would like to create a filtered index, select the filter from the Index Filter list.  

6. Click Edit…. 

 The Index Expression dialog box will open. 

 To use fields of multiple types, you must create an expression that converts all field 
types to a character type.  

7. Use the following guidelines when selecting fields: 

?   To use a character field, select the field from the Fields list. 

?   To use a numeric field, place your cursor in the Create any type of expression 
text area and type: str() (or select it from the String drop-down list). Place the cursor 
inside the parentheses. From the Fields list, select the field name. A plus sign (+) 
will be automatically added to the end of the field name inside the parentheses. 
Delete the plus sign, then type a comma, the field length, a comma, and the number 
of decimal places. If you will be using any additional fields, place your cursor 
outside the parentheses and add a plus sign. 

 Example:  str(contact3.amtorder,10,2) + 

 Hint: Use ltrim() with the expression to trim any leading spaces in the field. 
Example:  ltrim(str(contact3.amtorder,10,2)) + 

Note:  If you do not know the field length or number of decimal places, omit them. The 
index will sort to the largest whole number. 

 

Note:  Converting a numeric field to a character may affect the way the data is sorted. 
When sorting numbers in character fields, TeleMagic evaluates the value of each digit 
from left to right, not the actual value of the number. For example when sorting 1 
through 11 as characters, TeleMagic will arrange them 1, 10, 11, 2, 3, etc. Numeric 
fields that are not converted to character will correctly sort in numeric order. 

?  To use a date field, type: dtoc() or select dtoc() from the Date drop down list under 
Functions. Place the cursor inside the parentheses. From the Fields list, select the 
field name. A plus sign (+) will be automatically added to the end of the field name. 
Delete the plus sign within the parentheses. If you will be using any additional 
fields, place your cursor outside the parentheses and add a plus sign. 

 Example:  dtoc(contract3.condate) + 

Note:  dtoc() translates your date into a character, so TeleMagic would read 11/13/98 
as 111398. Because of this, if you have dates spanning multiple years, they may not 
be sorted correctly. (For example, 08/17/99 would come before 11/13/98 in ascending 
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order, even though the date is later, because the number 081799 is smaller than 
111398.) If you need to keep the dates in order by year, consider using dtos(), which 
sorts first by year, then by month, and finally by date. If you do use dtos(), you 
should alert users to match the year/month/day format when using Goto to search for 
records based on this index. 

 Your completed index expression will look similar to the following: 
contact2.acctrep+str(contact3.amtorder,10,2)+dtoc(contact3.condate) 

8. Click OK. 

 The Index Expression dialog box will close. The expression will appear in the Indexes 
dialog box. 

9. For your index to recognize upper-case and lower-case characters, mark the Case 
Sensitive checkbox. If this is marked, the index will place all of the records with an 
upper-case character at the start of the index field at the top of the index, followed by 
all of the records with lower-case characters at the start of the index field. (e.g., A - Z, 
a - z.)  

Note:  If you do not choose Case Sensitive, an UPPER() statement will be 
automatically added to your expression. This statement is used to instruct TeleMagic 
to not consider case by viewing everything in a character field as uppercase. This 
statement can only be removed from the expression by marking Case Sensitive. 

10. Mark Check Duplicate for the field on which the index is based to be used in 
duplicate record checking. This will only check the first field selected in the index. 

11. Mark Multiple Index Search for this index to be included when performing a search 
across multiple indexes. When searching for a record, all indexes with this option 
marked will be used. 

12. Mark Maintain Position to retain your position in the index when data in the index 
field changes. For example, if a record’s state changes from California to Oregon, with 
Maintain Position marked, when you scroll to the next record, you will be at the next 
record in California. Without this option marked, you will be at the next record in 
Oregon, as determined by the data currently existing in the field. 

Note: In Contact Manager, when you select a filter for a large database, then switch to 
upper or lower level, you may experience a major slow down if your active index has 
the Maintain Position checkbox selected. Either don't check the box or make sure that 
other index hasn’t. 

13. Select the Ascending or Descending radio button. 

Note:  Ascending means from A to Z, 0 to 9, or oldest to newest. Descending means 
from Z to A, 9 to 0, or newest to oldest. 
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In the Contact Manager, you have the option on Levels 2 and 3 to only view records 
associated with the current parent record. In order to show you only these records, 
TeleMagic creates an automatic index on the records’ Contact IDs (which include 
information about the parent record). In order to be used when this option is selected, 
an index must begin with the portion of the Contact ID relevant to the selected level. If 
you have selected a character, unique number, phone, or memo field as your index 
expression, the Use this index with the Contact Manager’s “See Only” option 
checkbox will become available. When selected, this checkbox will place the 
appropriate Contact ID information into the index. 

14. To use this index only when the See Only option is active in the Contact Manager, 
mark this checkbox. 

or For this index to be available when the See Only option is not in use, leave this 
checkbox unmarked. 

Note:  Indexes that have been selected for use with See Only will not appear on the 
list of indexes in the Contact Manager when this feature is not in use. Indexes that 
have not been selected for use with this feature will not be available when See Only is 
in use. 

15. Click OK. 

Note:  Before your new index will appear on the Active Indexes list, you must rebuild 
it. If you are creating more than one index, create all your indexes first, then rebuild. 
To build the indexes now, click Build Indexes. 

16. Click Close. 

 The Index selection box will close. If you have not performed a build on your new 
indexes, the Index Rebuild warning notice will appear. Click Yes  to proceed with the 
rebuild. If you choose not to rebuild now, you will be able to do so later. 
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?  To Create an Advanced Index: 

1. From the Contact Manager menu, select Contact Utilities , Edit Indexes . 

 The Indexes selection box will open. It will list all existing indexes. 

2. Click Add. 

 The Select a Level to Index dialog box will open. 

Note:  This dialog box will reflect the names of the database levels in the current 
database. The current level will be highlighted. 

3. Choose the level you want to sort. 

 The Add Index dialog box will open. 

4. In the Index Name field, give the index a unique name. 

5. If you would like to create a filtered index, select the filter from the Index Filter list.  

6. Click Edit…. 

 The Index Expression dialog box will open. 

7. Create an expression. When creating an expression, the following points apply: 

??The index will sort on the evaluated value of the expression. For example, if you 
select a field, the evaluated value of the expression is the contents of the field. If 
you perform a mathematical equation, the evaluated value will be the total of the 
equation. 

?  If you are creating an expression that uses a combination of field types, remember 
that you must convert date and numeric fields to a character string. 

??To perform a mathematical equation based on one or more numeric fields in 
combination with a character field, place the entire equation inside the str() 
function. (For example, str(contact2.budget + contact2.terms) would add the 
contents of the Budget and Terms fields, then convert the total to a character.) 

??Use the FIRSTACTIVITY(), NEXTACTIVITY(), and LASTACTIVITY() functions to 
create indexes based on Activity Manager information. For example, to sort on level 
2 by recall date, use NextActivity(1,”Call”). 

8. When satisfied with your expression, click OK. 

 If your expression is valid, you will be returned to the Indexes dialog box. (If your 
expression is not valid, you will be given a warning. Correct the expression and click 
OK.) 
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9. For your index to recognize upper-case and lower-case characters, mark the Case 
Sensitive checkbox. If this is marked, the index will place all of the records with an 
upper-case character at the start of the index field at the top of the index, followed by 
all of the records with lower-case characters at the start of the index field. (e.g., A - Z, 
a - z.)  

Note:  If you do not choose Case Sensitive, an UPPER() statement will be 
automatically added to your expression. This statement is used to instruct TeleMagic 
to not pay attention to case by viewing everything in a character field as uppercase. 
This statement can only be removed from the expression by marking Case Sensitive. 

10. Mark Check Duplicate for the field on which the index is based to be used in 
duplicate record checking. The result of this check is based on the first field in the 
index. This option is not applicable in all cases. 

11. Mark Multiple Index Search for this index to be included when performing a search 
across multiple indexes. When searching for a record, all indexes with this option 
marked will be used. 

12. Mark Maintain Position to retain your position in the index when data in the index 
field changes. For example, if a record’s state changes from California to Oregon, with 
Maintain Position marked, when you scroll to the next record, you will be at the next 
record in California. Without this option marked, you will be at the next record in 
Oregon, as determined by the data currently existing in the field. 

Note: In Contact Manager, when you select a filter for a large database, then switch to 
upper or lower level, you may experience a major slow down if your active index has 
the Maintain Position checkbox selected. Either don't check the box or make sure that 
other index hasn’t. 

13. Select the Ascending or Descending radio button. 

Note:  Ascending means from A to Z, 0 to 9, or oldest to most recent. Descending 
means from Z to A, 9 to 0, or most recent to oldest. 

In the Contact Manager, you have the option on Levels 2 and 3 to only view records 
associated with the current parent record. In order to show you only these records, 
TeleMagic creates an automatic index on the records’ Contact IDs (which include 
information about the parent record). In order to be used when this option is selected, 
an index must begin with the portion of the Contact ID relevant to the selected level. If 
you have selected a character, unique number, phone, or memo field as your index 
expression, the Use this index with the Contact Manager’s “See Only” option 
checkbox will become available. When selected, this checkbox will place the 
appropriate Contact ID information into the index. 
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14. To be able to use this index only when the See Only option is active in the Contact 
Manager, mark this checkbox. 

or For this index to be available when the See Only option is not in use, leave this 
checkbox unmarked. 

Note:  Indexes that have been selected for use with See Only will not appear on the 
list of indexes in the Contact Manager when this feature is not in use. Indexes that 
have not been selected for use with this feature will not be available when See Only is 
in use. 

15. Click OK. 

Note:  Before your new index will appear on the Active Indexes list, you must rebuild 
it. If you are creating more than one index, create all your indexes first, then rebuild. 
To build the indexes now, click Build Indexes. 

16. Click Close. 

 The Index selection box will close. If you have not performed a build on your new 
indexes, the Index Rebuild warning notice will appear. Click Yes  to proceed with the 
rebuild. If you choose not to rebuild now, you will be able to do so later. 

Rebuilding Indexes 
If you have made any changes to your indexes, they must be rebuilt before they can be used. 

Note:  Rebuilding indexes that have not been changed is a function of Rebuild. 

To Rebuild Indexes: 

Note:  All users must be out of the database when you rebuild indexes. 

1. If you have made any changes to your indexes, click Build Indexes. 

The Rebuild dialog box will open. 

Note:  If you have not changed any indexes, you will only be able to perform a rebuild 
from the Rebuild dialog box. A message will appear informing you if this is the case. 

2. Click Yes . The Rebuild status report will display the progress of the rebuild, and close 
when the rebuild is finished. 
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Creating Filters 
When you create a filter, you tell TeleMagic which field or fields to use to select records 
containing specific information. For example, you might want to use records for contacts 
from the state of California. The field you would use to find these records is “State”. The 
information you would want TeleMagic to search for in that field is “California”. 

Note:  You can select records using fields from any level. 

In the following example, you will create a filter for the Documentation database which picks 
out records for sales contracts that have closed, but have not been delivered or 
implemented. It will ignore records in any other sales stage (such as bid invitation received, 
proposal submitted, product shipped, or order implemented). 

To Create a Filter:  

1. From the Contact Manager menu, select Contact Utilities , Edit Filters . 

 The Filters selection box will open. It will list all existing filters: 

 

Documentation Database Filters Selection Box 

2. Click Add. 
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 The Filters dialog box will open: 

 

Filters Dialog Box 

3. In the Filter Name: text box, give the filter a unique name. 

 Example:  Closed Sales Contracts. 

4. Mark Don’t display this filter in the Contact Manager if you do not want this filter 
displayed in the lists of filters in the Contact Manager, Custom Reports, and Quick 
List. The filter will still be available elsewhere in the application. 

5. Mark Optimize Filter by pre-selecting records to enable Rushmore technology and 
improve the speed of your filter. There are other methods to optimize your filter further 
which are discussed later in the chapter. 

6. Click Edit. 

 The Filter Expression dialog box will open: 

 

Sample Filter Expression Dialog Box 

7. From the Field drop-down list, select the field you wish to use to select records. 

 Example:  Sales Stage: {Contact3.Stage} 
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Note:  This list will include all fields in the database, regardless of their level.  

8. From the Compares drop-down list, pick the appropriate comparison. 

 Example:  Equal 

9. In the To text box, type the information you will use to select records and press 
ENTER. 

Example:  CLOSED 

 In addition to being able to filter on the actual text appearing in the field, you can use 
the following conditions: 

? .EMPTY  Used to find fields containing no data. 

? .TODAY  Used with date fields to locate records containing today’s date. 

? .TAGGED  Used to include tagged records in the filter.  

Note:  If you only want to filter on tagged records, you can select the Tagged 
Records filter. The .TAGGED condition would be used if you are creating a multiple 
comparison filter that includes a specific group of records, plus any tagged records. 
(e.g., Records with CA in the State field and all tagged records.) 

 Using the above example, you have completed a filter that will look for “Closed” in the 
Sales Stage field. You could immediately save this filter by moving on to step 11. 
However, if you need to add more limits to your filter, or expand your filter, you may 
do so now. For example, you could expand your filter so that it finds all Closed 
records, as well as all records with a budget of over $100,000; or you could limit it so 
that it finds only closed sales with a warranty. 

10. In the And/Or field, choose: 

? And if you would like to require that both lines of the filter be true for a record to be 
included in the filter. For example, if you wanted only records that are closed with a 
warranty, you would use And. 

?  Or if either line of the filter can be true for the record to be included in the filter. For 
example, if you would like to include records that are closed, or those with a budget 
of over $100,000 you would use Or. 

 Hint: When deciding to use And or Or in a filter, think carefully about what 
you would like to have the filter do. For example, you may want a filter to 
find all companies located in California and Arizona. You would need to 
use Or in this filter to tell TeleMagic to show you records in either 
California or Arizona. If you used And in this instance, a company would 
have to be located in both California and Arizona. 

11. Repeat steps 6 through 9 for the next line of the filter. You can have up to 10 lines in a 
filter. 
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Note:  If you are using more than two filter criterion separated by a mixture of And and 
Or, it is recommended you create an advanced filter to improve your control over the 
grouping of the filter items. 

 The completed filter expression will look similar to this: 

 

Sample Completed Filter Expression Dialog Box  

11. Click OK. 

 The Filter Expression dialog box will close. You will be returned to the Filters selection 
box. 

12. Click Close. 

 The Filter selection box will close. The new filter will appear in the Filter: list on the 
Contact Toolbar. 

?  To Create an Advanced Filter: 

1. From the Contact Manager menu, select Contact Utilities , Edit Filters . 

 The Filters selection box will open. It will list all existing filters. 

2. Click Add. 

 The Filters dialog box will open. 

3. In the Filter Name: text box, type a name for the filter. 

 Example:  Assigned to Current User 

4. Click Edit. 
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 The Filter Expression dialog box will open. 

5. Click Advanced. 

 You will receive a warning that, once made into an advanced filter, it will always be an 
advanced filter. Acknowledge the warning to proceed.  

 The Expression Builder will open: 

 

Expression Builder Dialog Box 

6. Create an expression following the guidelines found in Appendix A of this guide. 
Records will be filtered by the evaluated value of the expression. (i.e., If you select a 
field, the evaluated value will be the data contained in the field; if you perform a 
mathematical calculation, the evaluated value will be the total of the calculation, etc.) 

Note: When using expressions in filters, the result of the evaluation should always be 
yes or no. 

7. When satisfied with your expression, click OK. 

Note:  TeleMagic will evaluate the expression to make sure it is valid. If this is not a 
valid expression, you will be given a warning. Correct the expression and click OK. 

The new filter will appear highlighted in the Filter selection box. 

8. Click Close. 
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Optimizing Filters 
Microsoft Visual FoxPro databases provide a technology to optimize filters called 
Rushmore technology. In the prior versions of TeleMagic Enterprise, we evaluated each 
record one at a time against the filter instead of using Rushmore. This allowed our users to 
escape out of the search process at any time. Starting with V5, a new option will allow 
users to stay with the previous implementation or select the option for better optimization 
of their filters. There are benefits and disadvantages to both: while Rushmore allows for 
little or no delay going through records, there is a noticeable delay as it first optimizes 
your filter and you cannot escape out of the process. The old system takes longer to go 
through the records, but you can stop the search process at any time.  

To Optimize Filters: 

1. Choose a filter to add or change as described above in To Create a Filter.  

2. Mark the Optimize filter by pre-selecting records checkbox to enable Rushmore 
technology on filters. 

3. Click OK. 

?  To Further Optimize Filters: 

Note: The security expressions in TeleMagic are added to the filter expressions. Be 
sure to add these expressions to the front of your indexes to see an improvement in 
the performance of your filter. 

 To fully optimize your filter, create an index that matches your filter expression from 
left to right. You will get partial optimization if your filter matches your index 
expression from left to right, but contains additional logic. 

 For full optimization, keep your filter on one level and do not use fields from multiple 
levels. Keep in mind that if the condition has to be set on more than one level and the 
filter is used very often, you can always create calculated fields and use those fields. 

Note: Filtering using a memo  field, or activity fields, will lead to minimal optimization of 
your filter.  

Activity Manager Setup 
The Activity Manager requires only minimal setup. For the most part, you can simply access 
your calendar and begin to use it. TeleMagic does provide Activity Preferences in case you 
would like to configure any areas of the Activity Manager to your specifications. Some 
setup is required to create the list of resources and holidays. 



192 Preferences 

System Administrator Guide 

 Note:  If users want other users to be able to assign them activities, they must establish their 
Activity Manager User Permissions. Each user should insure that the appropriate 
permissions to his or her calendar are established. 

Resource Management 
In an environment where many people are sharing office resources, you may need to 
schedule use of the resources that are most frequently in demand. This will prevent conflicts 
with several users trying to access the same equipment or space at the same time. Resource 
Management allows users to create an activity that will reserve a resource for the duration of 
the activity. Before creating an activity that reserves a resource, you need to establish a list 
of resources. 

To Establish a List of Resources: 

1. From the Options menu, select Maintenance, Resources . 

 The Resource Maintenance selection box will open: 

 

Sample Resource Maintenance Selection Box 

2. Click Add. 
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 The Add Resource dialog box will open: 

 

Add Resource Dialog Box 

3. Enter a descriptive name for the resource in the Resource: field. 

4. In the Hours Available: area, enter the time span during which the resource is 
available in the From: and To: fields, or click the Time Picker icons and select the 
available times. 

Note: The From: and To: fields will not be available if the Always Available checkbox 
is marked. 

or If your resource can be accessed 24 hours a day on the selected days, check the 
Always Available box. 

5. In the Days Available: area, mark the days on which the resource can be used. For 
example, unmark the check boxes corresponding to your established weekend days. 

6. When satisfied with your selections, click OK. 

or To close this dialog box without saving the resource, click Cancel. 

7. Repeat steps 2 through 6 for each resource you would like to add.  

Holiday Maintenance 
Holiday Maintenance is used to note holidays and other special occasions on your Activity 
Manager schedule. Holiday Maintenance is limited to supervisor users. 

To Set Up a List of Holidays: 

1. From the Options menu, select Maintenance, Holidays. 

 The Holiday Maintenance selection box will open: 
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Sample Holiday Maintenance Selection Box 

2. To add a new holiday to the list, click Add. 

 The Add Holidays dialog box will open: 

 

Add Holidays Dialog Box 

3. Enter the date of the holiday in the Date: field. 

or Use the date picker icon to select a date from a Go To Date dialog box. 

4. Enter a description of the holiday in the Description: field. 

5. If you would like to receive a warning when attempting to schedule an activity on this 
holiday, select the Warn when scheduling on this holiday radio button.  

or If it does not matter if activities are scheduled on this date, select the Allow 
scheduling on this holiday radio button. 
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6. If this holiday occurs on the same date annually, mark the Recurring Annually 
checkbox. Select the number of years you would like this holiday to repeat using the 
years list. 

7. Click OK to save this holiday. 

 You will be returned to the Holiday Maintenance selection box. 

8. Repeat steps 2 through 7 for each holiday you would like to set up. 

9. When satisfied with the list of holidays, click Close to exit. 

Creating User Groups 
Note:  User groups should be set up after you have added all necessary users to TeleMagic. 
If users are added later, make sure you place them into the appropriate groups. 

User groups are used throughout the program to perform functions for a pre-established 
group of users simultaneously. For example, when sending e-mail you may want to address 
the message to a specific department or group of individuals rather than a single user; or you 
may want to print a report on an entire group of users. The User Group option allows you to 
set up groups that can be accessed in other areas of the program. 

Typically, a company will have a group for its Sales team, Administration team, Personnel 
team, etc. You can also create a group of users with common interests, such as a group of 
employees who are working on a specific project, but who work in different departments 
within the company. All of the Managers in the company could also comprise a group. User 
groups are flexible, and can be used for any number of purposes. A user can be in several 
different groups at one time. 

Note:  Do not confuse the user groups you create with security groups. Defining users in a 
user group will not have any effect on their security access within  TeleMagic. 

To Add a User Group: 

1. From the Options menu, select User Groups . 

 The User Groups selection box will open: 
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User Groups Selection Box 

2. Click Add. 

3. Enter a unique name for the group in the User Group: field. 

4. Click Save . 

 All users available will appear in the Users not in group list. 

5. Highlight each name and click Add. To select them all at once, click Add all. Each name 
selected will appear in the Users in group: field. (If you make a selection in error, 
highlight the user in the Users in group: list and click Remove . The user will return to 
the Users not in group: list.) 

Note:  You can select the same users for more than one user group. 

6. When you are satisfied with the list of users, click Close. 

 The new user group will now be available for use in all applicable areas. 

Spell Checker Setup 
The Spell Checker comes with customization features that allow you to control how it works. 
You can choose to ignore uppercase words and/or words containing numbers. You can use 
the Auto-Suggest feature, and you can choose to recheck words which you have replaced 
manually. Users can add words to the dictionary as required. Added words are user-specific, 
so every user can have a unique spelling dictionary. 

Spell Checker Preferences 
Spell checker preferences are user specific settings that allow each user to customize how 
the spell checker behaves. 
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To Set Spell Checker Preferences: 

1. From the Options menu, select Maintenance, Spell Checker Preferences . 

 The Spell Checker Preferences dialog box will appear: 

 

Sample Spell Checker Preferences Dialog Box 

2. Mark Ignore Uppercase words to skip any words that are entirely in uppercase. 

3. Mark Ignore words containing numbers to skip any words which contain one or 
more numbers. 

4. Mark Auto-suggest to have the spell checker offer a list of alternative spelling 
suggestions for questionable words. 

 Hint: There is a slight trade-off in system performance with Auto-suggest 
selected, as TeleMagic must generate a list of possible spellings for every 
questionable word. On most machines, the time it takes to generate the 
list is negligible. On slower machines, there may be a very slight pause 
while the list is generated. If you are working on a slower machine, 
consider unmarking Auto-suggest, and using the Suggest button on the 
main Spell Checking screen when necessary. 

5. Mark Recheck replaced words to spell check any words you replace while running 
the Spell Checker. 

6. When satisfied with your preference settings, click OK. 

When you use the Spell Checker, you will have the opportunity to add new words to the 
dictionary. These additions are user-specific: they will not be available to any other users. 
You can add changes as part of the spell-checking process, or you can add them using Spell 
Checker Dictionary Maintenance. 

To Maintain the Spell Checker Dictionary:  

1. From the Options menu, open the Maintenance submenu. 

2. Select Spell Checker Dictionary. 
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 The Spell Checker Dictionary dialog box will open. 

3. To add a new word, click Add. 

 The Edit Dictionary dialog box will open. 

4. Enter the new word in the field. 

5. Click OK. 

 The Edit Dictionary dialog box will close. The new word will appear on the list of 
words displayed on the Spell Checker Dictionary dialog box. 

6. Repeat steps 3 through 5 for each word to be added. 

7. To edit an existing word, highlight it on the list and click Edit. 

 The Edit Dictionary dialog box will open. 

8. Correct the spelling of the word in the field. 

9. Click OK. 

 The edited word will replace the original spelling on the list. 

10. Repeat steps 7 through 9 for each word to be edited. 

11. To remove a word from the dictionary, highlight it on the list and click Remove . 

 A confirmation message will appear. 

12. Click Yes . 

 The word will be removed from the list. 

13. Repeat steps 11 and 12 for each word to be removed from the list. 

14. Click Close when finished maintaining the dictionary. 

Dialer Setup 
 Hint: Even if you are not using a modem to dial the phone from TeleMagic, you can 

still use the dialer feature to track your calls and call notes. 

TeleMagic can automatically dial contacts through your telephone using a modem or serial 
dialing device. It requires you to set up the program, and Windows, to “talk” to your 
telephone or telephone system. The program will then dial your telephone so you do not 
have to. 

If you are sharing a single line voice telephone line with a modem installed in your own 
computer, it is very simple to set up a quick way to phone your customers, clients and 
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contacts. You can have the computer dial the phone; once a connection is established, you 
pick up the handset and start your conversation. 

Most of Dialer setup is handled from the Configuration Options screen. To perform actual 
setup, refer to the Dialer Preferences topic in on-line help. This will give detailed information 
on every option on the Dialer Configuration Options screen. Before proceeding with Dialer 
setup, however, you need to be aware of the following special situations and how to deal 
with them: 

WARNING!  If you are setting up a new modem for your computer, and you have a 
sophisticated telephone system—check with an expert before plugging your modem into a 
telephone socket. If you plug it into the wrong place, you could damage your computer, your 
new modem, your telephone, your telephone system or even your computer network. Even 
though a plug may look right, it may be the wrong kind. 

? If you are setting up a shared copy of TeleMagic for use by multiple users, all of whom 
will use the same dialing scheme, set all the TeleMagic options for the Dialers before 
installing each individual user account. Then, use a “master template user” scheme to 
create users by copying them from a master template. The same Dialer preferences will 
be copied to all users. (See the heading Step 7: Add Users to TeleMagic  in the Multi-
User Installation section of the Installation chapter.)   

? If you are using a serial dialer device (other than a modem), or a special interface for PBX 
or Centrex telephones, the procedure may be more complex. We suggest that you 
contact your telecommunications support personnel for guidance on this matter.  

? If your telephone system requires an accounting code to be entered after a long 
distance number is dialed, you may have to dial this code manually. (It is possible that 
you can have it as a dialer suffix; contact your telecommunications professional for more 
information.) 

? Ensure that your modem is configured for the correct speed before attempting to use or 
install it. These parameters are changed in the Device Manager tab under System 
Properties in the Control Panel in Windows 95, and are documented in your Windows 
manual. Make sure that the port is not set for a speed faster than the modem can handle. 

? When establishing your area code and dialing prefixes in Dialer preferences, it is 
assumed that you are using TeleMagic’s default dialing plan. (Unless otherwise 
specified, TeleMagic will assume that all calls within your area code are local and all 
calls in another area code are long distance.) If your area uses a different dialing scheme, 
you will need to perform NANP setup. 

North American Numbering Plan (NANP) 
Note:  If your company is not located in North America, or is located in an area of North 
America where NANP has not been implemented, this section does not apply. 
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TeleMagic’s default dialing pattern assumes that all numbers which have the same area code 
as your phone are truly “local” numbers; and that all numbers with different area codes are 
long distance.  

Because of the proliferation of numbers for fax, cellular, and other communication devices, 
changes have been incorporated into the North American Numbering Plan (NANP). This is 
resulting in new and different area codes, multiple area codes for the same region (all of 
which are considered local), and numbers within the “local” area code that are considered 
long distance. With NANP revisions, it is quite possible that a user might: 

? Dial a different area code although the call is local. 

? Dial a numb er with the same area code although the call is considered long 
distance. 

? Dial 10 digits (area code + number) for a local call with the same area code. 

? Have some other unusual dialing pattern. 

The NANP setup in TeleMagic allows you to establish each area code and exchange that 
requires a special dialing pattern. 

NANP setup is a global setting. Any changes made to your NANP setup will be applied to 
all users and all databases, both for dialing and for faxing.  

To Set Up NANP 

Note:  The NANP settings provide exceptions to the settings established in Dialer 
preferences. If you have not already established your Dialer preferences, see Dialer 
Preferences in on-line help. Only supervisors have access to the NANP feature. 

1. Compile a list of any numbers that have an unusual dialing pattern. (This information 
for your local area code can usually be found in the front of your phone book.) The 
standard support in TeleMagic makes the following assumptions: 

? Long distance numbers will be preceded by the number entered in the Dialer 
preference’s Prefix for Long Distance Call field (usually a 1) 

? The area code is next  

? The exchange (the first 3 numbers after the area code) is next  

? The number is last 

Example:  1-123-555-7890  

? Local numbers will be dialed with just the exchange and the number 

Example:  555-7890 

Any exceptions to this should be included in this list. 
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Note:  Numbers that conform to the dialing pattern detailed above do not need to be 
entered in NANP setup. 

2. From the Options menu, select Maintenance, NANP. 

 The North American Numbering Plan Setup selection box will open: 

 

North American Numbering Plan Setup Selection Box 

3. Click Add. 

 The Add NANP Record dialog box will open: 

 

Add Record Dialog Box 

4. In the Area Code: field, enter the first area code on your list. If all numbers within that 
area code use the same settings, skip to step 8. 

5. In the Exchange: field, enter the exchange (the three numbers after the area code). 
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6. If there are several exchanges in an area code that require the same dialing pattern, 
use the Through field to enter a range of numbers. Enter the first number in the range 
in the Exchange: field and the last number in the Through field. 

7. Use the Dialer Formatting radio buttons using the following guidelines:  

? Select Use No Prefix if you do not want a local or long distance prefix dialed. 
(This will not affect your dialer prefix used to access an outside line.) 

? Select Use Local Prefix if you want TeleMagic to reference the Prefix for Local 
Call field in Dialer preferences when dialing this number. (The Prefix for Local 
Call field should contain any number that should precede a local call, but that 
should not be used with a long distance call.) 

? Select Use LD Prefix if you want TeleMagic to reference the Prefix for Long 
Distance Call field in Dialer preferences when dialing this number. (The Prefix 
for Long Distance Call field should contain any number that should precede a 
long distance number, but that should not be used with a local number. In North 
America, the prefix for long distance calls is generally 1.) 

8. Mark the Use Area Code checkbox if you would like TeleMagic to dial the area code 
when dialing this number. Leave it unmarked if the area code should not be dialed. 

9. Mark the Use Dialer Prefix checkbox for TeleMagic to use the Dialer Prefix from 
Dialer preferences. Unmark it if this prefix should not be dialed. (This only affects the 
number needed to get an outside line. It will not affect whether TeleMagic dials a local 
or long distance prefix.) 

10. Mark the Use Dialer Suffix checkbox for TeleMagic to use the Dialer Suffix from 
Dialer preferences. Unmark it if the suffix should not be used. 

Note:  The Use Dialer Prefix and Use Dialer Suffix settings do not specifically apply 
to the North American Numbering Plan. They have been included to allow you the 
flexibility to create exceptions to your preference settings if the need should arise. If 
you unmark either of these checkboxes, you are simply instructing TeleMagic not to 
use your preferences. 

11. Click OK to save the entry and return to the North American Numbering Plan Setup 
selection box. 

or Click Cancel to return to the North American Numbering Plan Setup selection box 
without saving the entry. 

12. Repeat steps 3 through 11 for each number on your list. 

13. When you have finished entering all numbers, click Close to close the North 
American Numbering Plan Setup selection box. 
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NANP Tips 

Use the following guidelines when selecting your Dialer Formatting settings: 

? If you are setting up a truly local number (one for which you only need to dial 
seven digits, without the long distance prefix and the area code—e.g., 555-7890), 
select the Use No Prefix or the Use Local Prefix radio button (depending on 
whether your phone system requires a local prefix) and leave the Use Area Code 
checkbox unmarked. (This is only required for local numbers that are in an area code 
other than what is entered in the Local Area Code field in Dialer preferences. You 
do not need to create a NANP record for local numbers within your area code that 
follow this dialing pattern.) 

? If you are setting up a long distance number which requires the area code, but does 
not require the long distance prefix (e.g., 123-555-7890), select the Use No Prefix 
radio button and mark the Use Area Code checkbox. 

? If you are setting up a long distance number which requires the long distance prefix, 
but does not require the area code (e.g., 1-555-7890), select the Use LD Prefix radio 
button, and unmark the Use Area Code checkbox. 

? If you are setting up a long distance number which requires the long distance prefix 
and the area code (e.g., 1-123-555-7890), select the Use LD Prefix radio button, and 
mark the Use Area Code checkbox. (This is only required if the long distance 
number is in the area code entered in the Local Area Code field in Dialer Setup 
Preferences. You do not need to create a NANP record for long distance numbers 
outside of your area code that follow this dialing pattern.) 

You may have created settings for a range of area codes and exchanges, but find that some 
numbers within that range require different settings. To save you time in NANP setup, 
TeleMagic allows you to create sub-sets of any range of numbers and use different settings 
for those sub-sets. A sub-set can be anything from a smaller range of numbers within the 
larger range, to a single entry. (The sub-set must be completely contained within the original 
range.) You can create multiple sub-sets, or even break the sub-sets down into smaller sub-
sets. 

When TeleMagic prepares to dial a number, it will check the NANP table first for a single 
area code with exchange. If that is not found, it will look for the number in a range. If the 
number belongs to more than one range, TeleMagic  will use the settings for the smallest 
range. If there is not a range assigned for the exchange, TeleMagic  will look for the area code 
without an exchange. If this is not found, TeleMagic will look at the Local Area Code field 
in Dialer preferences. If the area code does not match this preference, TeleMagic will dial it 
as a standard long distance number. 
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Setting Up the  
Fax System for Local Faxing 

Before you can send faxes locally with TeleMagic, you need to install a class 1 or class 2 
faxmodem on your computer. You should then check that the faxmodem initializes correctly, 
and that it sends faxes successfully. (Do this by installing and testing the software that 
accompanied your faxmodem.)  

Note:  Check Modem Properties (available from the Control Panel) to make sure the settings 
Windows is using match the settings you have established for the modem. (Pay particular 
attention to the COM settings Windows has established.) If there are any discrepancies, 
adjust your settings accordingly.  

Before Setting Up Local Faxing You Need to Know: 
???   Some faxing terminology; 

If you do not know what a COM Port is, or what a faxmodem does, refer to the Glossary 
in on-line help. 

?    Where your faxmodems are installed; 

If your workstation does not have a faxmodem, you can only send faxes to the queue. 
From there, the faxes must be processed by running the Automation Server on a 
workstation that has one or more faxmodems. 

? Whether you will send faxes locally, or queue faxes and have the server process them—
or both; 

If you know that you will always be faxing locally (that is, faxing to individual contacts 
from a faxmodem attached directly to your workstation, without using a queue/server) 
you should only need to follow the steps in Fax Setup for Local  Faxing. 

On the other hand, if you will always be sending faxes to the Automation Server, or if 
you do not have a locally installed faxmodem, you do not need to perform local faxing 
setup. You can instead refer to the setup steps outlined in the Automation Server 
Processing section of on-line help. 

If you will be using both approaches (for example, sending urgent faxes locally, and 
queuing faxes sent to all contacts in a filter), you should follow both procedures. 

Note:  Even if you will not be faxing locally, it is recommended that you refer to the Fax 
Preferences topic in on-line help for instructions on establishing your Fax preference 
settings. Although these settings will not affect the Automation Server’s settings, many 
of these options are offered as defaults when you send a fax. While these settings can 
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be entered when you prepare to send a fax, if you will be consistently using the same 
settings it is a good idea to establish them in Preferences. 

Performing Local Fax Setup 
Local faxing means creating a single fax and processing it immediately from the computer on 
which you are working. Local faxing is only available on workstations with locally installed 
faxmodems. You cannot send a fax to a group of contacts (in a filter) locally. Faxes being sent 
to all records in a filter must be processed by the Automation Server. 

To Set Up the Fax System for Local (Immediate) Faxing: 

1. Open TeleMagic on the computer where you have installed and tested a faxmodem.  

2. From the Options menu, select Preferences . 

3. Click on the Dialer tab. 

The Dialer Preferences page will open: 

 

Dialer Setup Configuration Options Dialog Box 

4. Make sure that the fields from Local Area Code: to Dialer Suffix: are completed 
correctly. 

Note:  You do not need to change your other dialer settings (Tone, Pulse, Insert 
Notes into Notepad, or Zoom Dial) to match your faxmodem. These TeleMagic Dialer 
configuration settings are for use with the Dialer feature and have nothing to do with 
faxing. 
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5. Click on the Fax tab. 

 The Fax Preferences page will open: 

 

Fax Preferences Page 

6. Click Configuration.  

The Faxmodem Configuration dialog box will open: 

 

Faxmodem Configuration Dialog Box 
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7. If you would like to have TeleMagic configure your faxmodem automatically, click 
Auto Configure. There will be a pause while TeleMagic  checks your system for 
faxmodems. 

When completed, any devices that were found will be listed in the Device(s) 
Configured field. 

 Hint: If you are encountering any problems using automatic configuration with 
your system, try using the manual configuration method instead. 

or If you know the COM Port to which your faxmodem is attached, click Manually 
Configure. 

 The Configure Modem dialog box will open: 

 

8. Select the port where the faxmodem is attached from the Configure Modem on Port 
drop-down list. 

9. Click Configure and TeleMagic will configure the faxmodem located at this port and 
list the faxmodem in the Faxmodem Configuration dialog box. Repeat this step for each 
COM Port with a faxmodem attached. 

Note:  If you select a COM Port which does not have a faxmodem attached, you will 
receive an Unable to Add Device message. 

10. Click Close at the Faxmodem Configuration dialog box when finished. 

11. Mark the following options as required: 

?  Use Local Faxmodem if you have a faxmodem installed locally (that is, on the 
computer from which you are running TeleMagic), and wish to use it. If you do not 
mark this checkbox, TeleMagic will automatically assume you wish to send all faxes 
to the queue, and sending locally will not be an option. 

Note:  If you check Use Local Faxmodem, but have not yet configured your 
faxmodem, you will receive a pop-up informing you that you must configure your 
faxmodem before selecting this checkbox. 

?  Modem Speaker On to hear the initialization and dialing sounds made by your 
faxmodem when you send a fax locally. 

?  Close Word Processor after Faxing to close your word processor. This option 
has no effect unless faxing locally . 
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Warning! With this option chosen, the word processor will close without prompting 
to save unsaved work. 

?  Use Dialer Prefix to use the prefix as entered on the Dialer preference screen. 

Note:  If you are not sure about this option, try leaving it blank initially. You can 
change it later if you have problems sending faxes. 

?  Fail Fax with Invalid Fields to abort sending a fax that contains invalid fields 
(because the database has changed, or the document contains fields that do not 
exist in the current database) and assign it a Failed status. 

12.  Mark Sending Preferences as required: 

?  E-mail Notify to send you an e-mail message after a fax has been successfully 
processed. The e-mail message will note the details of the fax. 

?   E-mail on Failure to be notified by E-mail in the event of an unsuccessful fax. 

? Create Activity to create an activity with the type LetterFax and the status 
Completed in your Activity Manager. This will also cause the fax to be included in 
the Document History rollup for the contact. 

? Notepad Stamp if you would like a "Sent fax" note stamped in the contact's 
notepad. 

? Monitor Fax (Local) to display the status of local faxes. (This is only available if 
you are faxing locally.) 

? Notification (Local) if you would like a pop-up to appear notifying you on 
successful completion of local faxes. (This is only available if you are faxing 
locally.) 

? Stamp Comments if you would like fax cover comments stamped into the 
contact's notepad, the activity comments field in the Activity Manager, and/or the 
Fax Stamp field established in Key Fields, if that key field is a memo field. 

? Stamp Documents if you would like a list of the documents (path and filenames) 
sent with the fax stamped in the contact's notepad, the activity comments field in 
the Activity Manager, and/or the Fax Stamp field established in Key Fields, if that 
key field is a memo field. 
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13. Click on the Writing tab. 

 The Writing Preferences Page will open: 

 

Sample Writing Preferences Page 

14. Make sure you have at least one word processor selected from the Word Processors 
list. 

Note:  You must have a word processor selected to be able to fax documents. 

15 Click on the Key Fields  tab. 

Note:  If the Key Fields  tab is unavailable, either you do not have a contact database 
open, or you are logged into TeleMagic as a user who does not have access to 
Database preferences. 

 The Key Fields page will open: 



210 Feature Setup 

System Administrator Guide 

 

Key Fields Page, with Sample Data 

16 With the Level 1 radio button selected, click in the Fax # field. 

 

Pager # Key Field, No Field Selected 

17. From the list of Level 1 fields, choose the field that contains the main fax number. 

Note:  Only Phone and Fax type fields will appear on the list of available fields. If there 
are no fields listed, you do not have any phone or fax fields on Level 1 of the current 
database. 

 The fax number will be pulled from this field whenever you send a fax from the Main 
menu or using the fax toolbar icon from this level of this database. (If you have fax 
type fields in your database, you will also be able to fax to the numbers contained in 
those fields using a fax icon on your Contact Manager page.) 

Note:  You can also establish a Fax Stamp field and a Contact field (used to offer the 
default name to whom faxes are being sent) from the Key Fields screen.  

18. Repeat steps 16 and 17 for the other levels of the current database, changing levels by 
clicking the appropriate radio button. You can save any changes without closing the 
dialog box by clicking Apply at any time. 
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19. When you have set up a fax field for each level of this database, click OK. 

20. If you will be faxing from more than one database, open each database in turn and set 
up the Fax Key Field. 

You are now set up and ready to begin sending local faxes in TeleMagic. 
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Wireless Messaging Setup  
Wireless messages can be sent either from a user’s local workstation or from a queue. Setup 
for sending and receiving wireless messages locally is detailed below. 

Before Setup 
Before setting up your Wireless Messaging system in TeleMagic, there are a few things you 
need to know: 

? The user’s pager ID (Pager PIN) and pager terminal number (carrier phone number). 

Before setting up Wireless Messaging in TeleMagic, users should contact their 
paging carriers to verify that they (and the terminal to which they are connected) 
can accommodate messaging from modems. TeleMagic uses Telocator 
Alphanumeric Input Protocol (TAP) with its Wireless Messaging feature. The 
paging carrier must use TAP, and its implementation must be compatible with 
TeleMagic. Not all carriers that use TAP use the same implementation. Once the 
Wireless Messaging feature is set up, it is recommended that you perform a test 
page to verify that your paging system is compatible and can accommodate pages 
from TeleMagic. 

? What packet size each user’s messaging system can accommodate. 

Wireless messaging systems have a limit to how much information can be accepted 
in one page. The amount of information that can be accepted is called a packet size. 
The minimum packet size that most pagers can accommodate is 80 characters; while 
some pagers may be able to accommodate more, TeleMagic can send a maximum 
packet size of 900 characters. When sending a wireless message, TeleMagic  will 
read the packet size and break the message up into packets, sending them one after 
another. To minimize having messages split up, enter the highest packet size each 
user’s pager will accommodate. Do not try to enter a packet size higher than their 
pager will accommodate. Only so much data will be accepted and excess information 
will be lost. 

? The user’s baud rate. 

This is not the baud rate the users’ modems will accommodate; this is the baud rate 
their paging carriers will accommodate. TeleMagic offers a default baud rate of 300. 
Having the baud rate at a setting higher than what the paging carrier can handle will 
cause problems —be aware of this if you alter this default setting. 
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Wireless Messaging Setup for TeleMagic Users 
Wireless Messaging setup is performed at the Preferences dialog box from either the 
Wireless Messaging page or from the Users page. The Wireless Messaging page allows you 
to perform full setup for both sending wireless messages and allowing other users to send 
you messages. The options available on the Users page allows you to quickly enter users’ 
pager numbers and pager IDs so that others can send them messages from TeleMagic. You 
have the choice of logging into TeleMagic as each user in turn and performing full setup 
from the Wireless Messaging page, or simply setting users up to receive messages when 
they are added, then allowing each user to perform his or her own setup to send messages. If 
you want to perform full setup, do so from the Wireless Messaging page. Otherwise, open 
the Users page to quickly enter each user’s pager number and ID. 

 Hint: If all or most users in your installation of TeleMagic subscribe to the same 
paging carrier, you can save time and repetitive data entry by establishing a 
default pager number. It can be edited for any users with a different paging 
carrier. 

Setup for Sending Wireless Messages to Contacts 
Although there is a Manual Entry option that allows you to send messages to your 
contacts and manually enter the contact’s pager ID and number, it can save time and effort if 
that information is entered automatically from the Contact Manager. By creating fields in the 
Contact Manager to contain the pager number and ID, then selecting those fields as key 
fields, you can have that information automatically pulled into the Wireless Messaging 
dialog box. 

Note:  In order to be used for wireless messaging, the fields you select as your Pager # and 
Pager ID key fields must use the templating described below. 

To Add Wireless Messaging Fields to a Database: 

1. From the File menu, select Add / Edit Fields . 

 The Edit the Field List dialog box will open: 
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Sample Edit the Field List Dialog Box 
(Your field list will look different) 

2. Select the radio button for the database level to which you want to add the fields. 

3. Click Add to create a field to contain the carrier’s phone number. 

4. In the Prompt: field, give your field a descriptive name. (e.g., Pager # .) 

5. In the Field name: field, give your field a name. 

6. In the Type: field, choose Pager. 

7. In the Length field, select 14. 

8. Click Template. 

 The template dialog box for the selected field type will appear: 
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Phone Template 

9. In the Input Mask: field, type 9-999-999-9999. (The nines are a templating mask 
character meaning “allow digits only” in that position in the field; the dashes are 
literal characters—you will not be able to place anything in the field in the positions 
occupied by the dashes.) 

10. Click OK. 

 The template dialog box will close.  

11. Click Save Field. 

12. Click Add to create a field to contain the Pager ID (Pager PIN). 

13. In the Prompt: field, give your field a descriptive name. (e.g., Pager ID.) 

14. In the Field name: field, give your field a name. 

15. In the Type: field, choose Character. 

16. In the Length: field, select 8.  

17. Click Template. 

 The Character Template dialog box will open showing a default template. 

18. In the Input Mask: field, enter XXX-XXXX. (The Xs are templating mask characters 
that allow anything to be placed in the field in that position; the dash is a literal 
character—users will not be able to place anything in the field in the position 
occupied by the literal.) 

19. Repeat steps 2 through 18 for any other database levels if necessary. 
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20. When satisfied with your selections, click OK to save the field, and Save Field to save 
the database changes. 

Note:  You must run a rebuild after making changes to your database. 

 After rebuild, the fields will appear in your database. Enter the pager information in 
each record for any contacts to whom you will be sending wireless messages. 

21. Using the Screen Designer, place the new fields and their prompts on your screen. 

To Set up the Pager # and Pager ID Key Fields: 

1. From the Options menu, select Preferences . 

The Preferences dialog box will appear. 

2. Click on the Key Fields  tab. 

Note:  If the Key Fields  tab is unavailable, either you do not have a contact database 
open, or you are logged into TeleMagic as a user who does not have access to 
Database preferences. 

The Key Fields screen will open: 

 

Key Fields Page 

3. Using the Key Fields for: radio buttons at the top of this dialog box, select the level 
containing the contact records you wish to page. 

4. Click in the Pager #: field and select the pager # field from the drop-down list. 
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5. Click in the Pager ID: field and select the pager ID field from the drop-down list. 

6. If you have created pager number and pager ID fields for any other database level, 
repeat steps 3 through 5 for the other level(s). 

7. Click OK to save your changes. 

or Click Apply to save your changes and continue configuration. 

8. To establish a pager number and ID for any other databases, open those databases 
and repeat steps 1 through 7. 

You are now set up and ready to use Wireless Messaging in TeleMagic.  

Automation Server Setup 
When sending faxes and Wireless Messages, you have the option of sending immediately 
from your workstation, or sending to a queue. The TeleMagic Automation Server allows you 
to process those queues to send groups of faxes, Wireless Messages, e-mail messages, and 
documents.  

When setting up the Automation Server, you create one or mo re Server IDs and establish 
specific configuration settings for each. You are then able to select a Server ID on a 
workstation to process your queued faxes and wireless messages. You can have up to eight 
faxmodems on a workstation being used as a server, and an unlimited number of servers on 
multiple workstations processing simultaneously. 

Note:  The Automation Server can also be used to print documents created in word 
processing. The only setup requirement for this is that the workstation running the server 
have a default printer set up in Windows, and that you have not deleted the queue named 
Print Queue (provided by default). 

Setup of your fax, e-mail, and Wireless Message processing system is a three-part process: 

? You must create the queues where faxes, e-mail messages, and Wireless Messages 
will be stored while awaiting processing; 

? You must configure your faxmodems for use with TeleMagic; 

? You must establish your server settings. 

Automation Server System Requirements 
If a workstation is going to be dedicated as an Automation Server workstation, the minimum 
hardware requirement is a Pentium 233 with 64 MB of RAM. The operating system 
requirements are the same as for TeleMagic Enterprise (Windows 95, 98, or ME, or Windows 
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NT 4.0 or Windows 2000). Windows NT 4.0 or Windows 2000 is strongly recommended for 
dedicated Automation Server workstations. 

To avoid an IRQ conflict resulting from too many internal modems —and because the 
standard Windows COM driver is not reliable with multi-line processing in the 
background—the maximum internal modems supported is two. To use more than two 
modems, you must use a multi-function (serial) board. If you are using up to four faxmodems, 
there are a variety of serial boards that can be used, such as Boca™, STB™, or DigiBoard™. 
If you are using up to eight faxmodems, you should use a DigiBoard™ (from Digi 
International) or a RocketPort™ (from Comtrol). For more information, see your system 
administrator or reseller. 

Before you can process your queues with TeleMagic, you should check that all faxmodems 
on the workstation that will be used as a server initialize correctly, and that they send faxes, 
e-mail, and Wireless Messages successfully. (Do this by installing and testing the software 
that accompanied your faxmodem.) 

Setting Up a Queue 
When users send faxes, e-mail, and Wireless Messages to the server, they are stored in a 
queue. You can establish up to ten separate queues. Queues are established by giving them 
a name. 

When you create your queues, think about how you will be processing. If you have only 
one workstation that will be used as a server, and no special requirements, you may only 
need to establish one queue. If you will be using multiple workstations or have variable 
processing requirements, you may need to establish more than one queue. For example, you 
may want to have separate queues for different departments in your comp any, or establish 
one queue for general faxes and another for only Wireless Messages, e-mail, or high priority 
faxes. 

By default there are three queues already set up when you start TeleMagic: 

? Queue #1, named TeleMagic Fax Q by default, will be ready for use as soon as you 
install the program. 

? Queue #5, named Print Queue by default, is used to print word processing 
documents from the server. (If you change the name of this queue, you will only be 
able to print word processing documents locally.) 

? Queue #10, named Local Faxes by default, stores data about TeleMagic faxes that 
were sent directly from users’ workstations without using the server. It is mainly 
useful for generating reports. If you do not need to have a queue dedicated to 
merely recording local faxing activity, you can rename queue #10. (Should you 
decide that you wish to use the local fax tracking feature later, you can rename 
queue #10 so that it starts with the word Local, and it will be ready to go.) 
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Note:  Queue #1 and Queue #10 cannot be deleted. You can change the current name, but 
you cannot remove the name. 

To Set Up the Queue(s): 

1. Double-click the Automation Server icon in the TeleMagic  Enterprise program group 
or folder: 

 

Automation Server Icon 

or From the taskbar, choose Start, Run. Enter the path to the file TMAUTSRV.EXE in 
the TeleMagic  \PROGRAMS directory, and click OK. 

 The main Automation Server screen will open: 

 

TeleMagic Automation Server Screen 

Note:  If you are prompted for a password before the above screen opens, or at any 
stage during the setup process, another user has already entered the Setup part of the 
Automation Server program and password-protected it. 

2. Click Queue. 

The Queue Edit dialog box will open, showing the current queues. 
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Sample Queue Edit Dialog Box 

3. Highlight the queue you would like to activate or rename, and click Edit. 

 A cursor will appear in the Queue Name: field. 

4. Enter a new name for the queue in the Queue Name: field. 

Note:  If you select a queue that currently has a name, then delete the name from the 
Queue Name: field and click Save at this point, you are effectively de-activating the 
queue. This will not delete faxes, e-mail messages, and Wireless Messages already in 
the queue, but they will remain inaccessible until you give the queue a name again. 
You can deactivate all but two of your queues: Queue #1 and Queue #10. 

 Hint: The queue named Print Queue is used to print word processing 
documents from the Automation Server. 

5. Click Save. 

 The queue name will appear in the list. 

6. To exit the Queue Edit dialog box, click Close. 

 You will be returned to the main Automation Server Setup screen. 

Configuring Modems 
You should already have decided what workstation is going to be used to process faxes, e-
mail, and Wireless Messages, and have installed and tested one or more faxmodems on that 
workstation. (If you will be processing from more than one workstation, modems must be 
installed and tested on each.)  

Note:  If you are going to be processing faxes, e-mail, and Wireless Messages on the same 
machine, you must have at least three modems installed, unless you are transferring e-mail 
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via local area network. If you are using a local area network to transfer e-mail, you would 
only need two modems; one for Wireless Messaging and one for faxing. Each of these 
features requires a dedicated modem, except e-mail, which can use a LAN connection 
instead. 

To Configure a Wireless Messaging Modem:  

1. On a computer where you have installed and tested a faxmodem, double-click the 
Automation Server icon in the TeleMagic program group or folder: 

 

Automation Server Icon 

or From the taskbar, choose Start, Run. Enter the path to the file TMAUTSRV.EXE in 
the TeleMagic  \PROGRAMS directory, and click OK. 

 The TeleMagic Automation Server will open. 

2. Click Configure. 

 The Modem Configuration dialog box will open: 

 

Modem Configuration Dialog Box 

 

3. Click on the Wireless Messaging  tab. 
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 The Wireless Messaging Setup page will open. The field on the left side of the page 
will contain a list of all faxmodems configured on this machine. Each device listed will 
have an icon associated that indicates how it is being utilized.  

4. In the Use Wireless Messaging Device Name field, mark the checkbox associated 
with the device to be used with wireless messaging. 

 The entry in the list on the left side for the selected device will be updated to indicate 
that it will be used for Wireless Messaging. Only one device can be used for Wireless 
Messaging. 

5. Click OK. 

or Click Apply and proceed with other configuration options. 

To Configure Modems for Faxing: 

1. On a computer where you have installed and tested a faxmodem, double-click the 
Automation Server icon in the TeleMagic program group or folder: 

 

Automation Server Icon 

or From the taskbar, choose Start, Run. Enter the path to the file TMAUTSRV.EXE in 
the TeleMagic  \PROGRAMS directory, and click OK. 

 The TeleMagic Automation Server will open. 

2. Click Configure to configure the local faxmodem(s). (TeleMagic  can use up to eight 
locally installed faxmodems.) 

 The Modem Configuration dialog box will open. 

3. If you would like to have TeleMagic configure your faxmodem automatically, click 
Auto Configure Faxmodems . There will be a pause (automatic configuration can take 
up to five minutes to perform) while TeleMagic checks your system for faxmodems.  

When completed, any faxmodems found will be added to the Device(s) Configured 
list. 

or If you know the COM Port to which your faxmodem is attached, click Manually 
Configure Faxmodems . 

 The Configure Modem dialog box will open. 

4. Select the COM Port to which the faxmodem is attached from the Configure Modem 
on Port: drop-down list and click Configure. 

5. Click OK. 
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 TeleMagic will configure the faxmodem located at the selected port and list it in the 
Faxmodem Configuration dialog box on the Devices Configured list. 

Note:  If you select a COM Port with no faxmodem attached, you will receive an 
Unable to Add Device message. 

6. Repeat steps 3 through 5 for each COM Port with a faxmodem attached, and click Exit 
when done. 

 You will be returned to the main TeleMagic Automation Server screen. 

To Configure an E-mail Modem:  

1. On a computer where you have installed and tested a faxmodem, double-click the 
Automation Server icon in the TeleMagic program group or folder: 

 

Automation Server Icon 

or From the taskbar, choose Start, Run. Enter the path to the file TMAUTSRV.EXE in 
the TeleMagic  \PROGRAMS directory, and click OK. 

 The TeleMagic Automation Server will open. 

2. Click Configure to configure the local faxmodem(s). (TeleMagic  can use up to eight 
locally installed faxmodems.) 

 The Modem Configuration dialog box will open. 

3. Click the E-mail tab. 

 The E-mail page will open. 

4. If you will be connecting through a local area network, select the Connect through 
Local Area Network (LAN) radio button and proceed to step 9. 

or Select the Dial-up Networking radio button. 

5. Select the connection you will be using from the Connection Name: drop-down list. 

Note: You must have at least one modem established in Windows for any 
connections to be available. 

6. Enter the User Name recognized by your ISP in the User Name: field. 

7. Enter the Password required by your ISP in the Password: field. Enter the password 
again in the Verify Password: field. 



224 Feature Setup 

System Administrator Guide 

8. The Stay idle field indicates the time, in minutes, that the Automation server will 
remain connected to the Internet without any messages before logging off. Enter the 
time in the field, or use the spinner arrows to select the idle time. 

9. Enter the SMTP server in the SMTP Server field. This is the server used for 
outgoing messages. 

Warning! Do not change the setting in the Port: field unless specifically instructed to do 
so by your network administrator or ISP representative. 

10. Click OK to save settings and exit the Modem Configuration dialog box. 

To Configure a Modem for DSS E-mail:  

1. On a computer where you have installed and tested a faxmodem, double-click the 
Automation Server icon in the TeleMagic program group or folder: 

 

Automation Server Icon 

or From the taskbar, choose Start, Run. Enter the path to the file TMAUTSRV.EXE in 
the TeleMagic  \PROGRAMS directory, and click OK. 

 The TeleMagic Automation Server will open. 

2. Click Configure to configure the local faxmodem(s). (TeleMagic  can use up to eight 
locally installed faxmodems.) 

 The Modem Configuration dialog box will open. 

3. Click the DSS E-mail tab. 

 The DSS E-mail page will open. 

4. Enter the POP3 server in the POP3 Server: field. This is the server used for incoming 
mail. 

5. The Port: field is machine specific and should not be changed unless specifically 
directed by the network administrator. 

6. Enter the User ID recognized by your mail service in the User ID: field. 

7. Enter the password recognized by your mail service in the Password: field. Enter the 
password again in the Verify Password: field. 

8. Click OK to save changes and exit the Modem Configuration dialog box. 
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Setting Up a Server 
To process the Automation Server, you must first establish server configuration settings. 
This involves creating one or more server IDs (servers), and establishing how each of these 
servers should process. 

To Set Up a Server: 

1. On a computer where you have installed and tested a faxmodem, double-click the 
Automation Server icon in the TeleMagic program group or folder: 

 

Automation Server Icon 

or From the taskbar, choose Start, Run. Enter the path to the file TMAUTSRV.EXE in 
the TeleMagic \PROGRAMS directory, and click OK. 

 The TeleMagic Automation Server will open. 

 If users have already sent faxes, e-mail, and Wireless Messages to the queue, they 
will be listed on this screen. 

Note:  If you are prompted for a password before the above screen opens, or at any 
stage during the setup process, another user has already entered the Setup part of the 
Automation Server program and password-protected it. 

2. Click Setup to set up a server. 

 The Setup screen will open, displaying details about the existing server(s). 
(TeleMagic comes with one server defined by default.) If you have more than one 
server, they will each be listed here. 

 

Sample Automation Server Setup Screen 
(Your server may show default settings in this dialog box.) 
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3. Click Add to add a new server. 

or Edit to edit the currently highlighted server. 

 The Server Setup dialog box will open: 

 

Server Setup: Adding a Server 

4. Enter a unique three-character ID in the Server ID: field. As faxes and Wireless 
Messages in the queue are sent, you will be able to identify which server is currently 
processing a given fax or message by this Server ID. 

5. In the Working Directory: field, type (or click Browse to locate) the name of the 
directory where the server’s temporary working files should be stored. 

 You can enter the name of an existing directory here, or of a directory that does not 
yet exist. We recommend that you enter a directory that will be used solely for the 
purpose of storing the server’s temporary working files, and that is located on a drive 
with plenty of disk space—especially if you are planning to fax files containing 
graphics. 

 If the directory name you enter does not exist, as soon as you leave the Working 
Directory: field TeleMagic will ask if you wish to create it. Click Yes . 

6. In the Processing Pause Time: field, enter the duration, in seconds, for the pause 
time. 

7. Select the radio button for the type of pause, either Pause between each item or 
Pause only when idle. When Pause only when idle is selected, there will only be a 
pause when the entire queue has been processed. When Pause between each 
item is selected, there will be a pause between each item in the queue as well as a 
pause between processing each queue. 
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8. Select what the server will process. The server can process merges, transmissions, or 
both. 

Merge And Transmit for this server to both merge (print) documents and send 
them out. (Select this option if this is to be your only server.) 

Transmit Only for this server to only send out documents. When selected, the 
server will look for documents that have been merged and printed to the fax driver 
by a server that is set to merge documents (see Merge Only, below).  

Note:  If you will not have a server devoted to merging documents, do not select this 
option. Do not select this option if the server will be used to process the Print Queue. 

Merge Only for this server to open the documents to be faxed or e-mailed, complete 
any merge fields, and print the documents to the fax driver. (Even if there are no 
merge fields, the server will still need to print the document to the fax driver.) 

Note:  You can select this option if you have another server set up to either Transmit 
Only or Merge And Fax. (If your other server is set to Merge And Fax, when the 
Automation server encounters a fax or e-mail in the queue that has not been merged, it 
will merge the document, print it to the fax driver, and send the fax or e-mail. When it 
encounters a document that has already been merged and printed by the Merge Only 
server, it will simply send the fax or e-mail.) Do not select Merge Only if this is to be 
your only server, or faxes and e-mail will not be sent. 

 Hint: Dividing the tasks of merging and printing the documents and actually 
sending the documents between different servers can dramatically 
increase processing speed. You can devote the workstation that has 
installed faxmodems to solely sending out the documents, while one or 
more other workstations do the time-consuming work of printing the 
documents to the fax driver.  

9. In the Retry Wait Time: field, enter the number of minutes (up to 900) the server 
should wait between each attempt to send the same fax or message. 

 Hint: Start with 15 minutes and adjust as necessary. 

10. In the Local Area Code: field, enter the local area code at the location of the 
workstation that will be running the server. 

Note:  This field (as well as the rest of the fields in the General Server Settings  
portion of the screen) does not read and display the settings you entered in the Dialer 
and Fax Preferences screens within TeleMagic. What you are entering here are the 
settings that the server should use when processing faxes; what you enter in Dialer 
and Fax preferences are the settings that apply to any faxes sent locally (not via the 
queue). The two sets of information are not related, even though they may look 
similar. (If you have set up NANP, the server will respect these settings.) 
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11. In the Dial Prefix (Outside Line): field, enter any number(s) you must dial to get an 
outside line. 

12. In the Prefix for Local Call field, enter any number that must be dialed when placing 
a local call that is not necessary when dialing a long distance number. 

Note:  If you have placed a number in the Dial Prefix (Outside Line) field, it is not 
necessary to place it here. (If you do so, it will be dialed twice.) This field should only 
contain any necessary local prefix. 

13. Mark the Modem Speaker On checkbox to hear the initialization and dialing sounds 
made by the faxmodem when faxes are being sent. 

14. In the Long Distance: field, enter any digits that need to be added in front of a 
number to place a long distance call. 

15. Enter any digits that must be dialed after a number in the Dialer Suffix: field. 

16. Click on the Fax Specific Settings tab. 

 The Fax Specific Settings page will open: 

 

Fax Specific Settings Page 

17. In the Number of Retries: field, enter the number of times (up to 9) the server should 
attempt to send a fax before declaring it failed. 

Note:  Number of Retries for Wireless Messages is defined when the messages are 
created. 
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 18. In the Local Fax ID: field, enter a name that will readily identify the origin of your 
faxes to others. The Fax ID can be up to 20 characters in length, and can contain 
spaces and special characters. This name is mainly used as an identification tag that 
can be displayed by certain receiving fax machines; for instance, those with an LCD.  

19. In the Fax Server Operators: field, enter the user ID of any users who will be 
responsible for maintaining the server when it is processing faxes. In the event of a 
critical error, the Fax Server Operators will be notified of the problem by e-mail. Use 
the drop-down list to select each user in turn. (The entries in this field must be three-
character User IDs separated by a comma.) 

 A default banner that includes who sent the fax, to whom it was sent, the subject, and 
a page count is provided. This can be edited if necessary. If you want to keep the 
default fax banner, proceed to step 21. 

Note:  The Fax Banner only applies to faxing. It will have no impact on Wireless 
Messages and e-mail sent through the server. If you choose not to edit the banner, 
the default banner will print. The default banner includes From, To, Subject, Current 
Page, and Total Pages. 

20. In the Left Justified, Centered, and Right Justified fields, enter the text and fields 
that should appear at the specified position at the top of any fax you send. Enter text 
by typing it manually; enter fields by choosing them from the drop-down list to the 
right of each field. The text will appear in the banner as entered. Data that changes 
from fax to fax will be merged in place of the fields. 

Note:  The fax banner you create for your first server (the topmost server listed in the 
Automation Server Setup dialog box) will also be used for any faxes sent locally, that 
is, those not sent via the fax queue. 

21. Click the E-mail Specific Settings tab. 

 The E-mail Specific Settings page will open. 

22. Select what type of e-mail traffic this server processes: 

Select None if this server does not process e-mail. 

Select Send Only if this server only transmits e-mail. 

Select Receive Only if this server only receives e-mail. 

Select Both if this server receives and sends e-mail. 

23. The Retrieve Mail Every field determines how often, in minutes, the mail service is 
checked for mail. Enter the desired interval in this field, or use the spinner arrows. Set 
this to 0 for continuous mail retrieval. 

24. Select the type(s) of mail this server will receive: 

 Select User Only to only receive mail for users. 
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 Select DSS Only to only receive mail for Data Synchronization Server. 

 Select Both to receive mail for users and for Data Synchronization Server. 

25. Click Save to save your changes. 

 You will be returned to the main Automation Server Setup screen with your new 
server displayed, or, if you were editing an existing server, with your changes 
displayed. 

Note:  If you need to edit any of the existing servers, click Edit and follow the 
instructions used in adding a server to make any necessary changes.  

 

Note:  To delete a server, highlight it and click Delete. TeleMagic will not allow you to 
delete your only server. You must have at least one server set up. 

Establishing Server Downtime 
You can have each server go off-line at a certain time during the course of the day. This is 
particularly important when you run TeleMagic  rebuilds, as an external rebuild cannot 
proceed if the Automation Server is processing. (You might also need to down each server 
for a routine backup of files.) You have the option of setting a global downtime, or setting 
server specific downtimes. For example, if you are using multiple servers, you can set a 
global downtime during TeleMagic rebuilds. If you have any servers set up to just fax 
without merging, you can customize their downtime so that they continue to process at all 
times. (Since they do not merge, they will not be accessing TeleMagic, and consequently will 
not affect a rebuild.) 

To Establish a Server’s Downtime: 

1. On a computer where you have installed and tested a faxmodem, double-click the 
Automation Server icon in the TeleMagic program group or folder: 

 

Automation Server Icon 

or From the taskbar choose Start, Run. Enter the path to the file TMAUTSRV.EXE in the 
TeleMagic \PROGRAMS directory and click OK. 

 The TeleMagic Automation Server will open. 

2. At the main Automation Server screen, click Setup. 

 The Automation Server Setup screen will open, showing a list of all the servers you 
have set up. 

3. To establish a global downtime, click Downtime. (Skip to step 5.) 
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or To create a server specific downtime, highlight the server whose downtime you want 
to set and click Edit. 

 The Server Setup dialog box will open. 

4. Click Downtime. The Set Server Active Time dialog box will open: 

 

Set Server Active Time Dialog Box 

5. Using the 24-hour time standard (where noon is 12:00 and midnight is 24:00), enter the 
time you want to take the server offline in the first field, and the time you want it to 
come back online in the second field. 

 Hint: If you leave 00:00 in both fields, the server will not go off-line. 

6. Mark the days that the downtime will be in effect. The server will not go offline on 
days that are not marked. 

7. Click OK when finished. 

 If you are setting a server specific downtime, you will be returned to the Server Setup 
dialog box. 

8. Click Save to return to the Automation Server Setup screen. 

9.     Repeat steps 3 through 8 for each server requiring a downtime. 
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 Establishing Your Word Processors 
Note:  Word Processor setup only applies to faxing, e-mail, and printing. It will have no 
impact on Wireless Messages sent through the server. 

You must tell TeleMagic where it will find each of the word processors it may need to open 
when sending faxes and e-mail messages, and printing documents. When setting up your 
word processors, you have the option of having your servers reference the same word 
processor setup, or you can set up each server’s word processors individually. If all or most 
of your servers will be using word processors located in the same path, you can establish 
default word processor setup. You can then set up the word processors for individual 
servers, as necessary. 

To Establish Word Processors: 

1. On a computer where you have installed and tested a faxmodem, double-click the 
Automation Server icon in the TeleMagic program group or folder: 

 

Automation Server Icon 

or From the taskbar choose Start, Run. Enter the path to the file TMAUTSRV.EXE in the 
TeleMagic \PROGRAMS directory, and click OK. 

 The TeleMagic Automation Server will open. 

2. Click Setup. 

 The Automation Server Setup screen will open. 

3. If you wish to establish global word processors, click Word Pro. (Skip to step 5.) 

or Highlight the server whose word processors you would like to set up and click Edit. 

 The Server Setup screen will open. 

4. Click Word Pro. 

 The Word Processor Setup dialog box will open: 



  Wireless Messaging Setup 233 

System Administrator Guide 

 

Word Processor Setup Dialog Box 

5. Choose a word processor from the Word Processors  list box by marking the Active 
checkbox. 

Note:  You can select as many word processors as you require. The correct word 
processor will be selected for each document to be faxed or printed. If you no longer 
use a word processor that has been previously activated, clear the Active checkbox. 

6. In the Command Line: field, type (or use the ellipses (…) button to find) the path to 
the word processor’s executable file. 

Note:  If multiple servers will be sharing the same word processor setup, you should 
make sure that the users logged into the workstations used to print documents, send 
e-mail messages, and process faxes have the same drive mapping, and the same word 
processor EXE file access. 

7. Click OK to save changes. 

 You will be returned to the main Automation Server Setup screen. 

 When TeleMagic is required to access a word processor to send a fax or an e-mail 
message, or to print a document, it will search first for the server specific word 
processor. If it does not locate it, it will use the global settings. 

Setting the TeleMagic Enterprise Automation Server Password 
To avoid unauthorized access to the Automation Server (TMAUTSRV.EXE), you can 
establish passwords for your Server. There are two types of Server passwords: a Master 
password and an Options password. When you first access the Automation Server and are 
prompted for a password, if you enter the Options password at the prompt, anyone who later 
tries to access any of the other Automation Server screens will again be prompted for the 
password. If you enter the Master password, you (and any other users) will have complete 
access to all areas of the Automation Server during that work session without being 
prompted for a password again. 
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To Establish the Automation Server’s Password(s): 

1. On a computer where you have installed and tested a faxmodem, double-click the 
Automation Server icon in the TeleMagic program group or folder: 

 

Automation Server Icon 

or From the taskbar choose Start, Run. Enter the path to the file TMAUTSRV.EXE in the 
TeleMagic \PROGRAMS directory, and click OK. 

 The TeleMagic Automation Server will open. 

2. At the main Automation Server screen, click Setup. 

 The Automation Server Setup screen will open, showing a list of all the servers you 
have set up. 

3. Click Password. 

 The Password Setup dialog box will open: 

 

Password Setup Dialog Box 

4. Click Master Password or Options Password. 

 Either the Master Password or Options Password dialog box will open: 

 

Master Password Dialog Box 

5. Enter the new password, retype it in the Confirm New Password: field, then click 
OK. 
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6. If necessary, repeat steps 4 and 5 for the other password type, making sure the 
passwords are different. 

7. Click Exit at the Password Setup dialog box. 

 You will be returned to the Automation Server Setup screen. Your server is now 
completely set up and ready to use.  

Branch Scripting Setup 
A script is a pre-written set of statements, answers, questions, or prompts that can be used 
by anyone who serves customers over the telephone. Scripts can be simple, such as a 
greeting given by a receptionist; or they can be complex, such as one that would be required 
by the customer information service of a national bank. They can be designed for making 
outgoing calls, or for incoming calls, or both.  

In addition, scripts can be used for other purposes that do not include phone use. For 
example, they could be a repository for specific instructions and information regarding the 
way your company uses a TeleMagic database. 

The basic model for a script is that of a tree which has one trunk, but many branches. 
Following any branch will bring you to more branches; choosing one of these will lead you 
to yet more branches, and so on. You can have an unlimited number of branches. 

There are four stages involved in adding a new script: 

1. Planning the script 

2. Setting up the master script name 

3. Creating the primary branch of the script 

4. Creating child branches for the script 

The script should be well planned. You should try to think of all possible directions the 
script user might need to turn to at any given stage. You need to decide if responses to 
questions or statements in the script need to be entered into the contact record, and which 
database fields should be used in the event that this is the case. Scripts tend to evolve with 
use, but a well-planned script will need fewer alterations over time.  

 Hint: The user will be able to freely switch between the script, the Call Notes dialog 
box, and the Contact Manager. At certain points, the most appropriate thing for 
a branch to do is to direct the user to add or edit a contact record, filling 
information directly into the database. Avoid adding branches that merely 
repeat a set of questions that could be asked directly from the contact screen. 

 Before proceeding, sketch out a plan for the logical flow of the script’s branches. Your plan 
might look something like this: 
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Sample Script Flow Plan 

This example shows the flow of a script that could be used by the advertising team for a 
newspaper. The newspaper has a list of clients whose advertising contracts have expired. 
An advertising representative (ad rep) has been chosen to call each contact and try to get 
them to renew their contracts. 

Following the script’s flow, the ad rep will call each client. The client will be asked if he or 
she plans to renew his or her contract. If the client is “Interested in renewing”, the script will 
then direct the ad rep to ask if the client would prefer the renewal duration of 6 months or 1 
year. 

If the client responds that he or she is “Not interested in renewing,” the ad rep will be 
directed to make a “Special Offer”. If the client accepts the offer, the ad rep will ask if the 
client would prefer the renewal duration of 6 months or 1 year. If the client responds 
negatively to the “Special Offer”, the ad rep will ask for permission to call back in 6 months 
to determine if the client’s advertising needs have changed. If the client agrees, the call is 
scheduled on the Activity calendar; if not, the call information is noted in the client’s 
database record. 

Taking the script a step further, you will need to decide how to integrate it with the rest of 
TeleMagic. Using the above example, you may have a field in your contact database to 
contain the client’s current subscription information. In this case, you should indicate on 
your script plan each branch of the script that needs to be linked to this field to allow the ad 
rep to input the client’s response. You can also have standard letters designed using the 
word processor for any of the possible responses. In this case, you can include a line in the 
script giving the ad rep instructions on which letter to print for the current response. 

Think carefully about how you can take advantage of TeleMagic’s many features to make 
your script more powerful. 

Once the script has been planned, you are ready to access scripting and add it. 
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To Set Up a New Script: 

1. From the Office menu, select Branch Scripting. 

Note:  You must have a contact database open to access Branch Scripting. 

or Click the Branch Scripting icon on the toolbar . 

 The Branch Scripts dialog box will open. 

2. Click Setup. 

Note:  Branch Scripting setup is only available to supervisor users. Only one user can 
access Branch Scripts Setup at a time. 

 The Branch Scripts Setup dialog box will open, displaying the details of the topmost 
script, including the number of times each branch has been accessed (located in 
parenthesis  next to the script title): 

 

Sample Branch Scripts Setup Dialog Box 

3. Click Add Script. 

 The Add Script dialog box will open: 
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Blank Add Script Dialog Box 

4. In the Script: field, enter a descriptive name for the script.  

Example:  Advertising Renewals  

5. In the text area, enter the script’s text that the user will read when at this branch. Use 
the font controls, above the text area, to specify the appearance of the script.  

6. To include information specific to the contact in the script, such as the contact’s 
name or the last time he or she was contacted, place your cursor at the appropriate 
location in the script and click Insert Expression to open the Branch Expression 
Builder. 

 Hint: To greet the contact by name in the script, create an expression to include 
the contact name field from the Contact Manager. This information will 
change in the script depending on what contact record is currently 
displayed in the Contact Manager. 

 Your completed dialog box may look something like this: 
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Sample Edit Branch/Script Dialog Box 

7. Click Save. 

 The Branch Scripts Setup dialog box will now show the new script and the primary 
branch with its associated text. 

 Hint: Now that you have created a new branch, you may want to associate some of your 
database fields with it. Associating fields is covered in the next section. 
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Sample Branch Scripts Setup Dialog Box 
(Note:  Because you have not yet added any child branches, the list 

of branches shows only the primary branch.) 

 Now that you have set up the script and its  primary branch, you are ready to create 
the branches that make up the rest of the script. This is done by progressively adding 
new branches to each branch that is already in your script. For example, taking the 
sample script flow shown earlier, first create the branches “Interested in renewing” 
and “Not interested in renewing” attached to the “Advertising Renewals” branch. 
Next, add the child branches “6 Months” and “1 Year” to the branch “Interested in 
renewing,” and so on. 

8. Click Add Branch to add a child branch. 

9. Enter the title of this child branch in the Branch: field.  

 Example:  Interested in renewing. 

10. Write the text of the branch in the notepad field. The text entered will appear when a 
user selects this branch. (Click Insert Expression to activate the Branch Expression 
dialog box if you would like to include information about the contact in the text. See 
step 6 above.) 

 Example:  As you may remember, we offer two different advertising contracts: a six-
month plan and a twelve-month plan. If you select the twelve-month plan, you will 
receive a 15% discount from our regular rate. This amounts to a free month. Which 
plan interests you? 

11. When finished, click Save. 
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 The dialog box will look something like this: 

 

Sample Child Branch 

 The item you have just added will appear in the list of branches beneath its parent 
branch, preceded by a number indicating how many levels deep it is. (For example, the 
primary parent branch is preceded by “001”. Immediate children of this branch are 
preceded by “002”, and so on.) A number in parenthesis follows each branch title 
indicating how many times the branch has been used. 

12. Repeat steps 8 through 11 for each of the child branches.  

WARNING!  Make sure that you have highlighted the correct parent before adding a 
branch. If you highlight the wrong branch by mistake, you will have to delete the child 
branch later and repeat this step with the correct branch highlighted. Any additional 
child branches created under the child branch that is deleted will also be deleted. 

 Eventually your screen will look something like this: 
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Branch Scripts Setup Dialog Box 

 To view a branch’s child branches, click on the plus sign  next to the branch name. 
A tree view will open showing the order in which these branches will be listed when 
you actually use the script. If one or more of the branches will be more commonly 
used than the others, you can change the order to place those branches at the top. 

13. If you would like to change the order of the branches, click Set Branch Order. 

Note:  If you have a branch highlighted which does not have any child branches 
attached, the Set Branch Order button will be dimmed.  

 The Set Branch Order button will lock in the depressed position. 

14. To change the sort order, click on the branch you want to move and drag it to the 
desired position. Branches can only be moved relative to one another within the 
parent branch. (They cannot be moved to other branches.) 

 As you begin moving the branch, your cursor will change slightly to indicate that you 
are moving an object. When you release the mouse button the cursor will return to 
normal and the branch will be relocated to the indicated position. 

15. Click on the Set Branch Order button when you are satisfied with the new order. 

 If you have made any changes to the branch order, you will receive a message asking 
if you want to save changes. Click Yes to save changes. 

 The Set Branch Order button will return to the non-selected position. 

As a script is used, the history of the conversation is indicated by the tree-view display. It is 
possible to create an activity in your Activity Manager linked to the current contact with the 
type Branch Scripting,  and for this history to be pasted into the Comments field. 
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16. To create an activity each time this script is used, mark the Create Activity with 
History checkbox. 

17. When the script is complete, and all branches and their children have been made, click 
Close. 

 The Branch Scripts Setup dialog box will close. 

18. Continue with any other Scripting option. 

or If you want to leave Scripting, click Close at the Branch Scripts dialog box. 

Adding Contact Manager Fields 
It is possible to create a link between your script and the Contact Manager. You can actually 
enter data into a contact record right from the Branch Scripting dialog box.  

To Include Contact Manager Fields in your Script: 

1. In the Contact Manager, go to the database and level containing the field(s) you 
would like included in your script. (If you will be using fields from multiple levels, go 
to the lowest level from which you will be selecting fields.) 

2. From the Office menu, select Branch Scripting. 

or Click the Branch Scripting icon on the toolbar . 

3. Click Setup. 
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 The Branch Scripts Setup dialog box will open, displaying the details of the topmost 
script: 

 

Sample Branch Scripts Setup Dialog Box 

4. Select the appropriate script from the Script: drop-down list. 

or Add a new script. 

5. Determine where in the script you might need to enter data into the contact record. 
For example, you may have a field defined to contain information on a customer’s 
primary product interest. Find the branch of the script that contains a question on 
product interest. 

6. Highlight the branch which is to have field access, and click Edit. 

 The Edit Branch dialog box will open. 

7. Click Associate Fields . 

 The Script Fields dialog box will open with a list of all of the available fields: 
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Sample Script Fields Dialog Box 
(Your list of fields may be different from this example)  

 You will have access to fields from the current database.  

8. From the Available fields list, choose the field you would like to access when using 
the script. If you are asking a series of questions, each related to a Contact Manager 
field, select each field at this time. 

 To make your choice, highlight the field and click Add. The field name will move to the 
Selected fields list. Repeat this operation for each field. If you want to have access 
to all available fields, click Add All. To de-select any chosen field, highlight the field in 
the right side list box and click Remove . To de-select all of the fields, click Remove All. 

Note:  When the script is used, only fields from the level that is in use at that time and 
its parent(s) will be available. For example, if you have selected fields from all three 
levels, then access the script from Level 2, you will only be able to use fields from 
Levels 1 and 2. 

 The fields will appear in the order they are added. If you add all of the fields at once, 
they will appear in alphabetical order. You will be able to change the order of the fields 
after they have been added. 

9. To change the order in which a field appears, click on the mover box associated with it 
and drag it to the desired position. 

10. When your fields are set up, click OK.  

 You will return to the Branch Script Setup screen. 

11. To associate fields with another branch, select the branch and repeat steps 5 through 
10. 

12 Click Save to save changes and exit the Branch Script Setup screen. 

 Your script is now ready to use.  
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TeleMagic Reports 
There are two types of reports in TeleMagic: custom reports, and standard reports.  

Custom reports allow you to design your own reports detailing practically any information in 
TeleMagic. You control what information is included, what calculations are made based on 
that information, and how the information is presented. With custom reports, you start with a 
blank page and use report generation tools to build a report. 

Standard reports are designed to anticipate your reporting needs and make printing 
professional reports even easier. Most of the major areas of TeleMagic include standard 
reports. When you print a standard report, the design and layout has already been done for 
you. You can select from options allowing you to control what information is contained in 
the reports, such as specifying users, date range, contacts, the amount of detail included, 
and more. 

When printing the standard reports, TeleMagic has to know from which Contact Manager 
fields to pull certain information, such as company name and address. Make sure you have 
established your Contact Key Fields preferences. If these Key Fields are not defined, you 
may receive an Unable to Process message when you attempt to print a report, or it may 
print without pertinent information. 

Also under the Reports heading are labels and envelopes. You can use these functions to 
print addresses on envelopes and labels, print name tags, shipping labels, rotary labels, and 
a variety of other related documents. You can use any of several standard envelope sizes for 
envelopes, and most Avery label styles for labels. 
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Data Backup 
The best way to safeguard your data is to make frequent backups of your files. While there 
is no specific command within TeleMagic to back up data, it is important to perform regular 
backups of your important files. TeleMagic can be backed up using the backup utility that is 
currently used for other applications and data files on your network or PC. (If you have no 
backup routine in place, you should implement one as soon as possible to preserve the 
integrity, not only of TeleMagic, but of all files in your system.) If you are using TeleMagic 
on a network, ensure that regular backups of the entire TeleMagic system are being made. 
This includes the root TeleMagic directory (\TM by default), and all files and directories 
beneath it . Databases being stored in a location other than off the root directory path, 
including users’ local drives, also need to be backed up. 

 Hint: When a new database is added or an existing one copied, TeleMagic requires 
that a new directory be created. By keeping these new directories under the 
TeleMagic default database directory path (located off the root TeleMagic 
directory, \TM\DATA, by default), you  will not only make the new databases 
available to other users, but also make them easier to back up as a group. 

When performing backup of TeleMagic, note the following considerations: 

? If a file is in use when backup is performed, the backup utility will typically not back 
up the file. It is important to make sure that all users are out of TeleMagic before 
backup is performed. You should also make sure that you back up during the 
downtimes established for Data Synchronization Server and the Automation 
Server(s). If there are users in TeleMagic Internet Mail, the downtime established in 
System Preferences will log them out of the e-mail program as well as TeleMagic. 
Users may still start and use the e-mail program without logging into TeleMagic. 

? Many backup utilities can be set to only back up files that have been changed since 
the last backup. If you are using this type of backup, ensure that full backup is also 
performed periodically. 

? If you ever need to restore a backup copy of TeleMagic, we urge you to restore all 
files at once. You must restore the entire installation or you may encounter serious 
problems when you try to open TeleMagic. If you are forced to consider restoring 
files individually, contact TeleMagic technical support before proceeding. 
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How You Should Back Up 
? The hardware which works best in any situation will vary according to how much data 

you have and how your system is organized. Tape backups are effective, but can be 
time-consuming to perform on very large systems. Removable drive systems  are a good 
choice for many installations. One of the fastest ways of backing up large amounts of 
data is to copy the relevant files to a separate hard drive dedicated to holding backup 
data. There are also subscription services which perform backups of your data via the 
Internet and provide off-site storage. 

? Use more than one set of backup tapes or disks, and rotate them between backups. This 
reduces wear on the disks/tapes themselves, and ensures that you have more than one 
recent backup in case one set fails . 

? Keep a current full backup off site, preferably in a safety deposit box. In case of fire or 
theft, your data will be protected. Make a policy of bringing, for example, each 
Monday’s backup to the storage site and swapping it for the previous week’s backup. 

What You Should Back Up 
?    Back up all of the sub-directories under the TeleMagic root directory (\TM5 is the default 
name). 

? Back up any other database directories that are not already sub-directories of the 
\TM\DATA directory. (This does not replace backing up the entire TeleMagic directory. 
It is not enough to only back up databases on a regular basis . They will not run without 
the TeleMagic root directory and its sub-directories.) 

When You Should Back Up 
?     Back up your system on a daily basis, if possible.  

? Back up before performing imports. This way, if you import records that you later decide 
you do not need, you can simply restore the entire database from the tape copy and 
start over. 

?     Back up before performing a group delete or group replace. 

? Back up before making structural changes (such as adding or deleting fields, or 
changing the expressions for calculated fields) to your contact database. If you are only 
making changes to screens, you will have the option of first backing up those screens in 
the Screen Designer. 

? Back up before you make any major change to your system. This would include 
upgrading or updating the installation, or installing any add-on product. 
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TeleMagic Directory Structure 
Directly after installation, your directory structure should look like this: 

Note:  Drive and directory names and locations will vary depending on where you have 
installed TeleMagic. This list assumes TeleMagic has been installed in F:\TM5.  

F:\TM5 The TeleMagic root directory. This directory contains all of 
the sub-directories described below. There are not normally 
any files stored here. 

F:\TM5\COMMON This directory contains files common to all databases and all 
users . 

F:\TM5\DATA This directory contains sub-directories for the databases that 
were installed with TeleMagic. Database directories contain 
all of the tables that make up one contact database. The 
number and names of the databases installed will vary 
depending on your choices when you installed TeleMagic. 

F:\TM5\HELP The online help files (e.g., TM.CHM) are stored here. 

F:\TM5\PROGRAMS The TeleMagic program files (e.g., TM.EXE) and other files 
needed to run TeleMagic are stored here. 

F:\TM5\TMFAX Files related to the TeleMagic fax system are stored here. 

F:\TM5\TMFAX\FAXDOCS This directory contains the merged documents and fax files 
for the automation server. It is from this directory that the 
finished file is printed, faxed, or e-mailed. 

F:\TM5\TMSYNC If Data Synchronization Server is installed, files related to it 
are stored in this directory. The sub-directories for your 
default inbox and outbox can be found in this path. 

F:\TM5\TMSYNC\PACKETS If the remote receives more than one packet via FTP or 
TeleMagic Internet Mail before it has a chance to process 
one packet, the packets will be copied to this directory. For 
more information on this directory, see the Synchronizing 
Your Data chapter of the Data Synchronization Server guide. 

F:\TM5\TOOLS The toolbar bitmap directory. This contains all the bitmaps 
used by the TeleMagic toolbar. You can use Paint or any 
similar bitmap editor to customize these tools. Any user-
defined icons to be used must be stored in this directory. 

F:\TM5\USERS The directory containing sub-directories for TeleMagic 
users . A user’s directory contains all the files specific to that 
user. It is also the directory where the majority of temporary 
files are created. Each user’s sub-directory will be named for 
his or her three-character User ID. 
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?  Rebuilding Data (Rebuild) 
Periodic rebuilding is necessary to shorten processing time and speed data access. During a 
rebuild, TeleMagic permanently removes records that have been marked for deletion; 
condenses memo fields; updates lists; and updates the records in index order. 

For maximum program efficiency, you should rebuild on a regular (preferably daily) basis . At 
a minimum, rebuild after: adding contact views, pages, or fields to the Contact Manager; after 
adding, changing, or deleting more than 10% of total records or notes in either the Contact or 
Activity Manager; or when access seems slower than usual. 

Note:  Rebuilds are especially important for databases containing memo/notepad fields. 
These fields can grow quickly, especially with many users. Rebuilding trims note fields down 
to actual data, removing excess blanks and reducing the space occupied by the database. 

You can run a rebuild any time (as long as you have exclusive use of the TeleMagic tables 
which are being rebuilt), or you can specify a future date and time to rebuild. Rebuild can be 
performed either from within TeleMagic, or externally from the Run dialog box or a rebuild 
icon.  

The time required for a rebuild will depend upon the hardware you use, the total number of 
records in your database, and the total number of changed records in your database. It will 
also depend upon whether you perform a full or partial rebuild. When rebuilding, you 
should make sure that you have sufficient hard disk or network space available for 
performing the rebuild. As a general rule, locate the largest file TeleMagic will be required to 
rebuild and make sure you have free hard disk or network space of at least 1 ½ times its size. 

WARNING!  Always back up your data before performing a rebuild. If your computer 
system fails for any reason during rebuild, you could lose data. If you must interrupt a 
rebuild while it is running, use the ESC key. TeleMagic will finish with the file it is currently 
rebuilding before shutting down. Be patient until this has completed. If you interrupt a 
rebuild while a file is being rebuilt, you could lose data. 

Precautions when Rebuilding on a Network 
Access to the rebuild function is subject to TeleMagic security group restrictions. For a 
rebuild to proceed, the TeleMagic user running the rebuild must be a member of a TeleMagic 
security group that allows rebuilds. If he or she is not, the Rebuild option will be dimmed 
(unavailable) on the File menu. 

TeleMagic requires sole access to any databases or files it is to rebuild. If you will be 
performing a full rebuild, all users, except the one running the rebuild, must exit TeleMagic 
before starting the rebuild. There should be only one copy of TeleMagic running (the 
workstation performing the rebuild) for the rebuild to occur. If you are launching the rebuild 
externally to TeleMagic, close TeleMagic on your workstation before proceeding.  
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Note:  If you are only rebuilding a single database, such as after adding fields, you must 
have exclusive use of that database. Users may continue to work in other databases .  

You can automatically force users out of TeleMagic for maintenance. Supervisor users can 
select Disable Logon from the System Settings preferences and TeleMagic will shut down in 
five minutes. Only the initiating user will have access to TeleMagic. 

A regular downtime can be scheduled from the System Settings screen. Any users who are 
in TeleMagic at the downtime will be forced out after five minutes. Users will not be able to 
log in during the downtime period. 

Make sure that the user account initiating the rebuild has sufficient network disk space 
available to it before performing the rebuild. (Some networks can restrict the amount of space 
available to particular users, either for the entire network or a particular directory.) 

If they are to be run nightly, TeleMagic rebuilds should be scheduled for just after your 
regular backup. This way, if the rebuilt database for some reason encounters a problem, or 
the rebuild process is stopped, you have a backup of the very latest data. Do not schedule 
them simultaneously—you will not be able to back up files being rebuilt. 

Note:  Any database or activity files stored locally will not be rebuilt by the standard 
network rebuild, unless that rebuild is run from their own workstation. If users have stored 
database or activity files locally, periodically run the rebuild from their workstations to 
ensure that those files are being rebuilt . (Ideally, only users with security access to rebuild 
should store files locally. In this way, they can perform periodic rebuilds from their 
workstations themselves.) 

Running a Rebuild 
A full rebuild packs and re-indexes all records, notes, activities, and related files for one or 
more databases . While partial rebuilds are possible, we recommend performing a complete 
rebuild whenever possible.  

During packing, TeleMagic removes all blank spaces between records, so that the database 
occupies the least possible storage area. Whenever you have deleted more than 10% of your 
records, packing will significantly improve processing speed. 

During re-indexing, TeleMagic sorts and re-numbers all records according to your 
designated display order(s). Whenever you have added or deleted more than 10% of your 
records, re-indexing will significantly improve processing speed. 

In addition to database files, rebuild optimizes system files. If you cannot load TeleMagic at 
all, you may have a problem with one or more system files. Running an external rebuild may 
remedy that problem. 

If you are rebuilding from within TeleMagic, you will be able to specify what areas of 
TeleMagic you would like rebuilt from a Rebuild dialog box. If you are rebuilding externally, 
you can either perform quick rebuild using command line parameters to launch rebuild 
directly (without opening the Rebuild dialog box), or a rebuild using the Rebuild dialog box.  
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To Run a Quick External Rebuild: 

1. Close TeleMagic, and, if on a network, make sure that everyone else has closed 
TeleMagic. 

Note:  You must also make sure that either the Automation Server and Data 
Synchronization Server are closed (or that the servers’ downtimes are set for the time 
of the rebuild) and that no users are logged into TeleMagic through TeleMagic 
Internet Mail. Users will still be able to start and use the e-mail program without being 
logged into TeleMagic. 

2. Select Start on the Taskbar, then select Run from the Start menu. Enter the path to the 
file REBUILD.EXE, which will be located in the \TM\PROGRAMS directory. 

or Locate the external rebuild icon in the TeleMagic Enterprise program folder: 

 
 and access the command line in the icon’s properties. (Right click on the icon, select 

Properties from the menu, then select the Shortcut tab and locate the Target field.) 

WARNING!  Rebuild from within TeleMagic is subject to group security restrictions. 
External rebuild can be performed by anyone with access to the REBUILD.EXE file or 
icon. As a feature of external rebuild, as long as an installation of TeleMagic is not a 
remote site in use with Data Synchronization Server, if the supervisor security group 
does not exist in TeleMagic, it will be re-added during external rebuild. (This is a 
safety feature in case the supervisor group is inadvertently removed from TeleMagic.) 
External rebuild will also recreate the supervisor user TST with the password TST 
READDED (be sure to include the space) if there is no supervisor in the installation. 
To preserve security, you should not allow non-supervisor users access to the 
rebuild file or icon. Use Data Synchronization to recreate the supervisor group at 
remote sites. 

3. After the command line, enter the parameter /R. 

4. In addition to /R, you may use the following parameters: 

/RE will bypass the Rebuild dialog box and delete the error log. Use it in place of the 
/R parameter. 

/RC will bypass the Rebuild dialog box and recalculate calculated fields. Use it in place 
of the /R parameter.  

/REC will bypass the Rebuild dialog box, recalculate calculated fields, and delete the 
error log. Use it in place of the /R parameter. 
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/ERRPT will limit the default rebuild report to only detail any errors encountered 
during rebuild. This parameter must be used with the /R, /RE, /RC, or /REC parameter. 
(Example: /R /ERRPT) 

/NOREP will turn off the default report option. This parameter must be used with the 
/R, /RE, /RC, or /REC parameter. (Example: /R /NOREP) 

/T= will allow you to specify the time the rebuild should commence. Enter the time in 
24-hour format directly following the equal sign. This parameter must be used with the 
/R, /RE, /RC, or /REC parameter. (Example: /R /T=18:00 will run the rebuild at 6:00p.) 

 Hint: If you set a time that has already passed, TeleMagic will wait until 
that time tomorrow to perform the rebuild. 

5. If you have added the parameter to the command line in the Run dialog box, click OK 
to launch the rebuild. 

or If you have added the parameter to the icon’s properties, save the properties, then 
double-click the icon to launch the rebuild. (These parameters will continue to be used 
every time the icon is used until you remove them.) 

 As the rebuild runs, status boxes will display the rebuild progress, showing the count 
of records indexed at the bottom of the screen, and the database being worked upon: 

 

Rebuild Progress Screen 
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To Run an Internal or External Rebuild Using the Rebuild Dialog: 

Note:  From within TeleMagic, access to the rebuild feature is subject to group security 
restrictions. For a rebuild to proceed, the TeleMagic User running the rebuild must be a 
member of a TeleMagic security group that allows rebuilds. 

1. To rebuild internally, select Rebuild from the File menu and skip to step 3. 

or To rebuild externally, close TeleMagic, and, if on a network, make sure that everyone 
else has closed TeleMagic. 

Note:  By default, the internal rebuild will rebuild all system, global, user, floating, 
Automation Server, and DSS files, plus the currently open database. The external 
rebuild will rebuild all system, global, user, floating, Automation Server, DSS files, and 
all databases  in the installation. 

2. Double-click the external rebuild icon in the TeleMagic Enterprise program folder: 

 

Note:  Make sure that the /R parameter has not been attached to the icon before 
double-clicking. If it has, the rebuild will commence without opening the Rebuild 
dialog box. 

or Select Start on the Taskbar, then select Run from the Start menu. Enter the path to the 
file REBUILD.EXE, which will be located in the \TM\PROGRAMS directory. 

 The Rebuild dialog box will appear: 

 

Rebuild Dialog Box 
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3. To customize your rebuild, refer to steps 4 through 14, below. For more information on 
rebuilding particular groups of files, see the section Rebuilding Specific File Groups 
later in this chapter. 

or To perform a full (default) rebuild that will rebuild all system, global, user, floating, 
Automation Server, and DSS files, plus the current database, skip to step 15, below. 

Note:  Rebuilding DSS and Automation Server files can also be accomplished from 
their respective features. When performing a rebuild of either of these sets of files 
from TeleMagic, a default rebuild will be performed. You will need to perform rebuilds 
from DSS or Automation Server to exercise full control over the parameters of these 
rebuilds. The DSS rebuild feature is not available unless DSS has been established at 
your site. 

4. Select either the Start Now or the Delay Until radio button to determine when the 
rebuild will be run. If running the rebuild later, enter the start time and date in the 
fields provided, or use the date picker and time picker icons (to the right of the fields) 
to select the desired date and time. 

5. To print a report on the results of your rebuild, mark Run Rebuild Report in the On 
completion section. (This can be valuable for troubleshooting.) 

Note:  The rebuild report will be sent directly to your default printer. Make sure you 
have a default printer established for the workstation running the rebuild before 
selecting this option. 

 If you select to run a rebuild report, the report radio buttons will become available. 

6. To run a full report on all that occurred during the rebuild, select the Print Full Report 
radio button. If you only want to report on any errors that were encountered during 
rebuild, select the Print Errors Only radio button. 

Note:  The full rebuild report will be selected by default on external rebuild.  

7. If you are rebuilding internally and would like TeleMagic to automatically shut down 
when the rebuild is finished, mark Quit TeleMagic in the On completion section. 
(This is not an issue if you are rebuilding externally.) 

8. If you do not want to rebuild your system files, unmark the System checkbox. This 
option will rebuild the core files required to run TeleMagic. If you would like to 
specify what system files are rebuilt, click the System button. 

 Hint: For a complete list of the system files that are rebuilt, mark this option and 
run a rebuild with the Full Report option selected. The rebuild report will 
list the system files that were rebuilt.  

9. If you do not want to rebuild the database files, unmark the Database checkbox. If 
would like to specify what databases are rebuilt, click the Database button. 
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10. If you do not want to rebuild the common files, unmark the Global checkbox. If you 
would like to specify what global files are rebuilt, click the Global button. 

11. If you do not want to rebuild your user files, unmark the User Tables checkbox. If 
you would like to specify what user files are rebuilt, click the User button. 

Note:  Only the user tables for your User ID will be rebuilt with internal rebuild. To 
rebuild other users’ user tables, you must perform an external rebuild. 

12. If you do not want to include the floating files in the rebuild, unmark the Floating 
checkbox. If you would like to specify what floating files are rebuilt, click the Floating 
button. 

13. If you do not want to rebuild your DSS files, unmark the DSS checkbox. 

14. If you do not want to rebuild your Automation Server tables, unmark the Automation 
Server Tables checkbox. 

15. To perform a partial rebuild that only reindexes, select the Reindex radio button. 
(Reindexing sorts and re-numbers all records according to your existing indexes.) To 
pack and reindex, mark the Pack and Reindex radio button. (Among other things, 
packing permanently removes all records that have been deleted from the databases 
being rebuilt.) 

16. When satisfied with your selections, click OK to start the rebuild. 

 As the rebuild runs, status boxes will display the rebuild progress, showing the 
database being rebuilt, the path to the database, and the table that is currently being 
rebuilt. A count of records indexed will appear at the bottom of the screen: 

Setting a Hold Time for Rebuild 
TeleMagic allows you the option of specifying rebuild start date and time. This allows you 
to set rebuild options, but instruct the program to wait until the specified time for the rebuild 
to commence. For example, you may run a rebuild at night after performing a backup. You can 
create the rebuild settings before you leave for the evening with a hold time set until after the 
backup is completed. 

Note:  This feature is designed for use in situations when you will be away from your 
workstation and unable to initiate the rebuild at the desired time. When you set a hold time, a 
wait dialog box will appear and remain on screen until the rebuild is started (unless you 
manually cancel or instruct TeleMagic to commence with the rebuild immediately).You will 
not be able to work in TeleMagic until the rebuild has been performed. Therefore, it is 
recommended that you access the rebuild option at a time when you will not be at your 
workstation (such as when you leave for the day) or at the time you want the rebuild to 
commence. 
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To Run a Rebuild at a Future Date or Time: 

1. Open the Rebuild dialog box. 

2. Select the Delay Until radio button. 

 The Start Time and Start Date fields will become available. 

3. Enter the time you wish the rebuild to begin in the Start Time field. You can also 
enter the time using the time picker icon, located to the right of the field. 

4. Enter the date you wish the rebuild to begin in the Start Date field, using your default 
date format. You can also enter the date using the date picker icon, located to the right 
of the field. 

5. Make any other necessary settings following the guidelines in To Run a Rebuild.  

6. To proceed with the rebuild, click OK. 

 The Rebuild wait dialog box will display:  

 

Rebuild Wait Dialog Box 

 This dialog box, as shown above, will remain on the screen until the appointed time 
for the rebuild. The rebuild will run at the date and time specified. Although you will 
not be able to use TeleMagic, you can switch to other applications while waiting for 
the rebuild to commence. 

or Click on the Start button to override the specified date/time and begin rebuilding 
immediately. Make sure no one else is using TeleMagic before starting a rebuild. 

or If you would like to abort the rebuild, select Cancel. 

WARNING!  Be sure that all other users have exited the database before the rebuild 
begins.  

Rebuilding Specific File Groups 

Rebuild Database Files 
Database files store your contact records. Along with records, they store related sorting 
criteria (filters and indexes), import and export formats, quick list and report formats, and 
contact views. When you perform a rebuild, you can specify which database(s) to rebuild 
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and whether you want to rebuild the records only, or records along with some or all of these 
related sort criteria, formats, and views. 

To Select Databases and Database Files for Rebuild: 

Note:  If you have made changes in TeleMagic, a partial rebuild will allow you to quickly 
rebuild changed files. It is not intended to replace a full rebuild. All files need to be 
periodically rebuilt to ensure maximum program efficiency. You should implement a regular 
rebuild schedule to rebuild your entire TeleMagic system in addition to any quick partial 
rebuilds you run. 

1. Open the Rebuild dialog box. 

2. Make sure the Database checkbox is marked and click the Database button. 

The Database Files dialog box will open: 

 

Database Files Dialog Box 

 If you are performing an internal rebuild, the current database will be selected by 
default. If you are performing an external rebuild, all databases will be selected by 
default. 

3. From the Databases list, select the database you wish to rebuild, then click Add. 
TeleMagic will add the database name to the Databases to rebuild list. Repeat this 
for each database you would like to include. (Click Add All to include all databases.) 

or  Highlight a database from the Databases to rebuild list, click Remove  to exclude it 
from the rebuild. (Click Remove All to remove all databases from the list and start 
over.) 

4. Leave all of the checkboxes marked to perform a full rebuild of the selected 
database(s). 
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or To partially rebuild the database, unmark the options which you do not wish to 
rebuild. 

 Examples: 

If you have added or deleted contact records, but have not made any other changes, 
unmark all except Contact Data. 

or 

If you have not added new records, but have set up new data import formats, unmark 
all except Import Formats. 

or 

If you have created new contact views and filters, but made no other changes, unmark 
all except Views, Filters and Contact Data. 

5. To rebuild calculated fields, mark the Calculated Fields checkbox. 

Note:  Depending on the number of calculated fields you have in your database, 
selecting this checkbox can dramatically increase the time it takes to perform a rebuild.  

6. To rebuild only a single level of the selected database(s), mark the Rebuild Level 
Only checkbox and select the level from the drop-down list. (If you have multiple 
databases selected, only the specified level will be rebuilt on all of them.) 

Note: You will not be able to choose to rebuild both calculated fields and a specific 
level of the database. 

7. Click OK. 

 The Database Files dialog box will close, returning you to the Rebuild dialog box. 

8. Make any other necessary settings following the guidelines in To Run a Rebuild.  

9. Click OK to proceed with the rebuild. 

Rebuild Global Common Files 
Global Files store information that pertains to all databases and users of your copy of 
TeleMagic. Global files include names and storage locations of all databases, security 
settings, word processor, bulletin board, message taker, sales forecasting, graphing, NANP, 
templates, and e-mail. 
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To Do a Partial Rebuild of Global Files: 

Note:  If you have made changes in TeleMagic, a partial rebuild will allow you to quickly 
rebuild changed files. It is not intended to replace full rebuild. All files need to be 
periodically rebuilt to ensure maximum program efficiency. You should implement a regular 
rebuild schedule to rebuild your entire TeleMagic system in addition to any quick partial 
rebuilds you run. 

1. Open the Rebuild dialog box. 

2. Make sure the Global checkbox is marked and click the Global button. 

 The Global Files dialog box will open: 

 

Global Files Dialog Box 

3. Unmark any checkboxes for files you do not want to rebuild. 

4. Click OK. 

 The Global Files dialog box will close, returning you to the Rebuild dialog box. 

5. Make any other necessary settings following the guidelines in To Run a Rebuild.  

6. Click OK to proceed with the rebuild. 

Rebuild User Tables 
User Files store information related to a specific user. Rebuilding your user tables will allow 
you to rebuild all of the files in your User directory, including the option to rebuild lists of 
tagged records, documents created with the word processor, and e-mail. 

To Do a Partial Rebuild of User Files: 

Note:  If you have made changes in TeleMagic, a partial rebuild will allow you to quickly 
rebuild changed files. It is not intended to replace a full rebuild. All files need to be 
periodically rebuilt to ensure maximum program efficiency. You should implement a regular 
rebuild schedule to rebuild your entire TeleMagic system in addition to any quick partial 
rebuilds you run. 
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1. Open the Rebuild dialog box. 

2. Make sure the User Tables checkbox is marked and click the User button. 

 The User Files dialog box will open: 

 

User Files Dialog Box 

3. If you do not want to rebuild the tags files, unmark the Tags checkbox. 

4. If you do not want to rebuild your list of user specific word processor documents, 
unmark the Word Processor File List checkbox. 

5. If you do not want to rebuild the e-mail files, unmark the E-Mail checkbox. 

6. Click OK. 

 The User Files dialog box will close, returning you to the Rebuild dialog box. 

7. Make any other necessary settings following the guidelines in To Run a Rebuild.  

8. Click OK. 

Rebuild Floating Files 
Floating Files are files which store information separate from, but related to, a contact 
database. Activities, user-defined list boxes, function keys, toolbars, and scripts are all 
saved in files separate from the database to which they relate.  

To Perform a Partial Rebuild of Floating Files: 

Note:  If you have made changes in TeleMagic, a partial rebuild will allow you to rebuild 
changed files. It is not intended to replace a full rebuild. All files need to be periodically 
rebuilt to ensure maximum program efficiency. You should implement a regular rebuild 
schedule to rebuild your entire TeleMagic system in addition to any quick partial rebuilds 
you run. 

1. Open the Rebuild dialog box. 
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2. Make sure the Floating checkbox is marked and click the Floating button. 

 The Floating Files dialog box will open. 

 

Floating Files Dialog Box 

3. Unmark the checkboxes for files you do not want to rebuild. 

 Example: If you have added or deleted activities, but have not made any other 
changes, unmark all except Activities. 

4. Click OK. 

 The Floating Files dialog box will close, returning you to the Rebuild dialog box. 

5. Make any other necessary settings following the guidelines in To Run a Rebuild.  

6. Click OK if you want the rebuild to proceed immediately. 

To Perform a Partial Rebuild of DSS Files: 

Note:  If you have made changes in TeleMagic, a partial rebuild will allow you to rebuild 
changed files. It is not intended to replace a full rebuild. All files need to be periodically 
rebuilt to ensure maximum program efficiency. You should implement a regular rebuild 
schedule to rebuild your entire TeleMagic system in addition to any quick partial rebuilds 
you run. 

1. Open the Rebuild dialog box. 

2. Make sure the DSS Tables checkbox is marked and click the DSS button. 

 The DSS Files dialog box will open. 

 

DSS Files Dialog Box 
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3. Unmark the checkboxes for files you do not want to rebuild. 

 Example: If you have added or deleted activities, but have not made any other 
changes, unmark all except Activities. 

4. Click OK. 

 The DSS Files dialog box will close, returning you to the Rebuild dialog box. 

5. Make any other necessary settings following the guidelines in To Run a Rebuild.  

6. Click OK if you want the rebuild to proceed immediately. 

Rebuilding User-defined Indexes 
When you add and change indexes at the Indexes dialog box, there is an option to build 
those indexes. This option will only rebuild any new or changed indexes. Additionally, you 
have the option to rebuild all indexes, whether changed or not, in database rebuild. 

To Rebuild New and Changed Indexes Only: 

1. If you are running on a network, make sure all other users are out of the database(s) 
whose indexes you want to rebuild. 

 Hint: Use the User Monitor option off the Help menu to determine if there are 
any other users in the applicable databases. See Troubleshooting later in 
this guide for more information. 

2. From the Contact Manager menu, select Contact Utilities , Edit Indexes . 

 The Indexes selection box will open: 

 

Indexes Selection Box 
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3. Make any necessary changes to the list of indexes. 

4. Click Build Indexes.  

 A Rebuild confirmation message will appear. 

Note:  If you have not added or changed any indexes, you will receive a message that 
you must rebuild existing indexes using database rebuild. 

5. Click Yes .  

The indexes you have added or changed will be rebuilt . The Rebuild status report will 
display the progress of the rebuild: 

 

To Rebuild All Indexes: 

Note:  The following set of steps will rebuild indexes only. 

1. If you are running on a network, make sure all other users are out of the database(s) 
whose indexes you want to rebuild. 

 Hint: Use the User Monitor option off the Help menu to determine if there are 
any other users in the applicable databases.  

2. From the File menu, select Rebuild. 

 The Rebuild dialog box will appear. 

Note: If you are only rebuilding indexes, you can mark Reindex under Options. If you 
select this option any new fields you have added to the database will not be available. 
You must Pack and Reindex for new fields to be available. 

4. Click the Database button. 

The Database Files dialog box will open: 
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Database Files Dialog Box(Rebuilding Indexes Only) 

5. Select the database(s) whose indexes you wish to rebuild. 

6. Unmark all but the Contact Data checkbox. 

7. If you only want to rebuild the indexes for one level of the selected database(s), mark 
the Rebuild Only Level checkbox and select the level from the drop-down list. 

8. Click OK. 

 You will return to the main Rebuild dialog box. 

9. Under Options: select Reindex. 

10. Click OK to proceed with the rebuild. 

 A status bar will display the procedure’s progress and close when complete. 
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Optimization for Speed 
Roughly, in order from most important to least, these are the areas (discussed in detail 
below) that yield the best improvement in speed for TeleMagic: 

? Faster CPU 

? More memory (RAM, Random Access Memory) 

? Better network throughput 

? More disk speed 

? Storing the program files on a local drive 

? Less complex screens with fewer fields 

? More video speed 

? Eliminating some user indexes 

? Server speed 

? Fewer screen colors (in Windows display driver) 

Note:  The System Information screens, available from the Help menu, will show many of the 
current system and program parameters, including memory, directories, screen resolution, 
etc.  

Faster CPU 
Ultimately, the faster your CPU, the faster all applications will run, including TeleMagic. It is 
beyond the scope of this manual to discuss specific processors in detail. The minimum CPU 
requirement for TeleMagic Enterprise V5 is a Pentium 133 or equivalent. The recommended 
CPU for use with TeleMagic is a Pentium 200 or faster. 

More Memory (RAM, Random Access Memory) 
The minimum RAM requirement for use with TeleMagic Enterprise V5 is 64 megabytes. We 
strongly recommend the installation of 128 megabytes of physical memory because having 
that basic 64 megabytes installed in your computer does not mean that you have all of it 
accessible. 

Note:  Adding more memory to your computer is the surest way to improve the speed of all 
your Windows applications, including TeleMagic. 
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Determining Available RAM 
In addition to the first TeleMagic System Information screen (available from the Help menu), 
Windows provides information on your memory and System Resources within Windows. 
This can be accessed from the Performance tab on the System Properties screen (accessed 
from Control Panel, System icon). This window shows the available memory and System 
Resources within Windows: 

Another indicator of Windows performance are the available System Resources . If the 
quantity gets below about 45%, Windows will run more slowly. This number is partially 
dependent on available RAM. 

Better Network Throughput 
In a network environment, network performance is the pacing item. Since every bit of data 
must come over the network, its throughput is most important. 

Make sure that your workstation network interface cards (NICs) are up to the tasks imposed 
by Windows. Tuning your network is a craft in itself; check with your network professional 
or reseller for more information. 

A faster (or second) network card in the network server will speed up all network-related 
operations. Adding more memory to your server may achieve similar results. Ensure that you 
have the latest drivers for your network card in both server and workstation. Hard drive 
speed on the network server can also affect network performance. 

You will increase network throughput by removing bridges and routers between the 
workstations and server, where appropriate. A qualified network reseller or consultant can 
time your system’s current throughput and suggest improvements. 

More Disk Speed 
A faster hard disk will speed up all disk operations; TeleMagic is especially dependent on 
disk while looking up records and loading the contact screen, and during rebuild. If you are 
using a local (not network) hard drive for storage, a faster one will improve the performance 
of all your programs. 

Local Program Files 
It is recommended that each user performs Workstation Setup to run TeleMagic from their 
workstation. This will reduce the necessity of accessing files across the network when 
working in TeleMagic, and thus speed up operations. (This will still allow users to access 
shared information, but will take some of the load off the network and place it on the user’s 
hard drive.) To perform a Workstation Setup, select that option from the File menu and 
follow the on-screen instructions. 
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Less Complex Screens 
The more OLE, picture, rollup, and memo fields you have in a TeleMagic database, the 
slower all operations on that database will run. Screens will update more slowly and searches 
will take longer, for example. Use as few fields as you need; you can always add more later. 

More Video Speed 
TeleMagic is extremely sensitive to the video update speed of your computer. Obtaining a 
video card that offers accelerated video under Windows will speed up all Windows 
programs . 

The System Information screen, available off the Help menu shows the current video display 
resolution, but not the number of colors. For complete information, check the Windows 
Setup program in Display Properties accessed from the Control Panel. 

Video display drivers are updated constantly. Check with the display card manufacturer; to 
make sure that you have the latest and fastest ones for your video card, if you are not using 
the ones that come with Windows. 

Third-party video display drivers can also speed up screen display. Check with a reseller 
familiar with Windows video requirements for recommendations on drivers, if you suspect 
display speed problems. 

Be aware that some video drivers can cause problems in TeleMagic, particularly those that 
generate a “virtual screen” (one that is larger than the actual displayed desktop size). 
Sometimes a simpler video card can be faster. 

Eliminating Some User Indexes 
User-defined indexes can take up excessive RAM while TeleMagic is running. Eliminating 
some of the less-frequently used indexes can free up that RAM, as well as quicken updates 
on changes to records in the contact database. Try to have no more than 20 or 30 indexes 
available at any one time. Be especially careful with filtered indexes. (When you have a 
filtered index, TeleMagic must check each time a change is made to a record to see if it has 
moved into or out of the filter in use with the index. This will occur whether or not you are 
currently using the filtered index. This process can increase the time it takes to save a record, 
especially if you have set up a large number of filtered indexes.) 

Server Speed 
If network  access appears slow from all or many computers, perhaps your network server 
needs to be optimized. See the relevant sections in your network’s documentation. 
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Fewer Screen Colors 
TeleMagic is sensitive to the number of colors in the Windows display driver. The more 
colors you allow in your Windows video driver, the longer it can take to draw a screen. 
Conversely, the fewer the colors, the faster TeleMagic will run. 

You can see how your display is configured by right-clicking on the desktop, selecting 
Properties from the menu, and clicking the Settings tab. 

Also make sure that the display driver you are using is the latest available for your video 
card. Contact your video card manufacturer or visit their web site for a driver update. 

Optimizing Windows 95/98/ME 
When optimizing your workstation, there are some settings in the Control Panel’s  System 
Properties that you should check (from the Control Panel select the System icon; at the 
System Properties dialog box, select the Performance tab): 

? Make sure that the File System: and Virtual Memory: are set for 32-bit operation. 
If you are using disk compression, Disk Compression: should also be set for 32-
bit operation.  

? Select the Virtual Memory... button. Make sure that Let Windows manage my 
virtual memory settings (recommended) is set on. 

? Select the File System... button. Under the Hard Disk tab, make sure that the 
Typical role of this machine: field is set properly for your workstation. Then 
check the Read-ahead optimization: to make sure it is set to Full. 

? Select the Graphics... button. Make sure that the Hardware acceleration is set to 
Full. 

Note:  In addition, the single best way you can ensure high swap file performance is to make 
sure that the disk containing the swap file has ample free space so that the swap file size can 
shrink and grow as needed. 

Under the System Properties’ Device Manager tab, make sure that all of the device drivers 
that you are using are the most up-to-date available for Windows 32-bit use. This is 
especially true for the display adapter, hard disk controller, monitor and network adapter 
drivers. To verify this, contact Microsoft and the device’s manufacturer for more 
information. 

Finally, here are a couple of items to remember that allow for faster operation with Windows: 

? Use the SCANDISK and DEFRAG programs  on a regular basis to optimize your 
hard disk performance. 

? Avoid using disk compression software. This can noticeably decrease performance 
of all Windows applications. 
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